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User Non-Disclosure and License Agreement

Important: This Agreement must be read before proceeding
with any Northern Computers, Inc. software. By installing this
software you agree to the terms of  this agreement.

Important: This software is a proprietary product of  Northern
Computers, Inc. It is protected by copyright and trade secret laws.
It is licensed (NOT SOLD) for use on a single computer system,
and is licensed only on the condition that you agree to this USER
NON-DISCLOSURE AND LICENSE AGREEMENT.

Please Read This Agreement Carefully.
If  you do not agree to the terms contained in this agreement, please
return the sealed software UNOPENED to your supplier, along
with any associated manuals and/or other documentation. If you
agree to the terms contained in this Agreement, proceed with the
installation and registration of the software by calling 1-800-323-
4576 between 7:00 am and 6:00 pm (CST).

In consideration of  and upon receipt of  payment of  a license
fee by you, Northern Computers, Inc., grants to you a non-
exclusive license to use this software and any associated
manuals and/or other documentation furnished herewith
(together referred to herein as “SOFTWARE”) under the
following terms and conditions.

Should you elect not to assume the obligations of this
agreement, DO NOT BREAK THE SEAL ON THE
SOFTWARE CASE. Return the software and any associated
manuals and/or other documentation to the supplier for refund
or credit. If you are unsuccessful in obtaining a refund or credit,
please contact Northern Computers, Inc. at 135 West Forest Hill
Ave., Oak Creek, WI 53154. NO REFUND OR CREDIT
WILL BE GIVEN ON ANY SOFTWARE PACKAGE ON
WHICH THE SOFTWARE CASE SEAL HAS BEEN
BROKEN.
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You shall not provide or disclose or otherwise make available
the SOFTWARE or any portion thereof  in any form to any third
party. You shall be obligated to retain in confidence the
SOFTWARE, except for any published user manual(s) you may
have received from Northern Computers, Inc. and except for
SOFTWARE information which is publicly known, or lawfully
received from a third party, or known by you prior to the date
you received the SOFTWARE.
You shall not have the right to print, copy or reproduce, in
whole or in part, in any form whatever, the SOFTWARE,
except that two copies of the media may be made, in machine-
readable form, for use by you for backup and/or archiving
purposes on a single computer system. You may not transfer the
SOFTWARE electronically from one computer to another or
over a network.
You agree not to decompile, disassemble or otherwise reverse
engineer the SOFTWARE. You may not modify the programs in
any way without the prior written consent of Northern
Computers, Inc.
The manuals and other documentation may not be copied for
any purpose. The SOFTWARE may be removed from one
computer system and transferred to a backup system, but shall
not under any circumstances be used concurrently on more than
one computer system.
You agree to maintain full and complete records of  the number
and location of any such copies of the software which have
been generated and to reproduce on any such copies any and
all copyright notices and other markings and notices present on
the originals.
From time to time as they become available, Northern
Computers, Inc. may notify you of any enhancements or updates
released by Northern Computers, Inc. for SOFTWARE licensed
hereunder. Any such updates offered would be subject to
standard Northern Computers, Inc. terms and charges if  any.
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ONLY REGISTERED LICENSEES WILL BE OFFERED
ANY SUCH UPDATES. The license of  the SOFTWARE
provided by this Agreement shall not be assignable or otherwise
transferable by you, except that, if you are a legally constituted
organization, you may transfer the license as part of a transfer
of your entire business or assets or that portion of your business
or assets to which the license of  the SOFTWARE pertains.
NOTICE: THIS SOFTWARE IS LICENSED (NOT SOLD).
IT IS LICENSED TO LICENSEES, INCLUDING END-
USERS, WITHOUT EITHER EXPRESS OR IMPLIED
WARRANTIES OF ANY KIND ON AN “AS IS” BASIS.
NORTHERN, INC. MAKES NO EXPRESS OR IMPLIED
WARRANTIES TO LICENSEES, INCLUDING END-USERS,
WITH REGARD TO THIS SOFTWARE, INCLUDING
MERCHANTABILITY, FITNESS FOR ANY PURPOSE OR
NON-INFRINGEMENT OF PATENTS, COPYRIGHTS, OR
OTHER PROPRIETARY RIGHTS OF OTHERS.
NORTHERN, INC. SHALL NOT HAVE ANY LIABILITY
OR RESPONSIBILITY TO LICENSEES, INCLUDING END-
USERS, FOR DAMAGES OF ANY KIND, INCLUDING
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES,
ARISING OUT OF OR RESULTING FROM ANY
PROGRAM, SERVICES OR MATERIALS MADE
AVAILABLE HEREUNDER OR THE USE OR
MODIFICATION THEREOF.
NOTICE: NORTHERN INC. MAKES NO CLAIM OR
WARRANTY WITH RESPECT TO THE FITNESS OF ANY
PRODUCT OR SOFTWARE FOR A SPECIFIC
APPLICATION AND ASSUMES NO RESPONSIBILITY
FOR INSTALLATION. THIS WARRANTY IS IN LIEU OF
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED. NO
REPRESENTATIVE OR AGENT OF NORTHERN, INC.
MAY MAKE ANY OTHER CLAIMS TO THE FITNESS OF
ANY PRODUCT FOR ANY APPLICATION.
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SO LONG AS THE SOFTWARE LICENSED HEREUNDER
REMAINS A PART OF NORTHERN COMPUTERS’
SYSTEMS, NORTHERN COMPUTERS RESERVES THE
RIGHT TO ISSUE PERIODIC ENHANCEMENTS AND
UPDATES WHICH WILL INCLUDE CORRECTIONS OF
PROGRAMMING ERRORS DISCOVERED OR BROUGHT
TO NORTHERN’S ATTENTION. HOWEVER,
NORTHERN SHALL NOT BE OBLIGATED TO ISSUE
SUCH ENHANCEMENTS OR UPDATES ON ANY
PARTICULAR SCHEDULE.

NOTICE: THE SOFTWARE CONTAINED HEREIN IS
LICENSED AS A “SERVICE ONLY” FOR NO
PARTICULAR APPLICATION. IT IS NOT TO BE
CONSIDERED OR CONSTRUED AS A “GOOD” FOR
PRODUCT DEFINITION WITHIN THE MEANING OF
THE UNIFORM COMMERCIAL CODE AND APPLICABLE
STATE LAW. NORTHERN, INC. MAKES NO
COMMITMENT TO CONTINUE PRODUCING THIS OR
ANY OTHER COMPATIBLE SOFTWARE, NOR MAKES
ANY COMMITMENT AS TO MARKETING THE
SOFTWARE IN ANY GIVEN TERRITORY.

NOTICE: THIS LICENSE AGREEMENT IS FOR THE
NORTHERN, INC. SOFTWARE AND/OR
DOCUMENTATION ONLY. THE SOFTWARE REQUIRES
THAT THE USER OBTAIN (EITHER FROM NORTHERN,
INC. OR ANOTHER SUPPLIER) ADDITIONAL
SOFTWARE SUCH AS BUT NOT LIMITED TO
OPERATING SYSTEMS AND/OR SYSTEM UTILITIES,
COMPILERS OR COMPUTER LANGUAGES. IT WILL BE
THE USER’S OBLIGATION TO COMPLETE AND
REGISTER ANY OTHER SOFTWARE AGREEMENTS AS
REQUIRED BY THE MANUFACTURER. NORTHERN,
INC. ASSUMES NO RESPONSIBILITY FOR ANY OTHER
MANUFACTURER’S SOFTWARE.
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WIN-PAK 1.17 provides the same solid, reliable access control
as version 1.16, but with a number of  new features. These
features include:

• 32-bit support

• Compatability with Windows NT/2000/XP

• Multiport communication device support for 32-bit
operating systems

• Ultra Electronics Rio/Tango printer support

• Implementation of  Crystal Reports, Version 8.5

• Supports Flashpoint 3D and Flash Bus capture cards

• Supports remote connection using multiport communication
devices

Version 8.02 panel firmware is required for the Send Year to
Panel feature. Using this feature, remote panels can remain
buffered over Leap Day to provide accurate history.

The basic installation, programming and functions remain the
same as version 1.16.

If  you are upgrading from an earlier version of  WIN-PAK, make
sure to create a backup of  your database files before installing
WIN-PAK 1.17. Refer to Appendix K.
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What is Access Control?

Access control is computerized control over entry to any area
that can be secured with a lock and key. Entry is only allowed to
authorized people at authorized times. Control of  who is allowed
to come and go is easily maintained.

The weakness of  a lock and key security system is the key. The
key is a readily duplicated piece of  metal that gives anyone who
holds it access to an area. The risk of  lost or stolen keys, with the
expense of  changing locks, is a costly problem. Access control is
an effective and affordable solution to this problem. With access
control, each person receives a card or keycode which restricts
access to authorized areas at authorized times.

A small, programmable control panel allows or denies access.
If  a card is lost or stolen, or if  a keycode is no longer secure,
the control panel can be reprogrammed quickly and easily.

An additional benefit of  access control is report capability. The
system provides reports of  all card/keycode activity, including
whether access was granted or denied, and why. A permanent
record of all entries to an area can be maintained.
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What is WIN-PAK?

WIN-PAK is state-of-the-art access control software that takes
advantage of  the WindowsTM operating environment. Security
professionals can program card information, create badges, and
monitor alarms and cameras with ease. The interface is intuitive
and makes it easy to manage Northern Computers’ high-tech security
hardware.

Database Management

WIN-PAK databases allow you to define timezones, areas,
panels, cards, and other information pertinent to the site. It is
easy to add and modify hardware or cards so that your access
control system can grow with your company’s needs.

Access Control Management

WIN-PAK’s tabbed screens give security personnel immediate
access to the principle facets of day-to-day access control
management.

The Alarm Monitor screen provides alarm monitoring
capabilities available in four views.

• The History view displays all alarm information and system
communication in a list form as it is received from the
panels.

• The Current view displays incoming alarms according to a
set priority so that high priority items are easily visible.

• The Monitor view displays a grid of  alarm input points that
can be monitored for status changes.

• The Floor Plan view provides a graphical representation of
locations in alarm with “hot spot” capabilities for navigating.
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The Alarm Info screen provides information on particular alarm
activity and allows the user to enter response notes.

The Panel Control screen provides control over panels, input
points, and output points.

The Muster Report screen aids in emergency situations when it
is important for the operator to know who has reached muster
(safe) areas.

The Camera Control screen gives camera control of  an optional
CCTV system.

The Card Lookup screen provides the user quick access to the
card database, and the ability to search on most fields, including
twenty-five user-defined note fields.

The Mail screen provides the operator at the server with a chat
function to communicate with networked WIN-PAK
workstations.

In addition to real-time printouts of  alarms WIN-PAK can be
used to generate a wide range of  reports. History reports provide
alarm logs from any given date, and database reports can list the
records in any WIN-PAK database.

Badge Design

WIN-PAK comes with a full-featured badge layout utility.
Producing high quality photo ID badges is easy. Using
WIN-PAK, you can design the badge, capture the photo ID and
print. Print onto an access control card to incorporate two
security measures onto one card!
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Hardware/Software Requirements

WIN-PAK is designed to run on IBM and IBM-based personal
computers that meet IBM serial communication specifications.
The minimum hardware/software requirements for WIN-PAK
are outlined in the following sections.

Computer Requirements

Northern Computers, Inc. requires an IBM or IBM-compatible
computer with Intel processor. The processor and Random
Access Memory (RAM) requirements depend upon the size of
the system as outlined in the following table:
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NOTE: To increase system performance, run badging and report generation
from workstations instead of  the server.
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Disk Drives
WIN-PAK requires a computer with a hard disk drive (210 MB
recommended minimum) and a CD-ROM drive for installing the
software.

A hard disk drive system provides the necessary disk storage for
the WIN-PAK program, database entries, and history transactions.
If  you plan on using the badging component of  WIN-PAK or
other programs on your PC, you may want to invest in a larger
hard disk drive.

Because the space on a floppy disk is limited, a tape drive or other
removable medium is recommended for WIN-PAK backups.

Monitor
A VGA monitor capable of displaying 256 colors on a 800x600
(or higher) pixel screen is recommended.

Mouse
A two-button mouse is required to fully operate WIN-PAK.

Serial Communication Boards
The computer may have up to two serial communication ports
configured as COM 1 and COM 2. Additional communication
ports [totalling up to 32] can be added using multiport devices
supported by the operating system.



Introduction 2121212121 Introduction

Operating Systems

WIN-PAK requires Microsoft Windows XP, Windows 2000, or
Windows  NT 4.0. It is not designed for use with Windows 95 or
Windows 98 platforms. Use WIN-PAK 1.16 for Windows 95
and Windows 98 platforms.

NOTE: Mixing WIN-PAK versions in a network is not supported. All WIN-PAK
computers must have the same version of WIN-PAK.

Peripherals

Parallel Printer
A parallel printer is optional, but is required for most systems to
print system activity, database reports and history reports. The
printer must be an IBM compatible parallel printer and supported
by Micrsoft Windows.

Converters
A converter serves as an interface between the computer’s serial
communication port and the control panels. Northern Computers
offers two communication converter options, the C-100-A and
the N-485-PCI-2.

C-100-A
The C-100-A allows the computer, using RS-232 protocol, to
communicate with the control panels in a 20 mA current loop.
A C-100-A Converter is required for each port or loop of
control panels.
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N-485-PCI-2
The N-485-PCI-2 allows the computer, using RS-485 protocol,
to communicate with control panels in a RS-485 dropline.
The N-485-PCI-2 has an advantage over the C-100-A in that it
can provide a higher degree of  data supervision in the
communications line as well as an increase in system
performance.

Modems
Modems enable the connection of  the computer running
WIN-PAK to control panels at remote locations, using standard
telephone lines. WIN-PAK supports two modem configurations,
as described below:

Leased-line Modems
The M-300 leased-line modems provide a continuous, direct
connection from the computer to the communication loop, using
a standard leased telephone line, terminated with an RJ11C
modular telephone jack.

Auto-answer/Auto-dial Modems
The M-200 auto-answer/auto-dial modems (Hayes compatible)
are typically used in dial-up configurations with the C-100-A1, in
which the panels are normally off-line with the computer and are
dialed only when communication is necessary. The M-200
modem uses a standard telephone line terminated with an RJ11C
modular telephone jack.
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The M-9600-2 is typically used in dial-up configurations with
the N-485-HUB-2 for locations that automatically call to the
WIN-PAK computer with activities.

NOTE: Do not use telephone lines with special features like “call-waiting”
because they may interfere with modem communications. If you must
use such a line, disable these features.

NOTE: Don’t use screen savers on the computers where you view incoming
activity. They mask the activity and draw power from your PC’s
processor. If you need to use a screen saver, choose one that blanks
out the screen. The Alarm Monitor does not update while a screen
saver is running, but is made current when the screen saver is
disabled by keyboard or mouse activity.

NOTE: Disable all power saving features when using WIN-PAK 1.17.
They will adversely affect the overall performance and operation.
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Setup

Pre-Installation System Setup

Because of  the complex computer configuration required to run
WIN-PAK, Northern Computers sells WIN-PAK as a “turnkey”
system. The software and peripherals are installed and tested on
a computer that meets the required specifications as outlined in
the Introduction. The tested PC and software are then sold as
the front end of an electronic access control system.

If the software has been purchased alone, (without a Northern
Computers, Inc. computer) for installation on the customer’s
own PC, then the purchaser must configure the PC, install a
video capture card (if  badging), and install WIN-PAK. Because
there are many PC brands and types available, the user may run
into IRQ conflicts and other hardware issues. To avoid these
hassles, we encourage users to purchase a pre-tested, turnkey
system from Northern Computers.

BEFORE installing WIN-PAK, install the video capture card or
digital camera (if badging). See the dedicated documentation for
your video peripheral for more information.

After installing the video capture card or digital camera, install
WIN-PAK as directed in the next section of  this manual.
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Installation

1. Insert WIN-PAK CD into the CD-ROM drive. The CD will
automatically engage and the first installation screen will appear.
Navigate through the initial installation screens and select Install
WIN-PAK 1.17 to begin installation.

If the CD does not automatically engage:

a) Click the Windows Start button and then click Run.

b) Click browse and select D:\Demo32.exe (where D is your
CD drive.) Click OK.

2. A copyright information screen appears. Click OK to
acknowledge that you understand the message and agree to the
terms. Clicking Cancel at any point aborts the installation.

3. Select one of the following types of installation:

Stand-Alone
The current machine is NOT networked with any other
computer.

Server
The current machine is networked with other computers, stores
all database information, and communicates with the control
panels.

Client
The current machine is networked with other computers but
does not store database information or communicate with the
control panels.

4. Click OK to continue. WIN-PAK Install then prompts for a
video capture card type (for video badging applications): Select
the board that is installed on the target PC (or None). Click OK.
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Setup

5. WIN-PAK Install prompts for the badge printer. If  you have one
of the special feature printers listed, then select it. If you have
any other printer or will not be printing badges, then select Other.
Click OK to continue.

NOTE: If installing the Ultra Electronics Tango printer, refer to Appendix I for
details on magnetic encoding configuration.
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6. WIN-PAK Install prompts for the type of  signature capture pad.
If you have a Penware signature capture pad, then select the
corresponding Penware option. If you will not be capturing
signatures, select None. Click OK to continue.

7. WIN-PAK Install prompts for an installation directory. The
default directory is on the C: drive. To select another directory,
click the Drive drop-down arrow and select one. An alternate
subdirectory can be selected by double-clicking the directory
folders. When the directory you want appears in the top text
box, click OK.

8. A registration dialog box appears. Type in your name and
organization. Click OK to continue.

9. WIN-PAK Install confirms that the registration information is
correct. If not, click No to return to the registration window
and modify the information. If  it is, Click Yes.

10. The Alarm Printing window appears. Select Yes if  you will be
printing alarms from this station or No if  you will not.

11. WIN-PAK Install copies files to your hard drive. Do not change
the Source Pathname unless it is different from the default path.
WIN-PAK install continues copying files to your hard drive.
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Setup

12. A message appears notifying you that WIN-PAK has been
successfully installed. Click OK. A Northern Computers Access
Control group window, containing icons, is installed.

The WIN-PAK program icons are:

 WIN-PAK Program

Double-click the WIN-PAK Program icon to access WIN-PAK

 Badge Layout Utility

Double-click the Badge Layout Utility icon to create badge
backdrops for cards. The Badge Layout Utility is also accessible
from within WIN-PAK

 WIN-PAK Help

Double-click the WIN-PAK Help icon to get help on any
WIN-PAK function. Help is also accessible from within
WIN-PAK.

 Un-Install WIN-PAK

Double-click the Un-Install WIN-PAK icon to delete WIN-PAK
and any related files off of your hard drive.



3232323232 WIN-PAK 1.17 User Manual

First Launch

Double-click the WIN-PAK icon to launch the program. If  this
is a new installation, click Yes. WIN-PAK creates the databases.
If  this is an upgrade, click No, so that your existing databases
are preserved. Refer to the WIN-PAK 1.17 release notes for
upgrading from previous WIN-PAK programs.

Options Setup

The first time you run WIN-PAK, you are prompted to set up
various options. The Options dialog box (following illustration)
has four tabs, each dealing with different areas of the program.
These options can be modified later by selecting Options from
the WIN-PAK Setup menu and making the desired.

Card Options
1. The Options box (previous illustration) opens to the Card tab.

Select either 5 digit or 12 digit cards. (12-digit cards are
supported by N-1000 Control Panels with version 8.xx firmware
only. WIN-PAK does not support 6.03 firmware.)
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2. Enable Card Limiting if you want to automatically limit card
usage. This can be done in one of three ways:

Activation & Deactivation by Scheduler
WIN-PAK can permit a card access between two dates. The
activation and deactivation dates are set for each card in the
Card Database. WIN-PAK checks the card dates by the
schedule defined in the Schedules database.

Expiration by Panel Hardware
A card’s access can also be set to expire on a selected date. This
is done at the panel level so the computer doesn’t have to be
online to expire the card. The expiration date for each card is set
in the Card Database and becomes effective when the card
information is transferred to the panels. The expiration date can
be up to 254 days from the date that it is entered in the Card
Database.

NOTE: The database capacity of the N-1000 Controller may be reduced by
up to 50% when either the Expiration by Panel Hardware or Limited
Use card limiting option is selected. See N-1000 programming
manual for details.

Limited Use
A card’s access can also be restricted to a limited number of
uses. Once a card has been used a set number of  times, it
becomes invalid. This number (maximum 254) is set for each
card in the Card Database. Like Expiration by Panel Hardware,
Limited Use is also controlled at the panel.
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Communication Options
Communication options cannot be set from a network client. If
you are installing a network client, the Communications tab
(following illustration) is not available.

1. Click the Communications tab to configure Communication
options. From the Send Command File section, select whether
you want to send command files and switch cameras upon
receiving alarm information or when you acknowledge alarm
information. The On Acknowledge option requires the
operator to acknowledge before sending/switching, while On
Receive acts automatically when alarm and reader conditions
are received.

2. From the Clear Alarm State section, select whether you want
operators to be able to clear only normal states, or both alarm
and normal states.
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3. From the Alarm Monitoring section, enable Alarm
Acknowledge if you want to eliminate the need to
Acknowledge lower priority items. If  enabled, type in or use the
arrow keys to indicate the lowest priority requiring
acknowledgment. 1 is the highest priority and 99 is the lowest
priority. Alarms, readers, and cards with this priority or higher
(lower number) AND undefined alarms and cards need to be
acknowledged. If  not enabled, only undefined alarms and cards
need to be acknowledged.

NOTE: Undefined alarms and cards always have the highest priority.

4. WIN-PAK’s Auto Card Lookup automatically displays card
information including name, card number, and badge photo (if
one exists) for cards that send a status to the Alarm Monitor. To
prevent Auto Card Lookup from displaying every card
presented, set a priority threshold. Enter a number from 0 to 99.
All card statuses with higher priorities (lower numbers) than the
selected threshold will trigger the Auto Card Lookup. The rest
of the cards are ignored.
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Operator Options

1. Click the Operator tab to configure operator options. From the
Operator screen, enable the Log Actions option if you want
history reports to contain operator actions including alarm
acknowledgment and database modifications.

2. Enable Lock Out Operator after invalid login if you want
WIN-PAK to refuse access after a certain number of  invalid
login attempts. Type in the number of  invalid attempts allowed
in the first box and the number of minutes to lock out in the
second box. The arrows adjust the box that has the cursor in it.
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Muster Report Options

1. Click the Muster Report tab to configure muster reporting
options. Check the box labeled Initialize with History Data to
prime the Muster Report when loggin in. Type in or use the
number arrows to select the number of hours of history to be
considered in the priming operation. The maximum is 99 hours.

2. When your options are set the way that you want them, click
OK from any screen.
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Registration

When opening WIN-PAK prior to registering, the CD Key
number screen (below) appears prompting for the CD Key
number.

1. Enter the CD Key (located on the WIN-PAK CD cover) in the
text spaces provided. Press TAB to move from one text entry
space to the next. When finished, click OK.

If the CD key entered is valid, the registration prompt screen
(below) will appear.

2. Click Yes to register WIN-PAK. The registration screen (below)
appears.
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3. Call Northern Computers’ Customer Service at 1-800-323-4576
to obtain the product serial number. Enter the serial number in
the space provided, and click Register. The CD Key number
screen will no longer appear. As a registered user, you receive
notification of  future WIN-PAK upgrades.

Product ID Number
The WIN-PAK product ID number includes the version and
issue number. The following example shows how to interpret the
product ID number: WP01.17A.00.00001-NCI02.

WP WIN-PAK product
01 major release (first part of version)
17A release code change (second part of version)
00 compile number (used in development, will always

be 00 in general release versions)
00001 the issue number of this version (evaluation/

demo always use 00000 and are limited in card
quantity and port communication time)

NCI02 version type
NCI01 Domestic upgrade version
NCI02 Domestic full version (standard)
NCI03 Domestic demo version
ADV01 Advanced Systems version
INT01 International version
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First Login

1. Under Operator Name: type system and under Password: type
startup (lowercase) and click Login.

2. A message will appear recommending that you change the
SYSTEM password immediately. Click OK.

NOTE: Operator names are not case sensitive but passwords are. After your
first login, it is suggested that you change the password. The
password and the operator name can both be changed when you
edit the privileges (next section) in the operator database. Passwords
can be comprised of up to eight alphanumeric characters. For the
greatest security, it is recommended to use a combination of letters
and numbers and not to use any familiar terms such as your company
name, initials, birth dates, etc.

Changing System Privileges and Password
WIN-PAK doesn’t give the SYSTEM operator access to all
functions. Access will have to be manually programmed as
follows:

1. Select Operators from the Database Menu.

2. Click Edit.
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3. Change the privileges for SYSTEM in order to access all
sections of the program: Scroll down the list of options and
click on the corresponding key symbols to enable rights to each
option.  Click on each key the number of times indicated below:

• • two times on File
• • • three times on Database
• one time on Reports
• one time on Setup
• one time on Alarm Monitor
• one time on Alarm Info
• one time on Panel Control
• one time on Muster Report
• one time on Camera Control
• one time on Card Lookup
• one time on Mail
• one time on Muster Card Deletion
• one time on Non-Muster Card Deletion
• one time on one time on Display Card Numbers
• one time on Display PIN Numbers
• • two times on Guard Tour View

4. Double check to make sure that all of the key symbols have
been cleared of the prohibit symbol.
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5. Click Password... The Set Password dialog box appears.

6. Enter a new password in both the Password and Verify boxes.
Passwords can contain both alpha characters and numbers.
Make sure that you don’t forget what it is. But do not use your
company name, your birthday or similar information which
could easily be decoded.

NOTE: A simple strategy for choosing a password that is both easy to
remember, but hard to decode, is to pick a simple phrase preceded
or followed by one or more numbers. Enter it without spaces and
capitalize each word. Such a password cannot be easily decoded
either by a random number generator or by dictionary decoder.

Click OK. Click OK again to close Operator Detail. Click Close
to close the Operator Database.

You now have complete access to the WIN-PAK program.
Login again, using SYSTEM and your new password. You will
have the ability to change WIN-PAK setup, program databases,
and will have access to all other functions.

 NOTE: When exiting WIN-PAK for the first time, a screen will appear
prompting you to save the control file. Click OK.
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Logging In from Within WIN-PAK

Operators can log in from within WIN-PAK by selecting Login
from the File menu or by clicking the Login button (  ) on the
toolbar. Either of  these actions brings up the Login dialog box
prompting you for operator ID and password.

Buffer/Unbuffer Prompts

When starting WIN-PAK, a dialog box prompts the operator to
unbuffer panels. If  Yes is selected, all direct connected panels
are unbuffered and events will be displayed in the History View
of  the Alarm Monitor tab. If  No is selected, the panels continue
to buffer transactions.

Similarly, when exiting WIN-PAK, a dialog box prompts the
operator to buffer panels. If  Yes is selected, all direct connected
panels are instructed to buffer transactions before WIN-PAK is
closed. If No is selected, panels do not buffer transactions and
all incoming alarm and card read data will be lost.
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Programming

Communication Setup

It is important to designate Serial Ports for communication
before programming the databases. Serial ports must be defined
so that they can be used in the Areas Database.

Each serial port can be used to communicate to a loop of panels
or a supported CCTV system. Personal computers generally
have one or two internal serial ports that can be used, but
additional hardware can be purchased allowing up to 32
communication ports.

The Serial Port Setup dialog box is used to configure WIN-PAK
for communication hardware. Up to 32 ports can be enabled for
configuring multi-port hardware (if needed).



Setup 4545454545

Setup

To Define Serial Ports
1. From the Setup menu, Select Serial Ports. The Serial Port Setup

dialogue box opens.

 NOTE: Do not enable a serial port if you have a serial mouse attached to it.
Errors will be generated.

NOTE: Verify that the communication ports are supported by the operating
system. Ports not supported by the operating system will not function
for WIN-PAK.

2. For each needed port (row):

a. Enable the ports that you will be using by clicking the box in
the row under Enable. An “X” indicates that the port has
been enabled. These ports are available to define areas in the
Areas Database.
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b. Click the box in the row under Modem if the port will be
used for a remote dial-up location. An “X” indicates that the
modem is enabled.

c. If the port is connected to a modem, select the baud rate of
incoming communication from the drop-down list (1200,
2400, 4800, 9600 or 19.2 K).

d. For each port connected to a modem, a default initialization
command string appears. It can be changed by selecting and
deleting the default string and retyping in a new one. Shift-F2
allows you to edit instead of  retyping the whole string. Press
Shift-F2 which will highlight the whole line. Then press the
left or right arrow key so the line appears in yellow. Use the
arrow keys to move to where you need to add or remove
information.

The following string may work better with modems sold by
Northern (as well as some other brands):

ATEØV1QØ&C1&WSØ=1&DØ

Ø = zero

e. If the port is connected to a modem, type in the modem
phone number of  the port’s modem. This is the number a
remote modem would dial to connect to WIN-PAK. It is
used for 485 ACK/NAK dial-in loops or areas.
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Note Field Setup

Note field labels can be defined at any time. However, setting
them up before programming your Card Database can make the
task easier. Decide what data you want to manage on each card
holder (or card) and the entry order, and then rename your note
fields.

NOTE: On badging clients, new Note Field names do not appear in the
Backdrops database until you exit and restart WIN-PAK on the client.

1. Select Note Fields... from the Setup menu.

2. Type a new label in the space next to a note field. For example,
type Department next to Note 1 to change the label from Note 1
to Department in every area of  WIN-PAK that uses note fields.

3. Hit Enter or move to a new field to save the label. Click OK
when finished.
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Printer Setup

The report printer and the alarm printer are set up independently.
Select Print Setup... from the File menu. The Printer Setup dialog
box opens.

NOTE: Printer Drivers are added and configured in the Windows Control
Panel, located in the Main Group. See your Window’s manual for
more information.

Report Printer
Select Report Printer and click Setup. To configure the options
for printing reports. You should have at least generic text installed
as a print driver so that the reports are shown and come up in a
letter (81/2" x 11") format.
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Alarm Printer
Select Alarm Printer and click Setup to configure the options
for printing system alarms. The Select printing method dialog
box opens.

Select the desired printing method.

Windows Printing
Windows printing should be selected with laser printers. It holds
transaction information until enough transactions are made to
fill a page. It then prints the page. If  you want the information
printed before the page is full, you must click the page eject
button  from the menu bar.

Direct to Port
Direct to port can be selected with dot matrix printers to print
transactions in “real time.” Use this option for local printing
only. Do not use this option with, or as, a shared network
printer.

No Alarm Printing
Select No Alarm Printing if  no alarm printing is required.
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Databases

Overview

The WIN-PAK access control system is made up of
interconnecting databases that can be accessed from the
Database menu. Although only a few databases are required for
operating a basic system, up to fifteen databases are possible in
advanced systems that make use of  WIN-PAK’s CCTV, floor
plan, muster, and other features. The programming order of
these databases is very important, because almost every
database depends upon information entered in other databases.
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Core Databases

Timezone Database
This database defines timezones. Timezones are time elements
that can be used to determine when particular actions happen or
when certain cards are allowed access. Timezones can be
attached to cards, inputs, and outputs in other WIN-PAK
databases.

The Areas Database
The areas database database defines the settings for each
communication port in the system.

The Panel Database
The panel database maintains information on access control
panels, including selected options and information, or readers,
input points and output points.

The Access Level Database
Access levels determine where and when access is allowed to a
card holder. An access level consists of  a number of  readers that
can be accessed, the time access is permitted, and if  configured,
the group of relays to be pulsed. Cards assigned to an access level
have access to the specified readers (doors) at the specified times.

The Card Database
The card database maintains information on cards and card
holders including an access level and badge information.
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Supplementary Databases

The following databases are supplementary. Information may be
required in the supplementary databases first, however, to
provide information when defining the main databases. Badge
backdrops are created using the Badge Layout Utility which is
discussed in Chapter 4.

NOTE: An operator must be permitted to add, edit, or delete database
records by being given Edit (  ) privileges for a particular database
in the Operator Database.

NOTE: An operator with a Look (  ) privilege can view records, but not
modify them. Access the database is allowed, but all editing buttons
are replaced with a “View...” button. The operator can see all
information in the database, but cannot save any changes.
Cancel must be used to exit the database.

NOTE: An operator with a None (  ) privilege to a database cannot view
records. The database does not appear in the Database menu. If the
None privilege is assigned to all databases, the Database menu does
not appear on the menu bar. (See Operator Database for more
information.)

Schedules Database
The Schedules database is used to send commands from WIN-
PAK to the access control system at particular days and times.
The uses for this feature include updating the panel date and
time, dialing up to remote panels, and activating/deactivating
cards. A schedule can also be set to send a reminder message to
the operator to back up files.
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The Guard Tours Database
The WIN-PAK Guard Tours database defines tours that a guard
can patrol to help secure a facility. Defined tours allow the guard
a certain amount of time to present a card to each reader or trip
an input on his route. Early or late arrivals to a reader or point
produce an alarm message in WIN-PAK.

Tracking Areas Database
Tracking areas are different from the Areas Database previously
discussed. Tracking areas are used to determine where personnel
are in a facility at a given time (when a muster report is run).

Camera Database
The camera database is used to define video cameras in a CCTV
configuration.

Holidays Database
The holiday database is used to define holidays during the year.
The operator will have the option of including or excluding
these holidays when defining a timezone.

Monitors Database
The monitors database is used to define video monitors in a
CCTV configuration.
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Operators Database
The operators database is used to set operator passwords and
the privileges that each operator has for the different sections of
WIN-PAK.

Floor Plan Database
The floor plan database is used to provide a graphic
representation of  the facility. This database is used to match the
graphics with descriptions and define hot spots that can be used
to monitor alarms.

Command File Database
The command file database is used to define text files
containing panel commands. These files can be uploaded to the
panels upon receiving a card/input status.

On the following pages is an illustration of how databases are
interconnected and a recommended programming order.
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Step 1
It is important that a “master” op-
erator be defined in the Opera-
tor Database that has access to
all areas in the WIN-PAK pro-
gram.

Step 2
Setup should be done before
the following databases are
defined, as they will affect
certain options in the Area,
Panel, and Card Databases.

The Schedules Database is
also an important part of the
Setup process. It allows you to
determine:

• when time & date updates will
be sent to the panels,

• what information will be sent
to remote panels and when,

• when to check the activation/
deactivation status of cards.

Step 3
Areas can be defined from
serial ports made active in the
Serial Ports section of the
Setup menu. These areas can
be local or remote control
panel loops or CCTV networks.

Step 4
Timezones simply define
blocks of time. These need to
be added to be included in the
Panel and Access Level
definitions.

• If Holidays will be treated
differently, they should be
defined in the Holiday
Database.
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Step 6
Access Levels  match
readers to timezones and
relay groups. Access levels will
be assigned to cards to decide
which cards have access at
particular readers at particular
times.

Step 5
The Panel Database defines
panel options, readers, input
points, output points, and relay
groups.

Depending upon the system, the
following databases may need
to be programmed first:

• If a CCTV system is utilized,
records should be added in the
Camera and Monitor
databases first.

• If Command Files that contain
panel programming
commands will be used,
program them first.

Step 7
Cards are defined in the card
database. This database is
where personnel are assigned
to a card number and cards
are assigned to an access level.

• If badging is going to be
done from WIN-PAK, badge
backdrops should be
designed in the Badge Layout
Utility so they can be assigned
to cards in this database.

Other Databases
• Alarms can be monitored by

floor plans with hot spots
defined in the Floor Plan
database. Floor plans can be
added to this database after
input points are defined in
the Panel Database.

• The Guard Tours database
can be used to schedule
routes for a guard to present
a particular card at specified
readers.

• The Tracking Areas Database
is used to define areas that
can be monitored with the
Muster Report screen.
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The Database Control Window
All WIN-PAK databases have the same control window. This
makes the program easier to learn and use. The elements of the
database control window are described in this section.

Data List
The data list is an on-screen chart of  the database records. It
varies depending on the database you are looking at, but
basically contains the names of the records and important
information contained in them. In all databases, double-clicking
the record is a shortcut for editing and viewing more detailed
information.
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Folders

The Timezone, Guard Tour, Tracking Areas, and Access Level
Data List Records have folders in front of them. If you click the
folder for a particular record, its information is displayed as a
sublist for viewing.

Search Tool

The search tool is used to find a particular record in larger
databases. Type in the record (or first few characters of  the
record) you are looking for and click the Search button. The
record information entered in the search box must be the type
of  information specified in the Sort Order box. For example, if
you want to search for a particular access level, set your sort
order to access level (see below) and then type the name in the
Search space. Press the search button (  ) to find the first
occurrence of a record meeting the criteria.

 NOTE: The Search Tool is  NOT case sensitive.
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Sort Order

WIN-PAK offers you more than one sorting option for each
database to make it easier for you to find the record you are looking
for. Simply click the drop-down list button to view a list of  fields,
and select the one you want to sort by. For most databases you have
the choice of sorting by which order records were entered, by
selecting “None”, or alphabetically by name. This is also the index
that the Search feature uses to find a record.

NOTE: You cannot use Search if the Sort Order is set to “None.”

Database Control Tools
Use the control buttons in the database control window to
modify the database.
Adding and modifying database records are included in the same
section. Because both processes require opening the correct tab
or dialog box, adding or deleting information, or overwriting
previously entered information. When you close the database,
all of your changes are saved.

Add Button  
Use the add button to add a new record to your database. It opens
a window with empty fields so that you can enter new data.
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Edit Button  
Use the edit button to edit the currently selected record. It
opens a window showing the data for that record. Add or delete
information, or overwrite existing information. Closing the
record saves your changes.

Delete Button  
Use the delete button to delete the currently selected record. As
a safeguard against accidental deletion, a dialog box appears
asking you to confirm the deletion. Click OK to confirm.

NOTE: Records that have been deleted appears in the database “grayed
out” until the database is packed. See Chapter 7 for more information
on packing.

Sometimes a record cannot be deleted until records from other
databases are reprogrammed to remove references to it. For
example, a timezone record cannot be deleted until all references
to it in the Panel and Access Level databases are removed. When
references to a record are removed, it can be deleted.

View Button  
The view button will appear instead of the Add... and Edit...
buttons when the current operator does not have editing
privileges. The operator can use this button to browse detailed
information on the database. Although an operator can access
these screens with View..., and even appear to change
information, none of  the changes can be saved because the OK
button is removed. The operator must Cancel out of the record.
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Close Button  
The close button closes the current database and saves any
changes.

Status Line

The status line located on the tool bar displays what record
number is currently selected and the number of records
currently defined.

The following sections will illustrate how to add and modify
information in each individual database. It is wise to plan your
system carefully on paper before you begin programming, paying
close attention to programming order. Appendix J contains
worksheets that you can use to plan your system.
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The Timezone Database

A timezone is one or more blocks of  time used to determine
when an activity happens or when a card is allowed access. A
timezone is defined by blocks of time, each consisting of a
starting time, an ending time, and days of  the week. WIN-PAK
also allows the user to determine whether holidays are to be
included in each block of time.

NOTE: Timezones should be programmed with access levels, shunted inputs,
and time controlled outputs (doors) in mind. There must be at least
one timezone defined before you can enter panels in the Panel
Database.

For example, we could define a timezone for 8:00 am to 5:00
pm, Monday through Friday excluding holidays, and give it the
name “1st Shift.” Then we use the name of the timezone, 1st
Shift, to refer to that period of time in defining access times,
shunt times, etc.

Access the Timezone Database by clicking Database on the
menu bar, and selecting Timezones.... This opens the Timezones
Database Control Window (next illustration).
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The Data List contains the names of  all defined timezones.
Clicking on a timezone folder shows the blocks of time that
define it. Each block of time has a Start Time, an End Time,
and x’s to indicate which days of  the week it includes. There is
an x under “Ho” if holidays are included in the block.

Under the Data List is the sort order. Click the drop-down arrow
to select the sort order. Choose from the order in which the
records were entered (None) or alphabetically by name
(Timezone).

When sorted by Timezone, you can search by entering the name
of the desired timezone in the search box and clicking the
Search button (  ).

Adding or Editing a Timezone

Click Add... to enter a new timezone or Edit... to modify the
currently selected timezone. This opens the Timezone Detail
window (next illustration).
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When you begin entering the details for the timezone, a message
appears providing the correct syntax for entering the start and
end time:

Click OK after noting the correct syntax for entering times.

 NOTE: Use zeros for seconds as seconds are not programmable

1. Type the name of  the timezone in the text entry box. The
timezone name can be a descriptive name containing up to
twenty characters with any combination of letters, numbers, or
spaces.

2. Click the first box under “Start Time” (defaulted 12:00 am).
Type the starting time of  the block and hit Enter.
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3. Select the End Time box. Type the end time of  the block and
hit Enter.

4. Select the days that are included in the block. Selecting holidays
(HO) in the time block includes all holidays that fall within that
block as defined in the Holiday Database. If not selected, the
block excludes holidays.

X’s mark your selection as shown in the sample screen. Clicking
the day again deselects it.

This process can be repeated for as many blocks of time as
needed to define the timezone.

Deleting a Block of Time
Click OK  to save the timezone or Cancel to ignore any
changes or additions and return to the Timezone Database
Window.

Deselecting all days of the week effectively deletes a block of
time.

Deleting a Timezone

Select the timezone you want to delete  and click Delete. If you are
sure you want to delete the timezone, click OK when the
confirmation dialog box prompts you.

The record continues to appear in the data list although it is
unavailable.  New records cannot use its key fields (i.e., name or
number) until the database is packed (see Chapter 7).
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The Areas Database

An Area is a network segment that originates from the same
communication port, such as a loop of panels or closed-circuit
TV equipment. There can be one direct connection Area defined
per communication port.

To open Areas Database click Database on the menu bar, then
select Areas.... This opens the Areas Database control window.

The Areas database control window includes the Area Name,
Type, Port, Baud Rate, and a Remote Site Phone Number (if  it
is a remote site).

A Sort Order option is available on the bottom of  the window.
Click the drop-down list button, to change the sort order. Sort
by the order in which the records were entered (None) or
alphabetically by name (Area).

When sorted by Area,  search by entering the name in the search
box and click the Search button (  ). The Search function does
not work when None is selected for sorting.
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Adding or Editing an Area

Click Add... to enter a new area or Edit... to modify the
currently selected area. This brings up the Area Detail window.

Name
Enter the name of the area in the text entry box. The area name
can be a descriptive name containing up to twenty characters
with any combination of  letters, numbers, or spaces.

Type
Select a type of configuration for the area from the drop-down
list. The choices are Loop (of panels), Camera Control, or Unknown.
Unknown is for other RS-232 communication or devices. Select
the one that describes the use of the communication port.



DATABASES

Programming Databases 7171717171

Databases

Style
Select the style that further describes the configuration of the
area. The drop-down list options depend on the type you have
selected.

Loop
Choose C-100, 485, or 485 ACK-NAK (485 should be used for
the N-485-PCI and N-485-API [not -2] panel).

The 485 ACK-NAK option works with the part numbers
N-485-xxx-2 only, when the N-485-xxx-2 is configured for ACK-
NAK.

Camera Control
Choose the brand of  CCTV equipment you are using. The NCI
CCTV option allows WIN-PAK to communicate with Northern
Computers’ PC-CCTV interface, which is required for some
brands such as American Dynamics.

Unknown
This unknown field is limited to Other.

Local/Remote
Select either Local or Remote to describe the area. Local is
hardwired or leased line communication, and remote is dial-up
modem communication.

NOTE: Multiple remote areas can be assigned to the same port, but only
one local area can be assigned to a port.

Port
Select the communications port for the area from the drop-down
list. This list consists of the serial ports enabled in your Serial
Port Setup (in the Setup menu) that match your Local/Remote
specification above.
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Baud Rate
Select a baud rate from the drop-down list to match the
communication device connected to the defined port. See your
access control panel, 485 interface, or CCTV manuals for
required baud rates.

Modem Settings
The remaining fields define the settings necessary for
communicating with a remote site. Some of the options in this
section may be unavailable depending on the equipment
selected in the Style field. They are only available if the area is
a remote site and the Type to Loops.
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Phone
Type the phone number of  the REMOTE SITE. Enter the
number as if you were dialing the number directly using up to 32
characters. A comma can be used to specify a pause in a dialing
sequence.

For example, if  a 9 is required, enter the 9 and a comma,
followed by the seven digit phone number. Likewise, if  the
remote site is in a different area code and a 1 is also required,
enter 1, the area code and the seven digit number.

Site ID
Enter a  unique code for each remote site. (Only with 485 ACK-
NAK.) Use the following format:
@A [unique 4-digit number], S [unique 4-digit number]

For example @A0001,S0001 would be area 1, site 1 and
@A0002,S0003 would be area 2 site 3.

Set Password
Specify a unique password up to 8 characters long, using
numeric, alpha, or a combination of both. (Only with 485 ACK-
NAK.)
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Advanced
When Remote Loops are  selected, Advanced allows you to
define remote area communication options. (Most of  these
options, however, are only available with 485 ACK-NAK.)

IMPORTANT: If you are using Starcom or US Robotics modems and the HUB chip
version 1.04.00, you may need to add a delay value for the Pause
Between Calls parameter in order for the dial-back to function
properly. The following values are recommended:

Number of Redial Attempts: 3
Dial Command Prefix: ATDT
Wait Time Before Disconnect 45
Pause Between Calls: 24
Modem Initialize: User defined
Call In Option: On invalid transaction

NOTE: Dial-back can be defined as alarm(s) generated at a panel that
prompt the HUB to call the PC and drop the alarm, and then hangup.

Number of Redial Attempts
Enter a specific number (0-50) in the Number of Redial Attempts
box.  The default setting is zero, which results in one redial
attempt. (Only with 485 ACK-NAK.)
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Wait Time Before Disconnect
Enter a specific number of  SECONDS (1-999) in the Wait
Time Before Disconnect box.  WIN-PAK defaults this number
at 10. (Only with ACK-NAK.)

Dial Command Prefix
Specify a Dial Command Prefix. This command should be
“ATDT” in almost all circumstances. (Only with 485 ACK-NAK.)

Pause Between Calls
Enter a specific number of SECONDS (1-999) for Pause
Between Calls.  WIN-PAK defaults this number at 15 seconds.
(Only with 485 ACK-NAK.)

Modem Initialize
Enter the remote modem initialize string as
ATEØQØV1&KØ&C1&DØSØ=1&W

NOTE: Northern Computers’ modems include documentation
regarding the current modem initialization strings.

This string is made of the following options (Only with 485 ACK-
NAK.):

EØ modem command echo disabled
QØ enables modem responses
V1 verbose (text) result codes
&KØ disable local flow control
&C1 cause DCD (carrier detect) to track actual state of

remote modems carrier
&DØ ignore data terminal ready signal from computer
SØ=1 one ring until answer
&W write the active profile as defaults
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Call In Option
Specify one of two possible Call in Options: On invalid
transactions (includes buffer full) or Never. (Only with 485 ACK-
NAK.)

Verify Communication
Enable this option to ensure that all panel communication is
supervised. This option is automatically enabled when 485
ACK-NAK is selected and cannot be turned off.

Communications

The options in this section can be edited only when Camera
Control or Unknown is selected from the Type drop-down list.
Refer to your CCTV or other serial device manual for proper
settings. For information on Pelco CM9750 camera support,
refer to Appendix I.

Deleting an Area
Select the area you want to delete and click the Delete button.
If you are sure you want to delete the area, click OK when
prompted to confirm the delete.

NOTE: You cannot delete an area that is assigned in another database.

The record continues to appear in the data list although it is
unavailable. New records cannot use its name until the database
is packed (see Chapter 7).



DATABASES

Programming Databases 7777777777

Databases

The Panel Database

Panels are an integral part of the access control system. They
control card readers, locks, alarms, and other inputs and outputs.
Although they are programmed from your WIN-PAK software,
they run independently. They can even save transaction
information when your computer is off  and transmit it to your PC
when you turn it back on. This database lets you assign
parameters for each panel.

Open the Panel database by selecting the Panels... option from
the Database menu.

The Panels database window lists all defined panels. For each
panel it lists a Panel Name, Panel Number, Type, PROM
Version, Digits and whether Keypads and Groups are enabled.
The status of the panel is also indicated.

A Sort Order option is available on the bottom of  the window.
Click the drop-down list button to change the sort order. This
database allows you to sort by the order in which the records
were entered (None) or alphabetically by panel name (Panel).
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When sorted by Panel, search by entering the name in the search
box and clicking the Search button (  ). The Search function
does not work when None is selected for sorting.

Adding or Editing a Panel

To add a new panel simply click the Add... button and fill out
the different tabs of  the Panel Detail screen. To edit a
previously defined panel, select it and click Edit. This allows
you to view or modify its information.

WIN-PAK organizes panel information in five or six tabs on the
Detail Screen, which are accessible when you add or edit a
panel. These tabs include information on the panel, timezones,
readers, input and output points, and groups of output points (if
enabled). Click a tab to access information associated with the
tab.
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NOTE: The OK button appears on every screen but should only be clicked
when data on all of the screens is configured. Clicking OK saves all
changes and closes the current panel detail window.

Panel Tab

The first tab screen (previous illustration) of  information is
labeled Panels and contains the most general panel information.
The information fields are described as follows.

Name
Enter a name for the panel in the space provided. It can consist
of  twenty characters including letters, numbers, and spaces.

NOTE: Although “Name” is the first field in the Panels screen, panel “Type”
must be defined first.

Loop (Area)
Click the drop-down list and pick the panel area from the list of
defined areas.

Once an area (loop) is selected and OK is clicked to save the panel,
you cannot re-assign another area (loop) to the panel. The area itself,
however, can still be edited from the Area Database.

Address
Assign a unique address to the panel. This address must match
the panel’s address setting. You can number panels from 1 to 63
for C-100 loops or from 1 to 31 for RS-485 loops. An error
message warns if the number is the same as another panel in the
same loop (area) or if the number is higher than allowed. This
field cannot be altered after clicking OK to save the panel data.
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Type
Select the type of control panel, from the list available. This
selection determine which panel options are available. This field
cannot be altered after moving from this screen.

Digits
The five and twelve digit option in the Serial Ports section of
the Setup menu restricts or allows firmware choices, and limits
card programming between 5 and 12 digits at the panel level. If
5 digits was chosen in the Setup menu, this option cannot be
changed in the Panel Database and is unavailable.

NOTE: Site codes cannot be used with 12-digit cards.

If  12 digits was chosen in the Setup menu, WIN-PAK allows
you to select either 5 or 12 digits at the panel level for individual
panels with firmware version 7.49 and up. When 5-digits is
selected, card numbers between 1 and 65534 are accepted.
When 12-digits is selected, a default card format is sent. This
default reads, in order, the first 12 positions of the card, accepting
card numbers from 1 to 999999999999. It may be necessary to
change this format structure for certain applications. Refer to the
panel documentation for more information.

Command File
Select a command file from the panel. List of all command files
in the Command File database. The command file selected is sent
to the panel when it is initialized. To remove a command file,
select NONE. For more information on command files, see the
section on the Command File database.

Version
Select the PROM version of the panel from the list. This
selection changes the number of card digits that can be
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recognized by the panel and the availability of certain hardware
options. The version number is printed on the firmware chip on
the panel’s circuit board.

NOTE: When WIN-PAK 1.17 is used with version 8.02 firmware or higher, year
data is sent to the panels which enables panels to recognize leap
years, even in the buffer mode.

Status (Panel)
Active
Select Active if the panel is on-line and you are expecting
transactions from it or will be sending commands to it. WIN-
PAK looks for that panel every two minutes if  no events have
been sent by the panel.

Inactive
Select Inactive if the panel is installed but communications are
stopped. A temporary file is created that tracks additions,
modifications, and deletions to the card database. These
changes are uploaded to the panel when it comes back on-line.

Not Present
Select Not Present if the panel has not been installed, but you
anticipate that it will be in the future. No temporary files are
created.

Enable Options Section
Anti-passback
Anti-passback is used to discourage users from entering with
others without using their own cards. Cards must be used at a
designated IN reader, then at a designated OUT reader before
the card can be READ IN again. If the in/ out/ in pattern is
broken, an anti-passback violation occurs and access is denied.
A reader on each side of the door is required for this option.
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If anti-passback is enabled for any panel in a given area, then
the result is global anti-passback where the card must be
presented at any out reader before it can be read in again without
a violation.

NOTE: Readers 1 and 3 are considered the IN readers and Readers 2 and 4
are considered the OUT readers. Readers 3 and 4 are on the N-1000-
IV (X) only.

Forgiveness
This option is used with the anti-passback option. Enabling
Forgiveness resets all cards at midnight so that if  a card user
leaves the building in the evening without using the Anti-
passback exit reader, the person is allowed a normal entry the
next morning. Without forgiveness, an anti-passback violation
occurs in this instance. This option is automatically disabled
when Anti-passback is disabled.

Free Egress
Free egress allows an exit without the use of a card, usually by
means of  a button, motion detector, or other device. For
example, with an N-1000-II panel, card reader 1 activates one
door, and card reader 2 activates a different door. Inputs 3 and 4
are reserved for exit devices for these two doors which release
locks just like a valid card read. The table below shows how
inputs are set for different panel versions.

Input to Output interlocks must also be defined for each door.
Input 3’s Alarm Action should be set to Pulse Output 1, and its
Normal Action should be set to No Action. Likewise Input 4’s
Alarm Action should be set to Pulse Output 2, and its Normal
Action should be set to No Action. See Interlocking in the
Input Points section for more information.
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Panel Inputs

Split Timezones
Enabling the Splict Timezones option allows you to associate a
different timezone for each reader in the Access Level database.
This requires that version 8.xx or higher firmware be in the
control panel and selected in the Version field. Without this
option enabled, only one timezone is associated with every
reader on the panel in the Access Level Database.

NOTE: The Split Timezones option is available only when version 8.00 or
higher firmware is selected for the N-1000-II. N-1000-III/IV panels
require 8.2 version firmware (or higher).
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Keypads
Check the Keypads option if matrix style (11-wire) keypads are
used with the panel. Wiegand style (5-wire) keypads are treated as
readers and this option should not be selected.

PIN Numbers
The PIN Numbers options is available with a Keypad. A
keycode must be entered before presenting a card to gain
access. Do not select this option if  the panel is using keypads
without readers.

Reverse Reader LEDs
Check the Reverse Reader LEDs option to reverse the standard
LED operation of  the reader. With this option checked, a reader
that normally changes from green to red at a valid card read will
change from red to green.

NOTE: Disable the Reverse Reader LED option when using 12 digit cards
with the NR-1 reader.

Continuous Card Reads
When the Continuous Card Reads option is enabled, card readers
read cards continuously, independent of  output pulse time. If  the
option is not enabled, card readers do not recognize valid cards
while the corresponding output is energized. For example,
without the Continuous Card Reads option enabled and output
1 assigned a 10 second pulse time, a valid card read at reader 1
causes output 1 to energize for 10 seconds, during which time
the card reader does not recognize any other valid cards.
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Groups
Enable the Groups option if you want to create output relay
groups. Groups allow cards to activate more than one output
relay for applications such as elevator control (See Appendix D).
When the Groups option is used with Free Egress (“E” option),
a valid card read pulses the defined group at all readers. When
the Groups option is used without Free Egress, a valid card read
on Reader 1(3) pulses the group, and a valid card read on Reader
2(4) pulses Relay 2(4).

NOTE: Group is automatically selected if an AEP-3 is selected from the
hardware options. See the Hardware Options Section.

Site Codes Section
Enter up to 8 site codes in this section. Site codes are encoded
with a card number on cards to ensure that cards belong to the
facility where access is attempted. Click any space in the table
to enter a site code. The panel will not check for site codes if
nothing is entered in this table.

 NOTE: When the system is set up for 12 digits, Site Codes cannot be
entered.

Hardware Options Section
Select the hardware options that are used with your panel. These
include add-on boards which supervise by reporting a trouble
condition if the inputs or their wiring are tampered with.
(Northern Computers’ AEP-5 is an example of this add-on
board. Select all that apply.)

AEP-5 supervised input board (not utilized with the N-1000-
III or N-1000-IV)
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ERB solid state relay board for outputs 9-12 (not utilized
with the N-1000-III or N-1000-IV)

AEP-3 8 output relays on a single board (2 possible)

NOTE: If Northern Computers’ AEP-3 is selected, an AEP-3 (second) option
will appear for panels with two AEP-3 boards.

Advanced...
The Advanced option allows the operator to select more
advanced panel options.

Multiple Interlock Protection (MIP)
The Multiple Interlock Protection option requires that all input
points tied to a single output be returned to a normal state to
de-energize the point. Without MIP, only one input needs to
return to the normal state to de-energize the output.

Click the option to turn it on or off. A bar over the option with
the option name reversed out, as shown in the screen above,
means the option is ON. A default is ON when using firmware
7.46 and newer.
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Power Fail Reroute
Enable the Power Fail Reroute option to reroute the Power Fail
alarm from Input 8 to Input 19, which is System Alarm 3 in
WIN-PAK.

Power Fail Reroute only applies to N-1000 or N-800 panels using
version 8.2 firmware and an AEP-5 board. Input 8 on an AEP-5 board
can then be used as a wired input.

Sys Alarms...
The Sys Alarms... button defines system hardware alarms.

NOTE: The N-1000-II uses alarm 17 for Communication Failure, alarm 18 for
AUX Port Failure, and alarm 8 or 19 for Power Failure. See Advanced
Panel settings.
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Hardware Alarms
Select an alarm from the drop-down list. The information
defines the currently selected alarm. Choose from the following:

Panel Communications in alarm when the panel doesn’t sense
any current (or current below a specific value) on the receive
path of the loop (specific to panel). This has a default priority
of 1.

AUX Port in alarm when the panel senses communication
failure from the auxiliary port. This has a default priority of 99.

Panel Primary Power in alarm when the control panel loses
primary power. This has a default priority of  1.

Panel Reset in alarm when the panel is reset. This alarm
cannot be stored in the history buffer. An N-1000-II panel must
have 8.2 firmware selected for the panel to report this alarm.
This has a default priority of 1.

NOTE: System Alarm interlocking is unavailable in this version.

Poll Response in alarm when WIN-PAK does not receive a
response to its poll (M=pn K) to the panel. Three polling
attempts are made. If  WIN-PAK doesn’t receive a response
(OK message) within those three attempts, it will receive a Poll
Response alarm. This has a default priority of  1.

It is possible to define all of  these one at a time. Select an alarm
and define it, then the next, and so on. The following hardware
alarms can also be configured if  you are defining an N-1000-III
or N-1000-IV:

Tamper Switch in alarm when the enclosure of  the panel is
opened. This has a default priority of 1.

Ground Fault in alarm when an input is shorted to the Earth
Ground. This has a default priority of 1.
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Low Voltage in alarm when the panel’s 12 volt battery is low.
This has a default priority of 1.

External 5 Volt in alarm when an External 5 Volt battery has
shorted. This has a default priority of 1.

Normally Open / Normally Closed
The Normally Open / Normally Closed option is available when
defining the Panel Primary Power and Tamper Switch hardware
alarms. Use this option to define the alarm’s normal status.

Alarm State
Both Alarm and Normal conditions for the selected alarm can
be assigned a priority from 1 to 99. The Current View in Alarm
Monitor allows you to view alarms by an assigned priority. High
priority items appear at the top of the list while lower priority
items appear lower in the list.

Click in the priority box next to the status that you want to
prioritize and type in a number. 1 would be the highest priority
and 99 is the lowest  priority.
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Message
A descriptive message can be associated with each alarm status.
It appears in the Alarm Info screen to provide additional
instructions pertaining to the alarm status. Type in a message of
up to 80 characters. You must press Enter or click on another
box before clicking OK to activate changes.

NOTE: The System Alarm message appears in the Alarm Info screen only. It is
not available in History View.

Command File
If  you want a command file associated with an alarm status,
select the file from the list. This file is sent either when the
condition is received or upon acknowledgment as defined in the
Setup Options.

Print
Enable the Print option for every status that you want printed to
your alarm log printer.

Hist.
Enable the Hist. option for every status that you want kept in
the WIN-PAK history files. This keeps a log of  the status and
can be used to generate reports. By default, all options are
included in history reports.
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Timezones Tab

Click the Timezones tab to open the Timezones tab screen.
Select the timezones that are available at the panel.

The screen contains a list of  all available timezones. Click an
available timezone to add it to the Selected Timezones list.
Click a timezone in the Selected Timezones list, to take it off
the list and return it to the Available Timezones list. You cannot
remove a selected timezone if it has been assigned to a reader or
alarm input point.
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NOTE: Up to 63 blocks of time (not 63 timezones) can be used with each
panel. In the above example, Accounting uses 3 blocks of time and
Shipping uses 1.

A maximum of 63 blocks of time can be assigned to a single
panel. A block is a line containing a start time, end time, and days
valid. Each timezone may contain several blocks, so WIN-PAK
warns you if  you exceed the maximum number.

Timezones Button 

The Timezones button opens the Timezone Database, so if the
operator starts defining a panel and realizes he needs to define a
timezone for it, he can do so without leaving the Panel Detail.
The Available Timezones list automatically updates to include
the new timezone. See the Timezones section for more
information.
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Readers Tab

Click the Readers tab to open the Readers tab screen.
Configure readers for the panel being defined. The number of
readers available depends on the panel Type.

NOTE: Information defined in the Reader Screen applies only to the selected
reader.

Reader
The reader list contains all available readers. The name of  the
currently selected reader is displayed in the Reader field. All
options made in the sections below apply to the selected reader.

Readers are given the default names of the panel and number of
the reader. For example, Panel 1 R 2 is the default name for the
second reader of Panel 1. Each reader in the system must have a
unique name. Therefore, it is desirable to leave the default
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names because they are descriptive and unique, but they can be
changed if desired. Simply select the reader from the list and type
in a new name of  up to 25 characters.

NOTE: If you rename the reader, continue to include a reference to the panel
in the name. Readers on different panels cannot share the same
name.

Active
Select Active so that a check mark ✔  appears in the box. This
makes options available and also makes the reader available to
the Access Level database.

Address
This field displays the address of  the selected reader. It cannot
be edited.

Floor Plan
Not used at this time.

Viewing Monitor
From the list, select a viewing monitor to be associated with this
reader. Monitors must be defined in the Monitors Database to
use this feature. Use this option together with the Camera to
View option (below) for CCTV supervision of  a reader. The
selected monitor displays the select camera view when the
priority of either the card or the reader status exceeds the
Acknowledge threshold.

NOTE: A camera and monitor can switch to the view defined in this screen
when a status is received or on acknowledgment. Select your
preference from the Options dialog in the Setup Menu.
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Camera to View
From the list, select a camera to be associated with this reader.
Cameras must be defined in the Camera Database. The selected
camera view is displayed on the selected monitor when the
priority of either the card or the reader status exceeds the
Acknowledge threshold.

Card Read Actions
The Valid and Invalid Read sections define how particular card
read conditions are interpreted and acted upon. For each type of
read status there is the option of  assigning a priority, a message,
and a command file. Each type of read status can be set to print
to the alarm log printer and also be included with history
information for reporting purposes.

Valid Reads
A valid read occurs when a card is presented and allowed access
because it is assigned the proper access level. This returns a
normal condition to WIN-PAK, unless the card has a TRACE
status in the Card Database – then return a TRACE condition is
reported.

Invalid Reads
An invalid read occurs when a card is presented, but not allowed
access. This may be for a variety of  reasons, each of  which can
be assigned a different set of options:

• A TIMEZONE condition is sent when the card was used
outside of its valid timezone.

• A NOT FOUND condition is sent when the panel does not
recognize the card number. Usually this means the card is
not in the panel or was never validated or given access to
that reader.
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• A PIN condition is sent when an incorrect PIN number is
entered where card presentation and PIN entry is required.

• A SITE CODE condition is sent when a card with an
incorrect site code is presented.

• An EXPIRED condition is sent when a card is presented
after its expiration date or after the allotted number of uses
(as defined in the Card Database and System Setup).

• An ANTI-PASSBACK condition is sent when an anti-
passback violation has occurred in panels with this option
enabled.

Both Valid and Invalid reads can be assigned the following options:

Priority
The condition can be assigned a priority from 1 to 99. The
Current View in Alarm Monitor allows you to view alarms that
meet the alarm acknowledgment threshold (in the Setup Options),
by an assigned priority. High priority items appear at the top of
the list while lower priority items will appear lower in the list.

NOTE: A similar arrangement can be found in the Card Database where the
action is based on the individual card status. The reader or card with
the highest priority dictates the message WIN-PAK sends.

Click in the priority box next to the status that you want to
prioritize and type in a number. 1 is the highest priority and 99
would be the lowest  priority.
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Message
A descriptive message can be associated with each status which
appears in the Alarm Info View of  the Control Monitor, or in
the AutoCard lookup, so that the operator gets additional
information regarding that type of  card read at that reader. Click
in the message box next to the status that you want to add a
message to and type in a message of  up to 80 characters.

Command File
A command file can be associated with each status. This file is
sent either when this condition is received or upon
acknowledgment as defined in the Setup Options. Select the
command file from the drop-down list next to the status that
you want to link a command file to.

If a command file has also been selected for a card in the Card
Database, then both the reader and card command files are sent.
The reader command file has priority and its command file will be
sent first. Then the cards command file is sent.

Print
Enable the Print option for every status that you want printed to
the alarm log printer.

Hist.
Enable the Hist. option for every status that you want kept in
the WIN-PAK history files. This keeps a log of  the status and
can be used to generate reports.
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Input Points Tab

Click the Input Points tab to open the Input Points tab screen.
Define all input points for the panel. The tab shown below is for
an N-1000-III or N-1000-IV panel.

Input Point
The input point list contains all input points available for the
panel you are defining. The name of  the currently selected input
point is displayed at the top. All options selected apply to the
selected input point.

Input Points are given the default names of  the panel and number
of  the input point. For example, Panel 2 I 4 is the default name
for the fourth input point of the panel named Panel 2. It is good
to leave these names because they are descriptive, but they can be
changed if desired. Simply select the input point from the list and
type in a new name of  up to 20 characters.
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NOTE: If you rename the input point, continue to include a reference to the
panel in the name. Input points on different panels cannot share the
same name.

Active
Select Active so that a check mark ✔  appears in the box. If Free
Egress is selected as an option in the Panel Screen, some input
points are automatically activated and reserved for these devices.
See Appendix B for more information on interlocking for a free egress.

NOTE: Points that are not active respond as if the Silence Alarms option is
enabled. If you wish to monitor Primary Power on an N-1000-II/N-800
panel with versions 7.0, 7.3, 7.46, 7.48, 7.49, or 8.0 firmware, then
Input 8 must be active. If using version 8.2 firmware, check the panel’s
Advance setting to see if input 8 is used for Primary Power.

Address
This field displays the address of the selected input point.

Supervised
Enable the supervised function if  the input point is electrically
wired to prevent tampering. This option is only available when
defining an N-1000-III or N-1000-IV panel.

Normally Open / Normally Closed
Determined the normal status of  the alarm circuits. This option is
only available when defining an N-1000-III or N-1000-IV panel.
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Silence Alarms
Enable this option to turn off  alarm point reporting associated with
the input, such as with an egress device.

Debounce Time
Debounce Time is the length of time (in seconds) that an input
must be in alarm condition (or returned to normal) before it is
recognized as an alarm (normal). For example, an input point
with the debounce time of  5 must be in alarm condition for five
seconds before it is reported as an alarm. The same is true when
returning to the normal condition. The point does not report as
normal until it is in the normal state for five seconds. This can
be set from 0 to 255 seconds.

Shunt Time
Shunt time is the amount of time (in seconds) that the input
point is shunted (deactivated) when triggered, such as upon a
valid card read. This can be set from 0 to 63 seconds.

Timezone
Select a timezone from this list if you want the input point to be
automatically shunted during a particular timezone. This list
contains only the timezones selected for this panel.

Floor Plan
Not available at this time.
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Viewing Monitor
From the list, select a viewing monitor to be associated with this
input. Monitors must be defined in the Monitor Database to use
this feature. Use this option together with the Camera to View
option (below) for CCTV supervision of  an input. The selected
monitor displays the selected camera view when a change of
state occurs at the alarm point.

NOTE: A camera and monitor can switch to the view defined in this screen
when a status is received or upon acknowledgment. Select your
preference under Send Command File from the Options dialog in the
Setup menu.

Camera to View
From the list select a camera to be associated with this input.
Cameras must be defined in the Camera Database to use this
feature. The selected camera view is displayed on the selected
monitor when a change of  state occurs at the alarm point.

Interlocking
Interlocking, in the case of inputs, is linking the changing state
of the input to either another input, an output, or a group of
outputs. Enable Interlocking for this input by clicking in the
Interlocking box. A check mark ✔  will appear and the entire
section can then be edited.

NOTE: Inputs, Outputs, and Groups must be made “active” to appear in the
drop-down list for interlocking.

1. Select whether you want to interlock to an output (output
group) or an input. This determines which points and groups are
available in the Point List.
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NOTE: Defaults are  created for interlocks if the “Free Egress” option is
enabled. These fields can be modified if needed.

2. From the list, select the name of the point list that you want to
interlock.

3. From the alarm Action list, select the action taken by the
second point when the initial input goes into alarm.

4. From the Normal Action list, select the action taken by the
second point when the initial input goes into normal status.
See Appendix C for the actions that can be chosen and more
information on interlocking.

Alarm State Section
An input point must be in one of  four states: Alarm, Normal,
Door Ajar, or Trouble.

Alarm
When a device attached to an input point is in
alarm condition.

Normal
When a device attached to an input point is in normal operating
condition.

Door Ajar
When a door contact is open longer than its shunt time.

Trouble
When an alarm circuit is out of  specified tolerance which may
indicate tampering or other “troubles” with the alarm point.

NOTE: The Trouble state only appears in N-1000-II panels when the AEP-5 is
used. It is always available with an N-1000-III or N-1000-IV panel.

Each of  these states can be assigned a priority, a message, and a
command file as well as be included in real-time printing and
History Reports.
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Priority
The state can be assigned a priority from 1 to 99. The Current
View in Alarm Monitor allows you to view alarms by an
assigned priority. The higher the priority the closer the alarm will
appear to the top of the list.

NOTE: A priority of 0 is displayed in the Alarm Monitor when a new panel is
brought on-line. Once WIN-PAK fully initializes the panel, the defined
priorities are applied.

Click in the Priority box next to the status that you want to
prioritize and type in a number. Priority 1 is a very high priority
item and 99 is a very low priority item.

Message
A message of up to 80 characters can be defined for each state.
This message appears in the Alarm Info screen for the input.
Click in the Message box and type it in the message.

Command File
If you want a command file associated with a particular state,
select the file from the List. This file is sent either when the
state is received or upon acknowledgment as defined in the
System Setup options.

Print
Enable the Print option for every alarm state that you want
printed to the alarm log printer. An “x” shows that it is enabled.

Hist.
Enable the Hist. option for every state that you want kept in the
WIN-PAK history files. This keeps a log of  the state’s
occurrences and can be used to generate reports. An “x” shows
that it is enabled.
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Outputs Points Tab
Click the Output Points tab to open the Output Points tab
screen. Define all output points or groups for the panel.

Output Point
The output point list contains all defined output points and
groups available for the panel. The name of the currently
selected output point or group  is displayed at the top. All
options selected  apply specifically to this output point or group.

NOTE: If you rename the output point, continue to include a reference to the
panel in the name. Output points on different panels cannot share the
same name.

Output points are given the default names of the panel and
number of  the output point. For example, Panel 4 O 3 would
be the default name for the third output point of the panel
named Panel 4. Groups are given the default names of the panel
and number of  the group. For example, Panel 4 G 1 would be
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the default name for the first group of the panel named Panel 4.
It is good to leave these names because they are descriptive, but
they can be changed if desired. Simply select the output point
from the list and type in a new name of  up to 20 characters.

Active outputs above 14 are defined by attaching them to a
group. The group can then be programmed as an output.

Active
Select the Active box so that a check mark � appears in the
box. This ensures that the output appears in other components
of  WIN-PAK (i.e. Groups, Interlocks, and Panel Control). If
Free Egress is selected, some input points are automatically
activated reserved for these devices. See Appendix C for more
information on interlocking for a free egress.

Pulse Time
The Pulse Time is the amount of time an output pulses when
triggered, such as upon a valid card read. Set this from 0 to 63
seconds.

Timezone
Select a timezone from this drop-down list if you want the
output point or group to be energized during a particular
timezone. This list contains only timezones selected for this
panel in the Timezones Database.

Address
The Address field displays the address of the selected output
point. This field cannot be changed. Groups are denoted by their
100 series number. For example, Group 1’s address is 101.
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Panel Outputs

tuptuO VI-0001-N III-0001-N II-0001-N

10 1rooD 1rooD 1rooD

20 2rooD 2rooD 2rooD

30 3rooD yrailixuA yrailixuA

40 4rooD yrailixuA yrailixuA

50 yrailixuA yrailixuA yrailixuA

60 yrailixuA yrailixuA yrailixuA

70 yrailixuA yrailixuA yrailixuA

80 yrailixuA yrailixuA yrailixuA

90 A/N A/N B*RE

01 A/N A/N B*RE

11 DEL1redaeR DEL1redaeR BRE

21 DEL2redaeR DEL2redaeR BRE

31 DEL3redaeR A/N DEL1redaeR

41 DEL4redaeR A/N DEL2redaeR

42-71 3-PEAts1 3-PEAts1 3-PEAts1

23-52 3-PEAdn2 3-PEAdn2 3-PEAdn2A
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*Not available when an AEP-3 is used.
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Interlocking
Interlocking, in the case of outputs, is linking the changing state
of the output to either another output, an input, or a group of
outputs. Click the Interlocking box to enable this option. A ✔
appears in the box and the entire section can be edited.

1. Select whether you want to interlock to an output (output
group) or an input. This determines which points and groups are
available in the Point List. Outputs 17-32 cannot be directly
interlocked because they are not physically located on the panel.
However, once that output is in a group, the group can be
interlocked.

NOTE: Inputs, Outputs, and Groups must be active to be available for
interlocking.

2. From the Point list, select the point that you want to interlock.

3. From the ON Action list, select the action the second point
takes when the initial output goes into on status.

NOTE: Defaults are created for interlocks if the Free Egress option is
enabled. These fields can be modified if needed.

4. From the OFF Action list, select the action the second point
takes when the initial output goes to an off  status.

See Appendix C for the actions that can be chosen and more
information on interlocking.
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Groups Tab

If the Groups option is enabled, click the Groups tab to open the
Groups tab screen. Define any desired groups of  output points.

Group
A group is one or more active output points grouped together so
that they all respond to the same triggering action. There are 32
possible groups available for a panel. The name of the currently
selected group is displayed at the top of the list. The Selected
Output Points list applies specifically to this group.

NOTE: If you rename the group, continue to include a reference to the panel
in the name. Groups on different panels cannot share the same name.
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Groups are given the default names of the panel and number of
the group. For example, Panel 2 G 7 is the default name for the
seventh group of the panel named Panel 2. It is good to leave
these names because they are descriptive, but they can be
changed if desired. Simply select the group from the list and
type in a new name.

Active
Select Active, so that a check mark � appears in the box. The
group then appears in other components of  WIN-PAK.

Available Output Points and Selected Output Points
All output points defined for this panel are listed as Available
Output Points. Click an output point in this list to add it to the
Selected Output Points list for the Group. Click it in the
Selected list to remove it from the group.

NOTE: Output points must be active before they are listed as Available
Output Points.

To define the group’s timezone control, pulse times, and
interlocking, return to the Output Points Screen and select the
group from the list of  points. The group has an address of  101
or greater.

Select Timezone, Pulse Time, and Interlocking as outlined in the
Output Points Screen section of  the manual.
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Deleting a Panel

From the panel tab, select the panel you want to delete and click
the Delete button. Verify that you have taken all the proper
steps outlined in the confirmation box. If  you are sure you want
to delete the panel, click OK.

The record will continue to appear in the data list although it is
unavailable. New records cannot use its key fields (i.e., name or
number) until the database is packed (see Chapter 7).
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The Schedules Database

The WIN-PAK Schedules Database can execute certain WIN-
PAK functions at scheduled times. The following four functions
can be scheduled to happen at regular intervals:

Panel Time & Date Update
Panel Time & Date Update uploads the time and date to every
direct connected (hardwired) panel.

Backup Reminder
Backup Reminder sends a pop-up message to remind you to
back up your WIN-PAK database and history files.

Auto Dial-Up
Auto Dial-up contacts each dial-up panel and sends command
files, unbuffers panels or uploads time and date.

Card Activation & Deactivation
Card Activation & Deactivation checks activation and
deactivation dates for cards and updates the card status
accordingly. The Card Activation & Deactivation by Scheduler
option must be enabled in WIN-PAK Setup and cards must be
assigned activation and deactivation dates.

NOTE: For remote panels, the cards are sent and stored in a temporary file.
When a panel is on-line, either through auto-dialup from the scheduler
or manual dial-up, the commands in the temporary file are sent,
updating the cards if Send Commands is checked.
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Open the Schedules Database by selecting Schedules... from the
Database menu. Add a scheduled function by filling out the
fields as described below.

Name
Type a Name for the Schedule in the text entry box.

Type
From the Type list, select the type of  scheduled event that you
want to define. You can select from Panel Time & Date Update,
Backup Reminder, Auto Dial-up, or Card Activation & Deactivation.

Frequency
From the Frequency list, select how often the scheduled event
should take place. You can select Once, Every Hour, Every Day,
Every Week, Every Two Weeks, Every Month, or Never.
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Next Date/Time
Enter the next date and time that the event should take place.
The ellipses button opens up a month dialog. Navigate to the
month that you want to start the event and select the
appropriate date.

Use the time text entry boxes to enter the time that you want the
event to happen. The first box is hours (in 24 hour format) and
the second box is minutes. Use the arrow keys to increment/
decrement the numbers by 1.

If Auto Dial-Up is selected, the Auto Dial-Up tab is available.
Click this tab to bring up the Auto Dial-Up screen.

Remote Area
From the Remote Area list, select the area that you want to dial.
This list contains all defined Remote sites.

Unbuffer Option
The Unbuffer Option unbuffers all panel transactions from the
remote site with the defined schedule.
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Send Commands Option
The Send Command option sends the stored card commands to
the remote panels. These commands include card additions and
deletions, and cards that have been activated or de-activated from
the Scheduler Database.

Send Date & Time Option
The Send Date & Timeoption sends the computer’s date and
time to the remote panels.

Click OK to save the changes or Cancel to quit without saving
the schedule.
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The Guard Tours Database

The WIN-PAK Guard Tours database defines tours that a guard
can patrol to help secure a facility. Defined tours allow the guard
a certain amount of time to present a card to each reader on his
route. Early or late arrivals produce an alarm message in WIN-
PAK.

Both card readers and input points can be checkpoints in a tour.
However, the first checkpoint in the tour must be a card reader.
Invalid cards (card not found) can be used to satisfy
checkpoints, except for the first stop in a tour.

To open the Guard Tour database, select Guard Tours... from the
Database menu.

The Guard Tours data list shows each guard tour represented by
a folder. Click a folder to open it and display detailed
information on the tour. The detailed information shows the
check point readers in sequence, with the time allowed to get
from one check point to the next. Tolerances for early and late
arrival are also given.



116116116116116 WIN-PAK 1.17 User Manual

A Sort function is available at the bottom of  the window. Click
the drop-down list button to change the sort order. This
database allows you to sort by the order in which the records
were entered (None) or alphabetically by name (Guard Tour).

When sorted by Guard Tour, search by entering the name in the
search box and clicking the Search button (  ). When None is
selected for sorting, the Search function is disabled.

Adding or Editing a Guard Tour

Click Add... to enter a new guard tour or Edit... to modify the
currently selected guard tour. This opens the Guard Tour Detail
window.

Guard Tour
Enter the name of the guard tour in the text entry box. The
name can be a descriptive name containing up to twenty
characters with any combination of  letters, numbers, or spaces.
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Area
Click the Area drop-down arrow and select the loop you want
to include in the Guard Tour. Or select ALL to make all readers
and input points available.

Panel
Click the Panel drop-down arrow and select the panel that has
the readers and input points that you want to include in the
Guard Tour. Or select ALL to make all readers and input points
available.

Available Check Points
Notice that both readers and input points are available for
selection as checkpoints.

Readers
Double click on each reader you want to include in the tour. It is
added to the list of  Selected Check Points. The order can be
changed after the points are selected. Invalid card swipes (card
not found) can be used to satisfy check points, except for the
first stop in the tour. The first check point in the tour must be a
card reader.

Input Points
Double click on each input point you want to include in the
tour. It is added to the list of  Selected Check Points. The order
can be changed after the points are selected.

Selected Check Points
Selected Check Points is the list of  readers and input points in the
guard tour. Readers and inputs may be selected from the list of
Available Check Points more than once.
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The order of the check points can be changed by selecting a reader
or input point and using the Move Up and Move Down buttons
at the bottom of  the window. The Move Up button moves the
check point further ahead in the tour, and the Move Down button
moves it later in the tour.

To remove a check point, select it and click the Delete button.

Time
The Time column allows you to enter an amount of time
required to reach each check point. This time is from the start
of the tour for the first check point, and from check point to
check point for the rest of  the tour. Click the Time column for
each check point and enter the duration as hours : minutes.

NOTE: Typing a number less than 60 and hitting Enter will be registered as
minutes. For a longer period of time, type the number of hours, a
colon (:) and the number of minutes, and hit Enter.

Plus ( + ) and Minus ( – )
For the time needed to reach each check point, a tolerance for
late and early arrival can be given. Click on the check point in
the ( + ) column and enter the amount of time tolerated for late
arrival as hours : minutes. Click on the check point in the ( – )
column and enter the amount of time tolerated for early arrival
as hours : minutes.

In this screen, the guard has 5 (10-5) to 12 (10+2) minutes from
the start of the guard tour to reach the reader at the Loading
Dock Entrance. The guard then has 10 (15-5) to 17 (15+2)
minutes to reach the reader at the Sales Area Entrance.
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Guard Tour Alarms

There are only two possible alarms, early arrival or late arrival. If
a card is not presented at the appropriate reader or the specified
input point doesn’t change to alarm state within the allotted
time, an alarm is generated indicating a missed check-in.

If a card is presented to the appropriate reader too soon or the
specific point changes state too soon, a different alarm is
generated indicating an early arrival.

Both of  these alarms can be assigned a priority, a message, and a
command file as well as be included  in log printing and history
reports.

Priority
The alarm can be assigned a priority from 1 to 99. The Current
View in Alarm Monitor allows you to view alarms by an
assigned priority. The higher the priority (lower number) the
closer the alarm is to the top of  the list.

Click in the Priority box next to the alarm that you want to
prioritize and type in a number. A priority 1 is a very high
priority item and 99 is a very low priority item.

Message
A message of  up to 80 characters can be defined for each alarm.
This message appears in the Alarm Info screen for the alarm.
Click in the Message box and type in the message.

Command File
To associate a command file with an alarm, select the desired
file from the drop-down list next to the alarm. This file is sent to
the panel, either when the alarm is received or on
acknowledgment, depending on which System Setup options
you selected.
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Print
Enable the Print option for each alarm that you want printed to
the alarm log printer. An “x” shows that it is enabled.

Hist.
Enable the Hist. option for each alarm that you want kept in the
WIN-PAK history files. This keeps a log of  the alarm’s
occurrences and can be used to generate reports. An “x” shows
that it is enabled.

Deleting a Guard Tour

Select the guard tour that you want to delete with the mouse
and click the Delete button. If you are sure you want to delete
the guard tour, click OK when the confirmation box asks you.

NOTE: You cannot delete a tour that is currently running.
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The Tracking Areas Database

Tracking Areas are sections of  a facility that are defined by the
readers that allow access to the area. Unlike Areas that we defined
in the Areas Database, Tracking Areas are not related to the loops
that carry communication through an access control system. They
are, rather, defined by a system administrator to logically determine
the sections of  a facility, and are an integral part of  a WIN-PAK
function called mustering. Mustering allows the operator to view
the cards that have entered into these defined areas. This is
particularly useful for tracking individuals in emergency situations.

NOTE: Tracking Areas can also be used as a list or grouping of readers to
restrict reporting information (as in “History, Cards” and Attendance
Reports).

A

B
C

D

1

3
2

4 9

6

5

87

In this diagram, A, B, C, and D are Tracking Areas. If  each area
is distinct and not nested, (a concept described later in this
chapter), then the area is defined by the readers that a card must
be presented at to gain access to the area. Readers 1, 4, and 9
allow access to Tracking Area A. Readers 3 and 6 allow access
to Tracking Area B. Reader 5 allows access to Tracking Area C
and Reader 8 allows access to Tracking Area D.
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Muster System Precautions

When designing a muster system for use with WIN-PAK, it is
important to keep the following precautions in mind:

1. Use a separate dropline (COM port) to isolate the muster
readers from the tracking units. A special line should be run to
provide a unique data path that will still be intact should the
wiring from the main facility get damaged.

2. A cold restart of the access control panel could occur from a
serious surge on the power or communication lines. This can
cause corruption of  the panel’s database and time functions.
Version 8.01.10 and higher firmware address the time problem
by generating a system alarm 99 (Panel Database, System
Alarms, Panel Reset Alarm) when the panel experiences a cold
restart. WIN-PAK will then send the current Time and Date to
the panel within 60 seconds of  receiving this alarm. The default
time and date after a cold restart is January 1st, Monday at 12:00
am. You will be able to see this time stamp on activities in the
History view. Panel Time is critical to the proper operation of
the Muster function as the most recent event is used to
determine the Tracking/Muster status of  a Card holder. If  a
card is presented to the Muster reader and the time and date
stamp is earlier than from another reader location, there will not
be a change of status to the Muster (safe) location.

3. In the event that the card database is lost or corrupted at the
muster reader, WIN-PAK will recognize all reader types (Not
Found, Timezone, Normal, Trace, Pin Violation, and Expired)
as “valid” muster reads (provided that the time is later than the
previous card read as described above). This function will
prevent the need to reload the cards to a muster panel during a
muster event. Only Valid and Trace card reads will count at a
Tracking reader.
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4. The communication loops should be RS-485. WIN-PAK should
have corresponding Areas defined as RS-485 with ACK-NAK
enabled. If using N-485-API-2s, they must be powered by a
battery backed up power supply (not required for N-1000-III or
N-1000-IV where the 485 is built into the control panel and is
already using the battery backup of the control panel).

5. An UPS or other backup power source should power the WIN-
PAK computer, N-485-PCI-2 and other associated
communication devices. Installation of  the equipment should be
in a location that is considered “safe” from known hazards.

6. The muster system should be on-line (not buffered) to ensure
timely and complete information. Regular checks to ensure that
the muster system is functioning properly should be performed
as part of the security routine and should be rigorously enforced.

7. As mentioned above, it is critical that the time and date be
correct on card reads at the Muster readers. If  the time and/or
date are earlier than that of other reads in the system they will
be ignored. For this reason, regular checks should be made to
see that all panels are maintaining the correct time and date. The
checklist for actions to be performed at the computer during the
time of the muster should include several checks to be sure that
the muster reads are coming in from the panel with the correct
time and date. If  it is observed that they are not, officials should
order the swiping of cards stopped, and the time and date
should be sent to the panel. A quick test should then be run and
all people who might have swiped their card during a time when
the time and/or date were incorrect should be directed to repeat
their swipe. Multiple swiping of the same card at the Muster
reader will not adversely affect the result of the Muster as the
most recent time/date stamp is the one that is “displayed” in the
Muster section. This procedure should be practiced regularly, so
personnel have a clear familiarity with it. The Scheduler should
also be programmed to update time and date at least once a day.



124124124124124 WIN-PAK 1.17 User Manual

The Tracking Areas Database can be accessed by selecting the
Tracking Areas... option from the Database menu. This will
open the Tracking Areas Data List.

The Data List contains the names of all defined tracking areas
and their type. Clicking on a tracking area folder will show the
readers that define it.

Under the Data List you will see the sorting order of the list. By
clicking the drop-down list button, you can select how you want
to sort the tracking areas for viewing. This database allows you
to sort by the order in which the records were entered (None) or
alphabetically by name.

When sorted by Tracking Area, an area can be searched for by
entering the name in the search box and clicking the Search
button (  ).
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Adding or Editing a Tracking Area

Click Add... to enter a new tracking area or Edit... to modify the
currently selected tracking area. This will bring up the Tracking
Area Detail window.

Tracking Area
Enter a name for the tracking area in the space provided. It can
consist of  twenty characters including letters, numbers, and spaces.

Type
Areas that can be set up fall under one of three categories: Exit
Areas, Tracking Areas, and Muster Areas. Below are a
description of each.
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Exit Area
When you first view the Tracking Areas Data List you will
notice a predefined area called EXIT. It is defined by a reader or
group of readers that are used to remove card read records from
the tracking and muster areas. The perception of  this “area” is
that when a person presents a card at one of these readers, they
have left the areas of  concern (e.g., they have gone home, or to
another facility). They will no longer be tracked in reference to a
possible muster call. This option can be edited to add or remove
readers, but the area itself cannot be deleted.

NOTE: The Exit area is also used in the Attendance Report to indicate an end
to a calculation.

Tracking Area
A tracking area is an area containing readers at which presented
cards are tracked in case of a muster call.  The first time a
person presents a card at one of these readers, the read event for
that particular card is recorded and may be viewed in the “Non-
Muster Card Transactions” screen. Each time that same card is
presented at one of the readers in that area, the previous record
for that card is replaced by the new record. The screen will
display the most recent records of  card reads from an individual
area or from all areas at one time. Reports can be generated in
the same manner. All reads from each card will continue to be
tracked in a similar manner until the card is presented at a
muster reader or an exit reader. When a card is presented at a
muster reader, the record of the card is moved to the Muster
Area Screen. When a card is presented at an exit area reader, it is
removed from the muster system.

NOTE: Tracking area definitions can also be used in Card/History Reports
and Attendance Reports.
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Muster Area
Like tracking areas, muster areas are also logical areas, not
defined by the hardwiring of the system. They contain readers
that will only be used by card users if there is a call for muster
(in the event of a disaster, for example). Several different muster
areas can be created. The Muster Area Card Transaction screen
will display card read events. A report can be run on cards
presented in an individual muster area or at all muster areas. In
normal conditions there will be no transactions being recorded
in the Muster Area Card Transaction screen. It will only be used
if there is a muster call (usually in an emergency).

Defining Readers

Available Readers
Along the left of  the Tracking Areas Detail Window are all
readers that are available to define the area. Click on a reader to
move it to the Selected Readers List.

Readers selected for a muster area will not be available for any
other muster area or a tracking area. Readers selected for a
tracking area will be available for other tracking areas, but will
NOT be available for a muster area.

Selected Readers
As readers are clicked on from the Available Readers list, they
are moved to this list. These are the readers that define the area.
To remove readers from this list, select them and click the
Delete button.

Click OK to save your changes to the Tracking Area or Cancel
to exit the Tracking Areas Detail screen without saving your
changes.
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Nesting  Areas
The concept of nesting is not unique to the muster system, but
does take on considerable significance when planning areas for
disaster management, and can change the way muster reports
will be run. When an area is considered “nested” in another
area, its readers are also part of  that other area.  For example,
note the diagram below.

The first general principle of nesting is that readers used to
enter an area or move about within the area should be listed
under the tracking area in the Tracking Areas Database. If  we
focus on the B and C areas shown above, we can consider those
areas in two ways.
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Not Nested
If they are not nested, then Readers 3 and 6 would be listed for
Area B in the database because those are the readers that a card
would be presented at to allow access to Area B. Reader 5
would be listed for Area C.

Nested
If we consider these same areas to be nested, we would consider
anyone who is in Area C as ALSO in Area B. In that case, we
list Readers 3, 5, and 6 under Area B and Reader 5 again under
Area C.  There can be many levels of “nesting”. There could be
another room inside of  Area C, which would be Nested under
both B and C.

The diagram would have the following Tracking Area definitions
when nesting:

Tracking Area A  Readers 1, 3, 4, 5, 6, 8, 9
(Presenting at any of  these readers shows the person in Tracking
Area A. Readers 2 and 7 both leave Tracking Area A.)
Tracking Area B  Readers 3, 5, 6
(reader 4 leaves Tracking Area B)
Tracking Area C  Reader 5
(reader 6 leaves Tracking Area C)
Tracking Area D  Reader 8
(reader 9 leaves Tracking Area D)
Reader E (Exit Reader)
Reader E causes the cardholder information to be deleted from
the non-muster or muster view screens. The card holder has
exited the tracking area.
Reader M (Muster Reader)
Reader M causes card holders to appear in the muster view
screen as per selected filter. It also removes card holders from
the non-muster view.
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The Access Level Database

Access Levels determine where and when a user’s card is valid
in the system. An access level represents the readers that a card
user can present cards to and the time period during which he
can present to them to gain access. When a card is defined in the
card database, it is assigned an access level. The ability to assign
cards to a group of doors eliminates the need to program the
card for every reader.

Select Access Levels... from the Database menu to open the
Access Level Data List.

The Access Level Data List shows the Access Level records that
have been defined. Click a record’s folder to show details of  the
access level including which readers and timezones are utilized,
and a group name (if defined). This list is sortable by the order
in which the records were entered (None) or alphabetically by
Access Level Name (Access Level).

When sorted by Access Level, an access level can be searched
for by entering the name in the search box and clicking the
Search button (  ).
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Adding or Editing an Access Level

Click Add... to enter a new access level or Edit... to modify the
currently selected access level. This brings up the Access Level
Detail window.

NOTE: When an access level has been changed, the affected panel should
be re-initialized or the cards manually updated.

Access Level
Type in a name for the access level. Use up to 20 characters
including letters, numbers, and spaces.

Available Readers
All of the readers made active in the Panel Database appear in
this list. To include the reader in your access level definition,
select it from this list. A Selected Reader Definition box appears
(next illustration).
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The reader name appears at the top of this box. All timezones
defined for this reader’s panel  are listed under Timezone on the
left. All groups defined for this panel are listed under Group on
the right.

Timezone
Select the timezone during which a person with this access level
is to have access though this reader.

NOTE: When the Split Timezones option is enabled for panels with version
8.xx or higher firmware, you are prompted for a timezone for each
selected reader. On older version firmware, the timezone defaults to
the same as the previously selected reader for that panel.

Group
Select the output group that a person with this access level is to
be able to activate. The LAST SELECTED group for a reader
on the same panel overwrites the other groups – there cannot be
split groups on the same panel.

Click OK to save or Cancel to return to the Access Level
Detail without saving.
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The Reader, Timezone, and Group are now a part of the
Selected Readers list. To remove a reader from the list, select it
and click Delete. To change its timezone or group, click on
Define Selected Reader.

NOTE: Free Egress (“E” option) determines how the panel responds to the
group. See your panel documentation for more information.

Save As...
Clicking the Save As... button allows you to save the current
Access Level under a different name. This allows you to create
new Access Levels based on existing ones with similar attributes.

New Access Level Name
Type in a name for the new access level (up to 20 characters).

Click OK to save the new access level or Cancel to return to
the Access Level Detail without saving.

Deleting an Access Level
Select the access level to be deleted and click the Delete
button. If you are sure you want to delete the access level, click
OK in the confirmation dialog box.

NOTE: An Access Level may not be deleted if it is already assigned to cards.

The record continues to appear in the data list although it is
unavailable. New records cannot use its name until the database
is packed (see Chapter 7).
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The Card Database

The card database contains information on all cards/card users
in the system. Selecting Cards... from the Database menu opens
the Card Database.

The Card Database shows the user name and card number of
the cards which have been defined. The list also has a column
of  information dedicated to the index that the cards are sorted
by. For example, if  cards are sorted by activation date, the last
column on the list is activation date.

The Card Database has the largest number of  sorting options. Cards
can be sorted by the order in which they were entered (None), by
card number (Number), by name (Card), by access level (the order
in which the access levels were entered), by activation/deactivation
dates, or by any of  the 25 user-defined note fields. See System
Setup for information on defining note fields.

To Find a Card
1 Select the desired field in the Sort Order list.
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2 Type the criteria in the Search box

3 Click the Search button (  ).

Adding or Editing a Card

Click Add... to enter a new card or Edit... to modify the
currently selected card. This opens the Card Detail screen (next
illustration). This screen contains three tab screens. The first tab
screen [Cards]contains general card information, the second
[Notes] contains notes, and the third [Badge] contains badge
information. Clicking OK from any screen closes the current
card and saves your changes. Use the tabs to move from one
screen to another and only click OK when you are finished.
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Cards Tab

The Cards tab screen (previous illustration) contains basic
information on the card and cardholder including name, card
number, access level, status, and read information.

Name
Type in the first name of  the card holder in the First text entry
space and the last name of the card holder in the Last text entry
space. Both first and last names can be up to 20 characters long.

Number
Type in the card number from the access control card. If  your
system uses keypads only (no cards), enter the keypad number.

NOTE: If you selected 5 digit cards in the Setup Options/Card Screen, then
the numbers allowed are 1 – 65534. If it is set to 12 digits, then the
numbers allowed are 1 – 999,999,999,999.

Status
Select a status for the card from the Status drop-down list. The
card must have one of four statuses: Active, Trace, Inactive, or Lost
or Stolen. When Active or Trace is selected, access is allowed as
per the access level. A card with Trace status returns a Trace
condition when presented. When Inactive or Lost/Stolen is
selected, the card is no longer valid at any reader in the system.

PIN Number
The PIN Number field is used if card users are required to enter
a PIN number with their card. For a 5 digit system, this can be
any 5 digit number between 1 and 65534. If the system is
keypad only, the number MUST be entered into the Number
field, and can then be treated as a five digit number or a 12 digit
number, if an ABA keypad is used.
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Access Level
Select an access level from the Access Level drop-down list.
This list consists of access levels previously defined in the
Access Level Database. See Access Level Database for more
information.

Limited Use Options

Card access can be limited in one of three ways: activation/
deactivation by use of the Scheduler, an expiration date, or by a
limited number of  uses. The field(s) visible for this option in the
Card database depend on the method selected in setting up
WIN-PAK. See Chapter 2 for an explanation of  each option and
instructions on selecting one.

NOTE: The Expiration Date and Limited Use options are only available if
enabled in the Setup Options. See Setup for more details.

Activation & Deactivation Date
Select Active in the Status field.

Use the ellipses buttons to set an Activation date and a
Deactivation date. The ellipses button will bring up a month
calendar. Use the arrow keys to navigate to the month you want
and then select the date. After selecting both an Activation and
Deactivation Date, the result should appear as below.

NOTE: Leaving the activation date blank will upload the card to the panels in
the card’s access level.
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Use the Schedules database to check for these dates at specified
times. When a Card Activation & Deactivation scheduled event
is performed, cards with an Activation date prior to the event
will be sent to the panels. Cards with a Deactivation date prior
to the event will be deleted from the panels and their status will
be made “Inactive” in the card database.

Expiration Date
This field is used to define an expiration date that limits the
period of  time that a card can gain access. This date can be up to
254 days from the date that this information is sent to the panels.

Enter the expiration date of the card by clicking the ellipses (...).
A month calendar  appears showing the current month or the
month of the expiration date, if previously defined.

NOTE: The computer does not have to be on-line to expire an existing valid
card. The expiration of the card is done at the panel level.

Use the backward and forward arrows to change the calendar
one month at a time. After navigating to the month of
expiration, select the exact date of expiration. The card cannot
gain access after this date. Click OK to save the date or Cancel
to return to Card Detail without saving the date.

Leave this blank if no expiration date is required. Click Cancel
to remove a date.
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Limited Use
This field is used to define the number of times that a card can
gain access.

Enter the number of uses for which the card is valid by clicking
the arrows. The maximum is 254. After the number of  uses has
passed, the card will be invalid.

NOTE: The Limited Use value decreases as the card is used.

Valid and Invalid Reads

The Valid and Invalid Read sections are used to define how
particular card read conditions are interpreted and acted upon.
For each type of  read status there is the option of  assigning a
priority, message, and  command file. Each type of  read status
can also be set to print to an event-logging printer and to be
included in history for reporting purposes.

Valid Reads
When a card is presented and allowed access because it is
assigned the proper access level, a valid read is generated. This
usually returns a normal condition to WIN-PAK. The exception
is if the card is given a Trace status in the Card Database – it
then returns a trace condition when presented.
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Invalid Reads
When a card is presented, but not allowed access, an invalid
read is generated. This may be for a variety of reasons, each of
which can be assigned a different set of options:

• A Timezone condition is sent when the card was presented at
a reader outside the time permitted by its access level.

• A Not found condition is sent when the panel does not
recognize the card number (possibly a card that is not in the
panel).

• A PIN condition is sent when an incorrect PIN number is
entered at readers where PIN entry is required.

• A Site code condition is sent when a card with an incorrect
site code is presented.

• An Expired condition is sent when a card is presented after
its expiration date or after the allotted number of uses (as
defined in the Card Database and System Setup).

• An Anti-passback condition is sent when an anti-passback
violation has occurred in panels with this option enabled.

Both Valid and Invalid reads can be assigned the following options:

Priority
The condition can be assigned a priority from 1 to 99. The
Current View in Alarm Monitor allows you to view alarms that
require acknowledgment by an assigned priority. High priority
items appear at the top of the list while lower priority items
appear lower in the list.

Click in the priority box next to the status that you want to
prioritize and type in a number; 1 is the highest priority and 99 is
the lowest  priority.
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NOTE: A similar arrangement can be found in the Readers Screen of the
Panel Database where the action is based on the card read status
itself. The read status or card with the highest priority dictates what is
displayed in the current view. If command files or action messages are
attached to both the reader and the card, both are displayed in the
Alarm Info screen or both command files are sent.

Message
To associate a descriptive message with a status, type a message
(up to 80 characters) in the message box next to the status. This
message is sent to the Alarm Info Screen so that the operator
knows what the invalid reads mean.

Command File
A command file can be associated with each status. To associate
a command file with a status, select the desired file from the
drop-down list next to the status. This file is sent to the panel,
either when this status is received or on acknowledgment,
depending on which System Setup options you selected.

Print
Enable the Print option for every status that is to be printed to
the log activity printer.

Hist.
Enable the Hist. option for every status to be kept in the
WIN-PAK history files. This keeps a log of  the status’s use and
can be used to generate reports.
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Notes Tab

Click the Notes tab to open the Notes tab screen. User-defined
information on the card user is entered here.

This screen contains a list of  25 note fields. The names of  the
fields are on the left. They contain descriptive names if they
have been defined in the Note Fields... section under the Setup
menu. Otherwise they are labeled Note 1, Note 2, etc.

To enter a note, enter information in the box next to the field to
be defined. Use up to 25 characters including letters, numbers,
and spaces. To save the note you must either hit Enter or click
on another note before clicking OK or moving to another
screen.

NOTE: Shift-F2 allows you to edit an existing field.
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Badge Tab

Click the Badge tab to open the Badge tab screen for managing
the badging component of  WIN-PAK.

If a photo has been taken for the card user, it appears in the
Image box. Photos can be incorporated into badges in several
ways. One way is to capture a photo from a source connected to
your PC. This may involve using a video camera with a video
capture card or a TWAIN device such as a digital camera or
scanner. The steps below outline the different methods available
for capturing a badge photo in WIN-PAK.
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Capturing a Photo with Video Camera and
Video Capture Board

The following steps demonstrate how to capture an image with a
video camera and video capture board. They assume that all
equipment has been connected and configured to work with
your computer.

NOTE: A program called WinImage starts when you click Photo. This
program is dynamically linked to WIN-PAK for capturing photos. It
closes automatically when the Card Database is closed.

1. Click Photo.

2. If you have a video capture board installed, a window appears
with live action from your camera. Use this image to properly
frame your photograph.

The dialog box used for capturing the photograph changes,
depending upon the video capture board selected during WIN-
PAK setup. Three elements, Freeze/Unfreeze, Primary/
Secondary, and  Compression are consistent with all capture
boards. Options that may differ for each board are covered in
the Video Capture Boards section that follows. First, the
Freeze/Unfreeze, Primary/Secondary, and  Compression
elements are defined as follows:

Freeze/Unfreeze
The Freeze/Unfreeze button toggles between “freezing” and
“unfreezing” the viewed image. When the desired image is on
screen, click Freeze to keep it on-screen. Click Unfreeze to
switch back to the live camera view.

NOTE: You can also use the space bar to toggle between Freeze and
Unfreeze.
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Primary/Secondary
WIN-PAK allows the capture of  two photos per subject. For
example, one photo can be taken from the front of the subject
and as well as one of the profile. Selection of either the Primary
or Secondary radio button determines which of  the two photos
you are capturing.

Compression
The image that is “snapped” for a record is saved to a JPEG file
which uses compression technology to decrease the size of  the
file. If desired, use the arrow keys to adjust the compression of
the saved image. The lower the number in this box, the greater
the compression. However, images lose some quality in this
process, so avoid over-compressing. A setting of  100 applies the
least amount of compression and provides the best quality image.
A setting of 30 applies the most compression, but provides a
lower quality image.

Video Capture Board Types

The options available for capturing a photo depend on the
system’s video capture card. Following is an explanation of  the
options available for different hardware.
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Integral Technologies FlashPoint

Clicking Capture Image from the Badge Screen of the Card
Database opens a window with an Advanced button. Clicking
Advanced expands the window.

You can adjust the slides at the right of  the image to enhance its
quality. These controls allow different settings for previewing
the video image and capturing it. The image seen in the Preview
mode can be brightened electronically. When the flash is tripped,
the amount of  light entering the camera’s iris is reduced
compared to the preview, allowing the flash to provide the light
saturating the subject, without over exposing the picture. (It may
be necessary to adjust the FlashPoint settings. See Appendix B.)

Preview Brightness
The Preview Brightness slider lightens or darkens the entire
tonal range of the preview image.
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Preview Contrast
The Preview Contrast slider expands or constricts the entire
tonal range of the preview image. The difference in highlights
and shadows can be greatly increased or decreased.

Capture Brightness
The Capture Brightness slider lightens or darkens the entire
tonal range of the image when the image is captured.

Capture Contrast
The Capture Contrast slider expands or constricts the entire
tonal range of the image  when the image is captured. The
difference in highlights and shadows can be greatly increased or
decreased.

Saturation
The Saturation slider controls the vibrancy, or amount of  color,
in the background image.

Hue
The Hue slider controls the value of color in the background
image. Adjusting this can correct photos that seem to have
incorrect color.
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Sharpen
The Sharpen slider sharpens blurry images by increasing the
contrast of  adjacent pixels. The highest value is 7.

Compression
The captured image is saved as a JPEG file which uses a
compression technology to decrease the size of  the file. If
desired, use the arrow keys to adjust the compression of the
saved image. The lower the number in this box, the greater the
compression. However, images loose some quality in this process,
so avoid over-compressing. A setting of  100 applies the least
amount of compression and provides the best quality image. A
setting of 30 applies the most compression, but provides a lower
quality image.

NOTE: Lower compression produces a better quality image, but the image
file is larger. An image compressed at 100 is approximately 80k. An
image compressed at 30 is approximately 8k.

Save Settings
The Save button saves the position of the sliders so that you
can use the same settings for all of  your badges.
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TWAIN Compatible Interface

If  your system is equipped with a TWAIN Compatible Interface,
you can capture photos and backdrops from other devices such
as scanners. Clicking Capture Image from the Badge Screen of
the Card Database opens a capture dialog.

The FIRST time you capture an image, click the Source...
button. This shows the TWAIN drivers present on your
computer. Choose one and click Select. The TWAIN interface
uses this driver until you select a different one.
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To capture an image, click the Acquire button. This opens a
device dialog box based upon the previously selected source.
See your device manual for information on how to use its
TWAIN interface.

The compression for a TWAIN device is set at the maximum
(30). If less compression (more detail) is required, then
compression can be set manually.

1. Close WIN-PAK

2. Open the BADGER.INI text file (see Appendix E: Database
and *.ini Files).

3. Enter the following line under the [Preferences] section:
JPEG_Compression=nnn

(where _ is a space and nnn is the compression level; 100 is the
least compression, while 30 is the most).

Import Photo
WIN-PAK allows you to import an image in addition to
capturing an image with a video capture card. This is useful if
you already have images of your personnel or if you want to
retouch images that have been previously captured. To do this,
take the following steps:

1. From the Badge Screen, click Import Photo to open the Import
Photo window.

2. Click Open… to open a dialog box for you to browse your
folders and find your image.
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Type drop down list. You can select from DIB (*.BMP), JPEG
(*.JPG or *.JP2), PCX (*.PCX), Targa (*.TGA), and TIFF
(*.TIF) files.

NOTE: Infrequently, you may find a JPEG file that cannot be imported into
WIN-PAK. Try opening the file in a graphics program and saving it as
a *.BMP file.

4. Find the directory that your image is in by selecting the correct
drive from the Drives drop down list and then double clicking
on folders to navigate to the correct directory.

5. Your image should then be in a list under File Name. Select it
and click the OK button to import it. The picture appears with a
frame in the center (next illustration).
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6. Click and drag from within the frame to move it and use the
handles on the sides of the frame to resize it.

7. Click the Primary option to use this photo in badge layouts that
have a primary photo placeholder or click the Secondary option to
use this photo in badge layouts that have a photo placeholder
for a secondary picture.

8. When the frame contains what you want in the picture, click
OK.

9. Click the appropriate View button to update the view of the
badge with the new photo.
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Capture Signature

Having a card backdrop designed with a signature block is the
first step to putting a signature on a card. The second step is to
actually capture the signature. This is done in WIN-PAK from
the Badge Screen of the Card Database.

NOTE: Only one signature can be imported per card record.

As part of  the WIN-PAK installation procedure, a prompt asks
you if  you have a signature pad. Clicking Yes adds a line to the
BADGER.INI file, enabling the device. If you are adding the
pad after WIN-PAK has been installed, follow this procedure to
enable signature capturing for your PC:

1. Close WIN-PAK.

2. Using a text editor, add the following line to the [Preferences]
section of  BADGER.INI (Located in the WINDOWS directory:

SigPad=Penware

3. Open WIN-PAK

Then for each signature take the following steps:

1. In the Card Database, open the record of each person you want
a signature captured. Click the Badge tab to open the Badge
screen.

2. Click the Signature button.
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The dialog box (next illustration) opens,  reflecting all activity
on the signature pad.

3. Have the badge user sign their name on the pad. To clear off  the
name and start over, press the left button on the signature pad,
or cancel button.

When the signature looks the way you want it, press the right
button on the signature pad or OK. This saves the signature and
exit to the Badge screen. The signature appears in the badge
preview when you click on the View Badge button.

Import Signature

Signatures do not need to be captured from within WIN-PAK. They
can also be captured using the WinImage capturing software, saved
to a file, and imported into WIN-PAK at a later time. To import a
previously captured signature, follow the steps below:
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1. Click Import Signature. This opens a dialog box (illustration
below) for opening a signature file.

2. Find the directory that your signature is in by selecting the
correct drive from the Drives drop-down list and then double
clicking on folders to navigate to the correct directory.

3. The signature should be in the list under File Name.  The file
must have an .SIG extension. Select it and click the OK button
to import it.

Assigning a Badge Layout

To assign a badge layout to a card, click the Badge Layout drop-
down list and select one. This list contains all the layouts
defined in the Backdrops Database (see Chapter 4). To see the
layout selected, click View Badge. This option shows the
backdrop with photo, signature, and field information.
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Ultra Electronics Tango/Fargo Printer Options

If  an Ultra Electronics Tango or Fargo duplexing printer was
selected as your badge printer when installing WIN-PAK, you
have the option of selecting a front and back badge layout as
shown:

Click the appropriate drop-down list button to select a front and
back badge layout. Click the View Front button to view the
front design or the View Back button to view the back design.
Enabling Default Back Layout makes the current back layout
design the default with all defined badges.
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Printing a Badge
Clicking Print allows you to print a badge using the current
visible record. A printer dialog box appears (illustration below),
allowing the selection of  printer options.

NOTE: If a printer other than an Ultra Electronics Tango or Fargo printer was
chosen during installation configuration, a different printer dialog box
appears.
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Printer Layouts

Clicking OK brings up a dialog box (illustration below) to print
the badge. A preview displays how the badge will fit on the card
(or page) using the printer you selected.

Current Printer Layouts

Although most badge printers print well with WIN-PAK’s
default settings, the Page Layout Dialog box allows you to
define different layouts for printing badges.

Creating a New Layout

1. Click New….

2. Type in a New Page Layout Name in the dialog box provided
and click OK.

3. Click Edit…. An Edit Page Layout dialog box appears (next
illustration).
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NOTE: Only one layout prints per page when printing on a 8 1/2” x 11” (or
larger) sheet. If you want to print more than one per sheet, you must
create multiple layouts – one layout for each badge position. Then
reinsert the paper to print again. Repeat until the desired amount of
printing is accomplished per page.

4. Use the badge settings to determine the number of  rows on a
page, their height and the number of columns and their width.
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5. Use the Left and Top Margin offsets to determine how far from
the left and top of  the page that the first badge prints. Click the
Center button if you want the badge (or badge group) centered
on the page.

6. Click OK to accept the changes or Cancel to return to the Page
Layout dialog box.

Magnetic Stripe Options

If a printer with magnetic stripe printing capabilities is used,
WIN-PAK can use the printer to encode the card. The following
outlines the options used in this procedure.

Encode Mag Stripe
Enable this option to print a magnetic stripe on a card. You
must use a printer with this capability, define a magnetic stripe
in the badge layout, and use a magnetic stripe card.

Encode Without Printing
Enable this option to encode the magnetic stripe without the
other elements of the badge. This option is only available if the
Encode Mag Stripe option is enabled.

Mag Stripe Printer…
The Mag Stripe Printer... button opens a dialog containing the
names of printers that encode magnetic stripes. Select the printer you
are using and click OK.

Click Print to print the card or Cancel to go back to the
database without printing.
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Printing with a Ultra Electronics Tango/Fargo Duplex
Printer

If  an Ultra Electronics Tango or Fargo printer is selected during
installation, a dialog box appears allowing the operator to select
options for printing.

Printer
From the Printer drop down list, select the printer that you are
using.

Print Both Sides
Enable the Print Both Sides option if you will be printing both a
front and a back on the badge. Make sure that the badge being
printed has a backdrop defined for both sides.

NOTE: Verify the printer driver is setup correctly before printing.
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Rotate Back Side 180°
Enable the Rotate Back Side 180° option if you are printing on
both sides of the card and want the back side of the card to be
printed upside down (180°). This option is only available if the
Print Both Sides option has been enabled.

Encode Mag Stripe
Enable the Encode Mag Stripe option if you want to encode a
number onto a badge with a magnetic stripe. A badge layout
with a magnetic stripe code defined must be selected.

Deleting a Card
Select the card you want to delete and click the Delete button.
If you are sure you want to delete the card, click OK in the
confirmation dialog box.

The record continues to appear in the data list although it is
unavailable. New records cannot use its key fields (i.e., name or
card number) until the database is packed (see Chapter 7).

NOTE: An alternative to deleting a card is to make the card status “Inactive.”
By making the card inactive, any future history will have a database of
the person’s name and other relevant information for history reporting.
If the card is deleted, there will be no reportable history on that
holder name.
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The Camera Database

The camera database contains information on CCTV cameras in
the access control system. Selecting Cameras... from the
Database menu opens the Camera Database.

The Camera Database shows the cameras that have been
defined and some basic information on each one, including the
camera’s descriptive name, address, and the title that appears on
a monitor when using this camera. This list is sortable by the
order in which they were entered (None) or alphabetically by
Camera Name (Camera).

When sorted by Camera, a camera can be searched for by
entering the name in the search box and clicking the Search
button (  ).
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Adding or Editing a Camera Record

Click Add... to enter a new camera or Edit... to modify the
currently selected camera. This opens the Camera Detail
window.

Camera
Enter a descriptive name for the camera of up to 20 characters
including letters, numbers, and spaces.

Address
Enter a unique numerical address for the camera from 1 to 999.
If  you enter a duplicate address, an error message appears.
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Title
Enter the text that you want to appear on the screen when
looking at this camera view. The title may contain up to 20
characters.

NOTE: Selected CCTV equipment must be capable of supporting titles to
use the Camera Title database field. Some camera titling may not
support 20 characters.

Click OK to save your changes or Cancel to return to the
database without saving your changes.

Deleting a Camera Record

Select the camera you want to delete and click the Delete
button. If you are sure you want to delete the camera, click OK
when the confirmation dialog box asks you.

The record continues to appear in the data list although it is
unavailable. New records cannot use its key fields (i.e. name or
number) until the database is packed (see Chapter 7).
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The Holidays Database

The holiday database is a set of defined holidays that are
considered when defining timezones. The ability to define
holidays is important if they are treated differently (i.e., only
certain employees have access on these days, a particular input
isn’t shunted, or a door is either open or closed, etc.)  If
“Holiday” is enabled in a timezone assigned to a card, then the
person is allowed access during that holiday. If  “Holiday” is not
included in the timezone, then the card does not have access on
that day. If  a door is Timezone controlled and does not have a
defined “Holiday” time element, then it will remained locked
during the “Holiday”.

Selecting Holidays... from the Database menu opens the Holiday
Data List.

The Holidays data list shows the holidays that have been
defined and the date they are on. This list is sortable by the
order in which they were entered (None) or alphabetically by
holiday name (Holiday).

When sorted by Holiday, a holiday can be searched for by entering
the name in the search box and clicking the Search button (  ).
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Adding or Editing a Holiday

Click Add... to enter a new holiday or Edit... to modify the
currently selected holiday. This opens the Holiday Detail
window.

Type in the name of  the holiday (up to 20 characters) that you
want to add in the text entry space provided. Then use the arrow
keys to browse by month until you see the month that the
holiday is in. Click the day of the holiday within the month.

Click OK to save the holiday or Cancel to return to the
database control window without saving the holiday.

NOTE: Enter only holidays for the current year. If you enter multiple instances
of a holiday, which falls on different days each year, WIN-PAK cannot
tell which is the correct date.

Deleting a Holiday

Select the holiday you want to delete  and click the Delete
button. If  you are sure you want to delete the holiday, click OK
when the confirmation dialog box asks you.

The record continues to appear in the data list although it is
unavailable. New records cannot use its name until the database
is packed (see Chapter 7).
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The Monitors Database

The monitor database is a set of defined monitors that are used
in the CCTV supervision of  a facility. These monitors can be
selected from within the Reader, and Input screens of the Panel
Database to view particular areas when reader and alarm
information is received. They can also be selected manually
from the Camera Control Screen. Selecting Monitors... from the
Database menu opens the Monitor Data List.

The Monitors Data List shows the monitors that have been defined
and their address. This list is sortable by the order in which they
were entered (None) or alphabetically by monitor name (Monitor).

When sorted by Monitor, a monitor can be searched for by
entering the name in the search box and clicking the Search
button (  ).
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Adding or Editing a Monitor

Click Add... to enter a new monitor or Edit... to modify the
currently selected monitor. This opens the Monitor Detail
window.

Type in the name of  the monitor (up to 20 characters) that you
want to add in the text entry space provided. Then use the arrow
keys to enter a monitor address.

Click OK to save the monitor or Cancel to return to the
database control window without saving the monitor.

Deleting a Monitor

Select the monitor you want to delete  and click the Delete
button. If you are sure you want to delete the monitor, click OK
when the confirmation dialog box asks you.

The record continues to appear in the data list although it is
unavailable. New records cannot use its key fields (i.e. name or
number) until the database is packed (see Chapter 7).
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The Operator Database

The Operator Database contains information on all WIN-PAK
operators. Selecting Operator... from the Database menu opens
the Operator Database.

The Operator Database shows the system operators that have
been defined. This list is sortable by the order in which the
records were entered (none) or alphabetically by operator name.

When sorted by Operator, an operator can be searched for by
entering the name in the search box and clicking the Search
button (  ).



Programming Databases 171171171171171

Databases

Adding or Editing a System Operator

Click Add... to enter a new system operator or Edit... to modify
the currently selected system operator. This opens the Operator
Detail window.

Operator
Enter a descriptive operator name consisting of up to 20
characters (letters, numbers, and spaces).
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Password
The Password button opens up a dialog box to enter a password
for the operator you are defining. The password must be entered
by the operator when logging into WIN-PAK.

Enter the Password in the first space provided. The password
can be up to 8 characters of  numbers or letters. When typing
asterisks are shown. The password is case sensitive. Make sure
the operator knows the exact case of his/her password.

Enter the password in the Verify space provided using the
correct case. This ensures that you entered the password
correctly in the first space.

Click OK when finished to save the password or Cancel to exit
this dialog without saving the password.

NOTE: Be sure to change the password. This is critical to the security of your
system. For the greatest security, use a combination of both letters
and numbers; do not use any familiar terms such as your company
name, initials, birth dates, etc. A simple strategy for choosing a
password that is both easy to remember, but hard to decode, is to
pick a simple phrase preceded or followed by one or more numbers.
Enter it without spaces and capitalize each word. Such a password
cannot be easily decoded either by a random number generator or
by dictionary decoder.
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Operator Privileges

Operator privileges define what kind of control an operator has
over different options of the program. The Operator Detail
window contains a list of the different options to which an
operator can be assigned access. Use the scroll bar to view the
list. Symbols before each option show the operator’s privilege
for that option. The privileges and their symbols are shown
below:

NOTE: Backup & Restore, Archive, Purge, and Rebuild privileges can not be
edited from a network client.

Edit Privilege   
An operator with the Edit Privilege for an option has the ability
to add, modify, and delete information.

None Privilege   
An operator with the None Privilege for an option cannot edit or
view the information.

View Privilege   
An operator with the View Privilege for an option can view the
information, but cannot edit it.

Privileges are grouped into categories for ease of  editing. The
categories are operational privileges, database privileges, report
privileges, setup privileges, and main screen privileges.

Operational Privileges

Operational privileges give the operator control over system
maintenance. These options do not have a View privilege.

File
Clicking the File bar from the list toggles the entire set of  File
options between the Edit privilege and the None privilege.
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Backup
Clicking the Backup bar from the list toggles this option
between the Edit privilege and the None privilege. The operator
must have the Edit privilege in order to backup system files.
(See Chapter 7)

Restore
Clicking the Restore bar from the list toggles this option between
the Edit privilege and the None privilege. The operator must have
the Edit privilege in order to restore system files. (See Chapter 7)

Archive
Clicking the Archive bar from the list toggles this option
between the Edit privilege and the None privilege. The operator
must have the Edit privilege in order to archive history files.
(See Chapter 7)

Purge
Clicking the Purge bar from the list toggles this option between
the Edit privilege and the None privilege. The operator must
have the Edit privilege in order to purge archived history files.
(See Chapter 7)

Rebuild
Clicking the Rebuild bar from the list toggles this option
between the Edit privilege and the None privilege. The operator
must have the Edit privilege in order to rebuild, recreate, and
pack indexes of  the databases. (See Chapter 7)

Print Setup
Clicking the Print Setup bar from the list toggles this option
between the Edit privilege and the None privilege. The operator
must have the Edit privilege in order to change printer settings.
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Exit
Clicking the Exit bar from the list toggles this option between
Edit privilege and the None privilege. The operator must have
the Edit privilege in order to correctly exit WIN-PAK.

WARNING: An operator could potentially exit WIN-PAK by exiting Windows or by
turning off the computer. BOTH ACTIONS CAN CORRUPT
COMPUTER DATA – WIN-PAK DATABASES COULD BE AFFECTED!
THESE ACTIONS ARE STRONGLY DISCOURAGED!

Database Privileges

Database privileges determine the operator's access to database
information. Each operator can be assigned Edit, None, or View
privileges to each of  fourteen databases.

An operator with Edit privileges to a database can add, edit, and
delete records in that database. If the operator has been assigned
None, the database is inaccessible. An operator with View
privileges can browse but not edit a database.

An operator can be assigned the same privilege for all databases
at one time by clicking the Database bar or they can be assigned
one at a time by clicking on individual bars.

NOTE: If an operator has View privileges for a database, the button 
appears.

Databases
Clicking the Databases bar from the list toggles the entire set of
database options between the Edit, None, and View privilege.
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Timezones
Clicking the Timezones bar from the list toggles the Timezone
database privilege between Edit, None, and View.

Areas
Clicking the Areas bar from the list toggles the Area database
privilege between Edit, None, and View.

Panels
Clicking the Panels bar from the list toggles the Panel database
privilege between Edit, None, and View.

Schedules
Clicking the Schedules bar from the list toggles the Schedules
database privilege between Edit, None, and View.

Guard Tours
Clicking the Guard Tours bar from the list toggles the Guard
Tours database privilege between Edit, None, and View.

Tracking Areas
Clicking the Tracking Areas bar from the list toggles the Tracking
Areas database privilege between Edit, None, and View.

Access Levels
Clicking the Access Levels bar from the list toggles the Access
Level database privilege between Edit, None, and View.
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Cards
Clicking the Cards bar from the list toggles the Card database
privilege between Edit, None, and View.

Cameras
Clicking the Cameras bar from the list toggles the Camera
database privilege between Edit, None, and View.

Holidays
Clicking the Holidays bar from the list toggles the Holiday
database privilege between Edit, None, and View.

Monitors
Clicking the Monitors bar from the list toggles the Monitor
database privilege between Edit, None, and View.

Operators
Clicking the Operators bar from the list toggles the Operator
database privilege between Edit, None, and View. Selecting the
Edit privilege gives the operator access to operator passwords
and privileges, and with it the whole system. The View privilege
allows the operator to see all operator information except
passwords.

Floor Plans
Clicking the Floor Plans bar from the list toggles the Floor Plan
database privilege between Edit, None, and View.

Command Files
Clicking the Command Files bar from the list toggles the
Command File database privilege between Edit, None, and View.
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Report Privileges

Report privileges define which reports the operator can define
and print. Because viewing and printing disclose the same
information, the operator can either have access to the
information (Edit) or not (None). View is not an option.

Reports
Clicking the Reports bar from the list toggles the entire set of
report options between the Edit and the None privilege.

History Reports
Clicking the History Reports bar from the list toggles between
the Edit privilege and the None privilege for printing reports on
system history.

Database Reports
Clicking the Database Reports bar from the list toggles between
the Edit privilege and the None privilege for printing reports on
WIN-PAK’s databases.

Attendance Report
Clicking the Attendance Report bar from the list toggles
between the Edit privilege and the None privilege for printing
attendance reports.
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Setup Privileges

Setup privileges define which setup parameters the operator can
modify. These are the commands located in the Setup menu.
They can either be edited (Edit) or not (None) – there is no
View privilege. In a network setup, these options can only be
edited on the network server.

Setup
Clicking the Setup bar toggles between the Edit and None
privileges for all items located in the Setup Menu. If all options
are set to None, the Setup Menu is inaccessible to the operator.
These options cannot be edited from a network client.

Options
Clicking the Options bar toggles between the Edit and None
privileges for items located in the Options section of the Setup
Menu. This allows/disallows the operator to choose certain
card, communications, and operator options. See System Setup
for more information.

Note Fields
Clicking the Note Fields bar toggles between the Edit and None
privileges for items located in the Note Fields section of the
Setup Menu. This allows/disallows the operator to redefine the
note field labels.

Serial Ports
Clicking the Serial Ports bar toggles between the Edit and None
privileges for items located in the Serial Ports section of  the
Setup Menu. This allows/disallows the operator to define serial
port usage and hardware.
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Main Screen Privileges

The last twelve bars in the privileges list control access to the
eight main screens that make up the control center of  WIN-PAK.
These twelve bars must be set individually. If  the operator is not
allowed access to any of the twelve, then the screens do not
appear when the operator logs in. In other cases the tab may be
inaccessible. Of  these options, the Guard Tour View is the only
one that allows the View privilege.

Alarm Monitor
Clicking the Alarm Monitor bar toggles between the Edit and
None privilege. This allows/disallows the operator access to the
Alarm Monitor Screen.

Alarm Info
Clicking the Alarm Info bar toggles between the Edit and None
privilege. This allows/disallows the operator access to the
Alarm Info Screen.

Panel Cntl
Clicking the Panel Cntl bar toggles between the Edit and None
privilege. This allows/disallows the operator access to the Panel
Control Screen.

Muster Report
Clicking the Muster Report bar toggles between the Edit and
None privilege. This allows/disallows the operator access to the
Muster Report Screen.

Camera Cntl
Clicking the Camera Cntl bar toggles between the Edit and
None privilege. This allows/disallows the operator access to the
Camera Control Screen after Area is setup and Monitor and
Camera Databases are programmed.
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Card Lookup
Clicking the Card Lookup bar toggles between the Edit and
None privilege. This allows/disallows the operator access to the
Card Lookup Screen.

Mail
Clicking the Mail bar toggles between the Edit and None
privilege. This allows/disallows the operator access to the Mail
Screen in a network system.

Muster Card Deletion
Clicking the Muster Card Deletion bar toggles between the Edit
and None privilege. This allows/disallows the operator the
ability to delete muster cards from the Muster Report Screen.

Non-Muster Card Deletion
Clicking the Non-Muster Card Deletion bar toggles between the
Edit and None privilege. This allows/disallows the operator the
ability to delete non-muster cards from the Muster Report Screen.

Display Card Numbers
Clicking the Display Card Numbers bar toggles between the
Edit and None privilege. The Edit privilege allows the operator
to see card numbers when displayed on the screens that show
them. The None privilege shows “*****” instead of card
numbers on screens that would otherwise show them.

NOTE: Although card numbers may be hidden in screens that normally show
them, they are still visible in Card Database reports (if access to
reports is enabled), the Locate Function (if access to Card Database
is enabled), and Attendance Reports.



182182182182182 WIN-PAK 1.17 User Manual

Display PIN Numbers
Clicking the Display PIN Numbers bar toggles between the Edit
and None privilege. The Edit privilege allows the operator to
see PIN numbers when displayed on the screens that show
them. The None privilege shows “*****” instead of PIN
numbers on screens that would otherwise show them.

NOTE: Although PIN numbers may be hidden in screens that show them,
they are still visible in Card Database reports ONLY if access to
reports is enabled.

Guard Tour View
Clicking the Guard Tour View bar toggles between the Edit, View
and None privilege. The Edit privilege allows the operator to
initiate and cancel guard tours. The View privilege only allows the
operator to view a tours progression. The None privilege prohibits
the operator from viewing or controlling guard tours.

Deleting an Operator

Select the operator you want to delete, and then click the
Delete button. If you are sure you want to delete the operator,
click OK in the confirmation dialog box.

NOTE: If you delete an operator, references to that operator’s activities in the
system are removed and do not appear in history reports. Instead,
change the operator’s password and limit access to File and Exit
only. This prohibits the operator from logging on while maintaining
the record of past activities.

The record continues to appear in the data list although it is
unavailable. New records cannot  use its name until the
database is packed (see Chapter 7).
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The Floor Plan Database

The floor plan database maintains graphics that can be
associated with particular input points. These graphics are
created in other applications and may be a diagram of a floor
plan, a photo, or any other  graphic that can be saved as a
Windows Bitmap file (.BMP). This is an alternative way of
monitoring alarm points in the Alarm Monitor Screen. Operators
can view points by the facility area they are located in.

NOTE: Photos of areas of the building can be used instead of
floor plans.

Select Floor Plans... from the Database menu to open the Floor
Plan Database.

The Floor Plan Database displays a list of the floor plans that
have been defined and the name and location of the Floor plan
graphic. This list is sortable by the order in which they were
entered (None) or alphabetically by Floor Plan name.

When sorted by Floor Plan, search for a floor plan by entering its
name in the search box and clicking the Search button (  ).
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Adding or Editing a Floor Plan Record

Click Add... to enter a new floor plan or Edit... to modify the
currently selected floor plan. This opens the Floor Plan Detail
window.

The Floor Plan Detail window is used to select a floor plan
graphic, name it, and assign a “hot spot” if needed.

Floor Plan
Type in a descriptive name for the floor plan. The name can be
up to 20 characters including spaces.
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Selecting a Floor Plan Graphic

File Name
Type in the name of  the graphic that you want to use, including
the path, in the space provided or use the ellipse button ... to
open a file-finding dialog box.

The Open dialog box allows you to select the floor plan file that
you want to associate with the name you defined.

List Files of Type
The floor plan graphic must be in a Windows bitmap format.
This drop-down list allows you to select between displaying only
Windows bitmaps (BMP) or listing all files. Listing Bitmap files
only is preferred because it does not list files that cannot be used.

Drives
Select the correct drive of the graphic you want to open.

Directories
Use the directory tree under Directories to navigate to the
directory of the graphic that you want to open. Double-clicking
on a folder opens it to reveal its contents.
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File Name
Once you have selected the correct drive and directory, the list
under File Name should contain the name of the file that you
want to open. Scroll the list, if  necessary, until you find the
correct file, then select it.

Click OK after you have selected the file that you want to open
or click Cancel to return to the Floor Plan Detail without
opening a graphic.

Creating a Hot Spot
The Floor Plan Detail window contains a dialog box called Hot
Spot Detail. A Hot Spot is a defined area on a floor plan that can
provide access to more detailed information in the form of  an
alarm input status, a link to another floor plan, or both. The
following sections explain how to define hot spots for alarm
points and floor plans.

Defining Alarm Point Hot Spots
An alarm point hot spot is a defined place on a floor plan that
displays the status of  one or more alarm input points. When a
floor plan with this type of hot spot is viewed in the Floor Plan
View of  the Alarm Monitor, it contains an alarm icon where the
spot was defined. This icon tells the status of  the alarm by its
color and blinks until the alarm is acknowledged. The following
steps show how to define an alarm point hot spot.

NOTE: The size of the hot spot adjusts automatically to the appropriate size,
depending on how many alarm input points are defined.
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1. With the floor plan open, click on the floor plan where you want
the upper-left corner of the hot spot to be and drag with the
mouse to where you want the lower-right corner of the hot spot
to be. This creates a white box around the spot.

2. The Hot Spot Detail Window becomes active. Type in a
message for the hot spot in the space provided (up to 50
characters). This message appears in the status bar when the
cursor is over the spot in the Floorplan View of  the Alarm
Monitor.

3. Click Alarm Point.... This opens the Monitor Points dialog box.

4. Select the desired loop from the Loop drop-down list or leave
All to select from more than one loop.

5. Select the desired panel from the Panel drop-down list or you
can select any panel defined in the Panel database that is located
on the selected loop.

NOTE: To see the status of an alarm point through multiple layers of linked
floor plans, define the alarm point in each layer.

6. Select the desired points from the Available Input Points list.
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PLANMAIN.BMP

PLANA.BMP

PLANA1.BMP PLANB1.BMP PLANB2.BMP

PLANB.BMP

Link to PLANA1.BMP
Alarms Defined:

PT1

Alarms Defined:
PT1

Alarms Defined:
PT2

Alarms Defined:
PT3 & PT4

Link to PLANB2.BMP
Alarms Defined:

PT3 & PT4

Link to PLANB1.BMP
Alarms Defined:

PT2

Link to PLANB.BMP
Alarms Defined:

PT2, PT3, PT4

Link to PLANA.BMP
Alarms Defined:

PT1

NOTE:
If you right click on the
floor plan view within a
hotspot, (excluding the
first layer) you will
receive a list of the floor
plans that you “traveled
through” to get to it as
shown below. Up to five
can be listed.
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They are added to the Selected Input Points list and to your hot
spot. When these alarms are triggered the alarm input icons
appear in the Floor Plan View of  the Alarm Monitor , based on
the Acknowledge Alarm Threshold set in the Communications
section of  the Setup options.

Clicking the points in the Selected Input Points list removes
them, and puts them back in the Available Input Points list.

7. Click OK to exit and save your input point hot spot
information. Then click OK from the Floor Plan Detail to save
the change to your floor plan.

Deleting a Hot Spot

To delete a hot spot within a floor plan, select the hot spot with
the mouse, and click Delete in the Hot Spot Detail dialog box.
After deleting or removing a hot spot, packing the Floor Plan
Database is required.

Floor Plan Linked Hot Spots

A floor plan linked hot spot is an area on a floor plan containing
a link to another floor plan. A floor plan link appears as a
dashed box in the Floor Plan View, unless it is both an alarm
point AND a floor plan hot spot; then it appears as an alarm
icon.

To Define a Floor Plan Hot Spot
1. Open the floor plan and place the cursor where you want the

upper-left corner of the hot spot to be, and then click and drag
to the lower right corner. This creates a white box around the
spot.
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2. The Hot Spot Detail Window becomes active. Type in a
message for the hot spot in the space provided (up to 50
characters). This message appears in the status bar when the
cursor is over the spot in the Floor Plan View of  the Alarm
Monitor.

3. Click Floor Plan Link.... This opens the List dialog box
containing all defined floor plans.

4. Select the floor plan that you want to link to the hot spot.

NOTE: In addition to floor plan diagrams, photographic images can be used.
These can be scanned and saved as bitmap files or taken with a
digital camera.

5. Click OK to save the floor plan link, and OK from the Floor
Plan Detail to save the floor plan.
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Creating Floor Plans

Floor plans give the operator a visual map or cue associated with an
alarm or reader area. There is a wide variety of  software packages
available to help you create floor plan images ranging from simple,
inexpensive paint programs, such as Windows Paint, to more
elaborate painting and drawing programs. Any program that can
save to an uncompressed Windows bitmap file (.BMP) will work,
but you may find that some programs are easier to use or provide
more flexibility. Following are some tips to help you create useful
floor plans.

Floor Plan Size
Floor plans can be created larger than the Floor Plan View of the
Alarm Monitor. Scroll bars allow the operator to see areas of  the
floor plan that aren’t immediately visible. While this may be
suitable for an entire facility floor plan, it may be cumbersome
when the operator wants a quick view of  an alarm input area. In
this is case, it is important to design the floor plan to fit on the
floor plan viewing area.

Monitors vary in size and resolution. Special drivers installed in
your computer can also give you special flexibility by allowing
you to change resolution and color capabilities. Design your floor
plan with the hardware and monitor settings that are used for
running WIN-PAK. What you see on the screen when designing
the graphic will then be what you get in WIN-PAK.

Deleting a Floor Plan
Select the floor plan to be deleted and click the Delete button. If
you are sure you want to delete the floor plan, click OK in the
confirmation dialog box.

The record continues to appear in the data list although it is
unavailable. New records cannot use its name until the database is
packed (see Chapter 7).
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The Command File Database

Command Files are text files used to control system hardware.
They may be used to instruct one or more panels to take a
particular action, or they can be used to send data to a camera
control or other (Unknown) loop. Command files can either be
automatically sent to a panel (or other loop) upon receiving
information or upon acknowledgment, as defined in the System
Setup option. Command files can also be sent manually from the
Panel Control Screen (or Live Camera View).

WIN-PAK checks command file entries for correct syntax when
an area is defined as a Loop. Refer to your panel’s programming
manual for commands and their syntax. Areas defined as Camera
or Unknown won’t be checked for syntax.

Selecting Command File... from the Database menu opens the
Command File Database.

The Command File Data List shows the Command Files that
have been defined and the area (loop) that they are defined for.

When sorted by Command File, you can search for a file by entering
its name in the search box and clicking the Search button (  ).
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Adding or Editing a Command File

Click Add... to enter a new command file or Edit... to modify
the currently selected command file. This brings up the
Command File Detail window.

Command File
Enter a name for the command file. It can consist of up to 20
characters including letters, numbers, and spaces.

Area
From the Area drop down list, select the area in which the
command file will be used. This list contains all of the areas
defined in the Area database.
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Commands
Type in the commands you want to add to the command file.
When your Area defines a panel loop, be sure to use the syntax
required by your panel. If  your area defines a camera loop, use the
appropriate syntax for that manufacturer. Commands defining an
Unknown area type are sent as a text file regardless of syntax.
Commands for an Unknown area that would normally have an
<Enter> or <CR> must instead contain <137> or <ØxØxd>.
Include the less than (<)and greater than (>) symbols when you
type in either of  these statements. After entering one command
line, press the down arrow to add more. Make sure to press the
down arrow after the last command, so that none of the
commands appear in yellow. This ensures that all of  the
commands are saved when you click OK.

When you have finished entering commands, click OK to save
your command file or Cancel to return to the Command File
Database screen without saving.

Deleting a Command File

With the mouse, select the command file to be deleted and click
the Delete button. If you are sure you want to delete the
command file, click OK in the confirmation dialog box.

The record continues to appear in the data list although it is
unavailable. New records cannot use its name until the database is
packed (see Chapter 7).
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Overview

Badging designs are created as templates that can be merged
with card user data to produce badges. The Badge Layout Utility
is used for building these templates. The operator can then save
the badge design and assign it to persons in the Card Database.
This chapter shows how to create badge designs. Assigning these
badge designs to card holders is covered in the Card Database
section of Chapter 3.

Accessing & Exiting the Badge Layout Utility
To access the Badge Layout Utility select Backdrop... from the
Database menu. This launches the utility for customizing badge
backdrop designs.

NOTE: The Badge Layout Utility can be accessed independently from
WIN-PAK by double-clicking its icon in the Northern Computers'
Access Control Group in Windows.

To exit the Badge Layout Utility of  WIN-PAK, select Exit from
the File Menu.
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Creating a New Badge

To create a new badge select New Badge... from the File menu
or click on the New Badge button (  ). When the Create New
Badge dialog box opens specify the name and printable area of
the new badge. Fill in the fields outlined below.

Badge Name
Enter a name for the badge design. You can use spaces and
special characters. The program automatically replaces lower
case letters with capital letters. You can use up to 25 characters
or until the field is full.

Printable Area Size
Enter in the width and height of the printable area of the badge
in millimeters. The default size for a new badge is 80mm W x
49mm H, which works for most badge printers. To create a
vertical badge change the values to 49mm W x 80mm H.

NOTE: The size of a badge’s printable area can be changed after the new
badge is created by selecting Badge Layout... from the File Menu.

Click OK to accept the new badge parameters or Cancel to close
the dialog box without creating a badge.
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Opening an Existing Badge
Select Open... from the File menu or click the Open button ( )
on the tool bar to display a list of  previously created badges.
Select a badge from the list and click OK to open it, or click
Cancel to leave this option without opening a badge.

NOTE: To see measurements in inches, edit the BADGER.INI file in the
WINDOWS subdirectory. Add the following line under [Preferences]:
Inches=1

To Close a Badge
Select Close from the File menu. The currently selected badge
design closes. To close all open badge designs, select Close All
from the Window menu. Both methods prompt you to save
backdrops that have not been saved.
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To Save a Badge
Select Save from the File menu or click the Save button (  )
on the tool bar. All changes made to the currently selected badge
design are saved. It is a good idea to save your work often. It is
necessary to save your changes before printing the badge. A
badge that has not been saved after changes have been made is
indicated by an asterisk in the title as shown below:

To Rename a Badge
Select Rename from the File menu. The Rename/Copy Badge
dialog box opens. Type in a new name. Click OK to keep the
change or Cancel to keep the original name.

To Copy a Badge
Select Copy from the File menu.  The Rename/Copy Badge
dialog box opens. Type in the new badge name. Click OK to
create the new badge or Cancel without creating it. Copying a
badge design allows you to create several badges with the same
basic layout and perhaps one distinguishing feature, such as the
background color.

NOTE: A badge will not copy until it is saved.
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To Delete a Badge
Select Delete from the File menu. This permanently deletes the
currently selected badge design.

To Import a Graphic
All graphics used in designing a badge must be located in the
DATA directory specified during WIN-PAK setup. Select Import
Graphic... from the File menu to copy a graphic file from any
directory on your hard drive or a floppy disk to the graphic
directory.

1. From the Files of  Type drop-down list, select the correct type of
file (.bmp, .jpg, .tga, or .tif).

2. From the Drives drop-down list, select the drive where your files
is located. A and B are usually floppy disk drives.

3. In the Folders window, click folder containing the file.

4. From the File Name list, select your file and click OK to import
the graphic or Cancel to exit this box without importing.
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Editing the Badge Background

One basic feature of the Badge Layout Utility is the ability to
change the background of the badge. The background is the
entire printable area on the card in which other elements are
placed. This area is defined by the gray box that appears on a
new badge.

There are three ways to provide a background for a badge: select
a single color, capture a live image using your computer
equipped with a video camera and capture board, or import an
existing bitmap image. These three methods are explained below.

Creating a Single Color Background
The simplest background is one that consists of  a single color.
Badge colors can be used to represent different clearance levels
as they are easy to distinguish from a distance.

NOTE: Colors on the screen and colors that are printed don’t always match
exactly because of different monitor & printer settings. Lighter color
backgrounds print better. White is typically the best background
color.
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To change the color of  the background, click anywhere on it
with the RIGHT mouse button. A menu opens displaying
editing options. Select Background Color.... Selecting this menu
item opens the Basic Colors palette. Select the color you like
and click OK. Or create a custom color for your badge (See
Appendix F).

NOTE: You must erase the captured background from the badge if you want
to change it to a solid color.
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Capturing a Background

Another way to create a background is with your computer
equipped with a video camera and video capture board. This
involves setting up something that you want to appear as your
background and capturing it on video. The instructions below
assume that your video equipment has been installed and tested.

To capture a new background, right-click anywhere on the
existing background. A menu opens, displaying editing options.
Select Backdrop and then select Capture from the submenu. If
you have a board installed, a window appears (as shown in
illustration above) with live action from your camera. Use this
image to properly frame your background.
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The dialog box used for capturing the background changes,
depending on the video capture board selected during WIN-
PAK setup. Options that may differ for each board are covered
in the Video Capture Boards section that follows.

Freeze/Unfreeze
The Freeze/Unfreeze button toggles between “freezing” and
“unfreezing” the viewed image. When the desired image is on
screen, click Freeze to keep it on-screen. Click Unfreeze to
switch back to the live camera view.

Video Capture Boards

The options available for capturing a background depends on
the system’s video capture card. Following is an explanation of
the options available for different hardware.

Brightness
The Brightness slider lightens or darkens the entire tonal range
of the background image.

Contrast
The Contrast slider expands or constricts the entire tonal range
of the background image. The difference in highlights and
shadows can be greatly increased or decreased.

Saturation
The Saturation slider controls the vibrancy, or amount of  color,
in the background image.
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Hue
The Hue slider controls the value of color in the background
image. Adjusting this can correct images that seem to have
incorrect color.

Compression
The captured image is saved to a JPEG file which uses
compression technology to decrease the size of  the file. If
desired, use the arrow keys to adjust the compression of the saved
image. The lower the number in this box, the greater the
compression. However, images loose some quality in this process,
so avoid over-compressing. A setting of  100 applies the least
amount of compression and provides the best quality image. A
setting of 30 applies the most compression, but provides a lower
quality image.

NOTE: The lower the compression the better. An image compressed at 100 is
approximately 80k. An image compressed at 30 is approximately 8k.

Save Settings
The Save button saves the position of the sliders so that the
same settings can be used for all of  your badges.
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Integral Technologies FlashPoint

Selecting Capture from the Backdrop submenu opens a dialog
box with an Advanced button. Clicking Advanced expands the
window.

You can adjust the slides at the right of  the backdrop to enhance
its quality. These controls allow different settings for previewing
the video image and capturing it. The image seen in the Preview
mode can be brightened electronically. When the flash is tripped,
the amount of  light entering the camera’s iris is reduced
compared to the preview, allowing the flash to provide the light
saturating the subject, without over exposing the picture. (It may
be necessary to adjust the Flash point settings. See Appendix B.)

Preview Brightness
The Preview Brightness slider lightens or darkens the entire
tonal range of the preview image.
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Preview Contrast
The Preview Contrast slider expands or constricts the entire
tonal range of the preview image. The difference in highlights
and shadows can be greatly increased or decreased.

Capture Brightness
The Capture Brightness slider lightens or darkens the entire
tonal range of the image when the image is captured.

Capture Contrast
The Capture Contrast slider expands or constricts the entire
tonal range of the image  when the image is captured. The
difference in highlights and shadows can be greatly increased or
decreased.

Saturation
The Saturation slider controls the vibrancy, or amount of  color,
in the background image.

Hue
The Hue slider controls the value of color in the background
image. Adjusting this can correct photos that seem to have
incorrect color.
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Sharpen
The Sharpen slider sharpens blurry images by increasing the
contrast of  adjacent pixels. The highest value is 7.

Compression
The captured image is saved as a JPEG file which uses a
compression technology to decrease the size of  the file. If  desired,
use the arrow keys to adjust the compression of the saved image.
The lower the number in this box, the greater the  compression.
However, images lose some quality in this process, so avoid over-
compressing. A setting of  100 applies the least amount of
compression and provides the best quality image. A setting of 30
applies the most compression, but provides a lower quality image.

NOTE: The lower the compression the better. An image compressed at 100 is
approximately 80k. An image compressed at 30 is approximately 8k.

Save Settings
The Save button saves the position of the sliders so that you
can use the same settings for all of  your badges.
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TWAIN Setup

If  your system is equipped with a TWAIN Compatible Board, you
have the ability to capture background images from other devices
such as scanners. Selecting Capture from the Backdrop submenu
opens a dialog box with an Acquire... and Source... button.

The FIRST time you capture an image, click the Source...
button. This shows the TWAIN drivers present on your
computer. Choose one and click Select. The TWAIN interface
will use this driver until you select a different one.

To capture an image, click the Acquire button. This opens a
device dialog box based upon the previously selected source.
See your device manual for information on how to use its
TWAIN interface.
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FlashPoint TWAIN Setup

1. Select the TWAIN interface during installation of  WIN-PAK.
The settings for a TWAIN interface are similar to those
described in the previous section, except there are no separate
capture or preview brightness/contrast settings.

2. Use the sample settings shown above as a starting point for your
TWAIN setup. Test the settings and then adjust them as
necessary for your system.

3. If a frame capture camera is used or if flash is not being utilized,
the width and height settings should be set to maximum settings.
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Loading a Graphic Background

A third method of creating a background is to load an existing
graphic file. Creating this file takes more work than the other
two methods but allows an infinite number of  possibilities. Here
are just a few ways to obtain a file:

• Use a paint-type software program to create a background
file from scratch

• Use a desktop scanner to scan a logo or photograph and save
it to a file

When Creating Your Background File, Remember...
1. The file must be saved as a Windows Bitmap (BMP), JPEG

(JPG), Targa (TGA) or TIFF (TIF) file and imported to the
directory you specified as your graphic subdirectory during
WIN-PAK setup. The file should be close to 300ppi (pixels per
inch).

2. Keep in mind the orientation and size of  the badge. Try to make
the image the same size and shape as the printable area of your
badge because WIN-PAK will stretch the background image to
fill the printable area – check Badge Layout in the File menu to
see the printable area size.

3. Keep in mind where photos, barcodes, and text will be placed
on the badge so important parts of your background are not
obscured.

Loading the File
To load the graphic file after it has been imported into your
WIN-PAK data directory, right-click anywhere on the current
background.
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A menu opens, displaying editing options. Select Backdrop and
then select Load... from the submenu. The Open Image File dialog
box appears.

Choose the type of graphic file you wish to import from the File
Types list. Your choices are:

*.BMP, *.JPG, *.TGA, *.TIF

Once you select the type of file you are importing, select the file
you want to import and click OK. The graphic is loaded and
stretched to fit your badge size.

NOTE: Infrequently, you may find a JPEG file that cannot be imported into
WIN-PAK. Try opening the file in a graphics program and saving it as
a *.BMP file.
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Changing the Background Orientation
After you have either captured or loaded an existing backdrop,
you can rotate it within your badge. Click anywhere on the
current background with the RIGHT mouse button. A menu will
pop up displaying editing options. Select Orientation. This will
open up a submenu with rotation options expressed in degrees.

Your options are:

0° Placing your image upright.
90° Rotating your image 90° clockwise.
180° Placing your image upside-down.
270° Rotating your image 90° counterclockwise.

Erasing the Background
To remove the loaded graphic as a background, click anywhere
on it with the RIGHT mouse button. A menu will pop up
displaying editing options. Select Backdrop. A submenu will
appear. Select Erase to remove the background.
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Badge Tools

Object Menu

Objects or elements (from the Object menu) can be added to
badges to conform to specific needs. The badge holder’s photo
can be placed on the badge. The badge can also contain his
name, card number, and other pertinent information. A barcode
can be added to input information into computer systems
ranging from access control and payroll to resource checkout.
Bitmaps such as logos can be added.

Once added, elements can be manipulated in a number of  ways.
They can be moved, rotated and resized. Background, foreground
and outline colors can be specified. In addition, unwanted
elements can be removed.

Adding Elements
The six elements that can be placed on a badge (text, bitmap,
photo, barcode, shape, and signature) are accessible in three
ways. Either select the element from the Object menu, click the
button on the toolbar that corresponds to the element that you
want to add, or click the RIGHT mouse button on any open
area of the badge and select the element you want to add from
the menu. All methods will change the cursor (when over the
badge) to the styles shown here:

Text
Bitmap
Photo
Barcode
Shape
Signature
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Click the badge where you want the upper left-hand corner of
the element to appear. All elements can be moved and resized,
so don’t be concerned if it doesn’t appear in the right place. The
instructions for moving and resizing appear below.

Resizing Elements
One of the ways to modify a badge element is to resize it. All
elements are resized by “stretching” its edges. First click with
the pointing cursor on the element to select it  for modification.
If it is difficult to select the element because it is obscured by
other elements, use the TAB key to cycle through the elements
until the one that you want to resize is selected. When over an
edge or corner of a selected object, the cursor changes to a
double-pointed arrow.

Click and drag an edge or corner until the sizing box is the size
and shape that you want the element to be.

Moving Elements
All elements on the badge can be moved. First click on the
element to select it. If it is difficult to select the element because it
is obscured by other elements, use the TAB key to cycle through
the elements until the one that you want to move is selected.
When the cursor is within the edges of a selected element and the
left mouse button is clicked, it changes to the move tool (four-
directional arrow).
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Then just click and drag the element to where you want it. The
dotted outline shows the new placement.

Badge elements can be modified in many other ways by
accessing the element’s menu. This is done by selecting the
element and clicking the RIGHT mouse button.

Layering Elements
Elements on the badge are layered as they are placed. This is only
be noticeable when elements overlap each other. To change the
layering order select Layering... from the Object menu or by click
the layering button (  ) from the tool bar.

Objects on the badge are listed in the order that they are
layered, from top to bottom. Select the object to be moved from
the list shown. Click Move Up to move the object one item
closer to the front. Click Move Down to move the object one
item closer to the back. Click OK when finished.
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Grids

Grids are evenly spaced points to assist in sizing and aligning
elements. The grid can be used simply as a visual help in placing
elements, or you can have items “snap” to the grid when moved.

Setting up a Grid
Select Grid Settings... from the Grid menu and modify the grid
as shown.

Spacing
Use the edit fields in this section to define how far apart the grid
points are. The X Axis field is the distance between points
horizontally across the badge. The Y Axis field is the distance
between points vertically down the badge. Both distances are
measured in millimeters.

NOTE: To see measurements in inches, edit the BADGER.INI file in the
WINDOWS subdirectory. Add the following line under [Preferences]:
Inches=1
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Snapping to the Grid
Selecting Snap to Grid from the Grid menu toggles on and off
the option of having items snap to the grid when moved on the
badge. For example, when an element is moved close to a grid
mark, it will be pulled to it like a magnet. A check mark identifies
this option as enabled when you open the Grid menu.

Showing the Grid
Selecting Show Grid from the Grid menu or clicking the Show
Grid button (  ) on the toolbar toggles on and off  the option
of  viewing the grid on the badge. (See Grid Setup... above). A
check mark identifies this option as enabled when you open the
Grid menu.

Window Menu

The Window menu is a standard menu for most Windows
applications. It allows you to organize open and minimized
badge windows in a variety of  ways. This menu is useful when
working on more than one badge a time.

Below is an explanation of the Window menu items:

Tile
The Tile menu item arranges all open badges so that they can all
be seen. It is also handy for enlarging one open badge to its
maximum size.

Cascade
The Cascade menu item arranges the badges in a stacked
position with the title bars showing.
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Arrange Icons
The Arrange Icons menu item arranges all minimized badge
windows along the bottom left corner of  the main window.

Close All
The Close All menu item closes all open badges. A prompt to
save the badge will appear for each badge that has been modified
but not saved. Click Yes to save the changes or No to ignore the
changes.

List of Open Badges
The List of  Open Badges menu also lists all open badges. The
currently selected badge has a check mark next to it. Clicking on
a badge name will make it the selected badge and bring it to the
front.

NOTE: To display more than one layout at a time, your computer color pallet
must be set to a value greater than 256 colors.
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Text Control

Adding Text

Adding text to a badge is as easy as clicking on the badge with
the text tool. The text tool can be accessed in a number ways:

• Select Insert Text from the Object menu,

• Click the text button (  ) on the toolbar,

• Click anywhere on an empty part of the badge with the
RIGHT mouse button and select Text.

After the cursor has changed to the text tool, click on the badge
where you want the upper left-hand corner of the text box to be.
The text box can be resized and moved as described earlier and
edited as described below.
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Editing Text Contents

Click on the text box to make sure that it is selected. Then click
the RIGHT mouse button anywhere on the text box to open up
its option menu and select Text....

This menu item opens a dialog box for defining what text is
displayed. You can enter in the Text edit field exactly what you
want. Press Control and Enter together to start a new line.

NOTE: The message <text> identifies an item as a text box. It should be
deleted or “written over” when defining your text or it will be
displayed in your text box and printed on your badge.

You can also include information specific to the badge holder.
To do this, place the cursor in the Text edit field where you want
this information to appear. Then find which field you want to
use from the list on the right. Double-click the information field
and it will appear in the text edit field. Now when you assign a
badge to an individual, it will automatically fill in the
appropriate data for that person. Click OK when finished.
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Changing the Font

This menu item allows you to change the font, style, and size of
the text. Options are reflected in the Sample box.

NOTE: If a barcode font or a True Type font was installed in Windows, it will
appear in the Font list and be available for use.

Font
Select a Font type from the list. The fonts included in this list
depend upon the fonts installed in Windows. See your Windows
manual for information on installing fonts.

Font Style
Select a  style for the appearance of the font you are using:
Regular, Italic, Bold, or Bold Italic.
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Size
Select a size (in points) for the font. The size of the capital
letters is approximately:

72 point = 1.0 inch
36 point = 0.5 inch
18 point = 0.25 inch
9 point = 0.125 inch

You can also resize text by sizing the text box and the “Size Font
to Box” option below.

Effects
It is also possible to apply simple effects to your text. Click the
Strikeout box to strike through your text. Click the Underline
box to add an underline to your text.

Color
It is possible to change the color of your text from this menu
from the Color drop-down list. However, you have more
flexibility in choosing text color from the “Foreground Color”
menu item discussed below.

Resizing Text
Click on the text to select it, then click anywhere on the text with
the right mouse button to open the options menu. Select Size
Font to Box. Enabling this option changes the text size to fit the
text box when resized. The text will grow or shrink proportionally
when the box is resized. This may not be desirable in fields where
the data is a variable such as a name.
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Editing The Text Foreground Color

Click on the text to select it, then click anywhere on the text
with the right mouse button to open the options menu. Select
Foreground Color. Selecting this menu item brings up a palette
of  Basic Colors for changing the text color.

Choose a color, select it with the mouse, and click OK. If a
custom color is needed for the text, it can be created (See
Appendix F).

Editing the Text Background Color

Click on the text to select it, then click anywhere on the text with
the right mouse button to open the options menu. Select
Background Color. Selecting this menu item brings up a palette
of Basic Colors for changing the text background color (above).
Choose a color, select it with the mouse, and click OK. If a
custom color is needed for the text, it can be created. See
Appendix F.
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Creating Text with a Transparent Background

The background color of text can be set to transparent. Click on
the text to select it, then click anywhere on the text with the
right mouse button to open the options menu. Select
Transparent so that the elements behind it show through.

Editing Text Horizontal Justification

To adjust text horizontal justification, click on the text to select it,
then click anywhere on the text with the right mouse button to
open the options menu. Select Justification.

Selecting this menu item opens a submenu allowing the operator
to select the horizontal positioning of the text in the text
background. The text can be justified to the Left, Center, or
Right.
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Editing Text Vertical Alignment
To adjust text vertical alignment, click on the text to select it,
then click anywhere on the text with the right mouse button to
open the options menu. Select Alignment.

Selecting this menu item opens a submenu allowing the operator
to select the vertical positioning of the text in the text
background. You can have it align to the Top, Middle, or
Bottom of the text box.
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Changing Text Orientation

To change the orientation of  text, click on the text to select it,
then click anywhere on the text with the right mouse button to
open the options menu. Select Orientation and choose the angle
for the text to appear on the badge.

Your options are:

0° Places your text upright.
90° Rotates your text 90° clockwise.
180° Places your text upside-down.
270° Rotates your text 90° counterclockwise.

Deleting a Text Block

To delete a text block, click on the text to select it, then click
anywhere on the text with the right mouse button to open the
options menu. Click Delete. This menu item removes the text
from the badge.
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Photo Placeholder Control

The Badge Layout Utility of  WIN-PAK places a photo
placeholder on the badge, not an actual photo. Photos are
imported into the badge when a photo is captured and the badge
design is assigned to the card holder in the card database.

Adding a Photo Placeholder

Adding a photo placeholder to a badge is as easy as clicking on
the badge with the photo tool. The cursor can be changed to the
photo tool in any of the following ways:

1. Select Insert Photo from the Object menu.

2. Click the photo button (  ) on the toolbar, or

click anywhere on an empty part of the badge with the right
mouse button and select Photo.

After the cursor has changed to the photo tool, click on the
badge where you want the upper left-hand corner of the photo
to be. The place holder can be moved, resized, or edited as
described below.

Editing a Photo Placeholder

Clicking the right mouse button anywhere on a photo
placeholder opens up its option menu. The menu items are
explained below.
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Primary Photo
Enabling the Primary Photo option assigns the placeholder to
the photo designated as the “primary” photo for the badge
holder in WIN-PAK. This is the only photo that is displayed in
the card lookup, pop-up, and card databases.

Secondary Photo
Enabling the Secondary Photo option assigns the placeholder to
the photo designated as the “secondary” photo for the badge holder
in WIN-PAK. The only way to view the secondary photo is in a
badge layout view.

Keep Aspect Ratio
Enabling the Keep Aspect Ratio option keeps the photo in
proportion as you are resizing so that it isn’t irregularly shaped.

Orientation
The Orientation function allows you to rotate your photo.

Your options are:

0° Places your photo upright.
90° Rotates your photo 90° clockwise.
180° Places your photo upside-down.
270° Rotates your photo 90° counterclockwise.
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Deleting a Photo Placeholder

To delete a photo placeholder, click on it to select it, then click
anywhere on the photo placeholder with the right mouse button
to open the options menu. Click Delete. This menu item
removes the photo placeholder from the badge.

Graphic Control

WIN-PAK allows you to place graphic images on the badge such
as a logo or symbol. Simply create or scan in your image and
save it as a Windows bitmap (*.BMP), JPEG (*.JPG), Targa
(*.TGA), or TIFF (*.TIF). Then use the “Import a Graphic...”
option to place the graphic in the correct WIN-PAK
subdirectory.

Adding a Graphic Image

Adding a graphic image to a badge is as easy as clicking on the
badge with the graphic image tool. The cursor can be changed to
the graphic image tool in any of the following ways:

1. Select Insert Bitmap from the Object menu.

2. Click the graphic image button (  ) on the toolbar, or click
anywhere on an empty part of the badge with the right mouse
button and select Bitmap.
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After the cursor has changed to the graphic image tool, click on
the badge where you want the upper left-hand corner of the
graphic image to be. This opens a dialog box that allows you to
select a graphic image for your backdrop from your graphic
subdirectory.

Choose what type of graphic file you wish to import as your
backdrop from the File Types list. Your choices are:

*.BMPJ, *.JPG, *.TGA, *.TIF

Once you select what type of file you are opening, you can then
view those files in the file list. When you see the file that you want
to use, select it and click OK.
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Editing a Graphic Image

Clicking the right mouse button anywhere on a placed bitmap
element opens up its option menu. The menu items are explained
below.

Keep Aspect Ratio
Enabling the Keep Aspect Ration option keeps the graphic in
proportion as you are resizing so that it isn’t irregularly shaped.

Orientation
Orientation allows you to rotate your graphic.

Your options are:

0° Placing  your graphic upright.
90° Rotating your graphic 90° clockwise.
180° Placing your graphic upside-down.
270° Rotating your graphic 90° counterclockwise.
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Deleting a Graphic
To delete a graphic, click on it to select it, then click anywhere
on the graphic with the right mouse button to open the options
menu. Click Delete. This menu item removes the graphic from
the badge.

Barcode Control

WIN-PAK creates barcodes for badges in a number of  formats
that can be used for a wide variety of  reasons. Barcodes can
contain information specific to the badge design or to the
cardholder. For example, the barcode can reflect the card number
or the user’s social security number.

NOTE: Some "High Density" applications may require a bar code font. In this
case, use the text field to define your barcode instead of a barcode
field. Another advantage to using a barcode font is the ability to
rotate the barcode (text block).

Adding a Barcode

Adding a barcode to a badge is as easy as clicking on the badge
with the barcode tool. The cursor can be changed to the barcode
tool in any of the following ways:

1. Select Insert Barcode from the Object menu.

2. Click the barcode button (  ) on the toolbar, or click anywhere
on an empty part of the badge with the RIGHT mouse button
and select Barcode.

After the cursor has changed to the barcode tool, click on the
badge where you want the upper left-hand corner of the barcode
to be. The barcode can be resized and moved or edited as
described below.
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Editing a Barcode

Select the barcode by clicking on it. Then click the RIGHT mouse
button anywhere on the barcode to open up its option menu.

Click Data... to define your barcode with the following fields in
the dialog box:

Style
Select a barcode style from this drop down list. Your choice
include:

5fo2• 39edoC• ISM• ACPU•

devaelretni5fo2• 821edoC• FTI• ECPU•

9fo3• 821NAE• 11edoC• A821edoC•

rabadoC• 31NAE• BedoC• B821edoC•

93edoC• 8NAE• nepeleT• C821edoC•

Ratios
Select a ratio from Ratio drop down list to determine the width
ratio of  thick bars to thin bars. For example, a ratio of  2.00
indicates that thick bars are twice the width of  thin bars.
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Data
Data can be entered directly into this edit box. Either type in what
you want encoded or enter a field that you want coded from the
card holder’s database. To do this, simply double-click a field from
the listing of fields and it will appear in the data edit box.

Data can be combined in much the same way as it was in the
text fields mentioned above. You should highlight and delete the
sample data (1234567890) when defining this field.

NOTE: Error detection is not a feature with all barcode readers.

Check Digit
Check Digit provides error detection.

Spacer
Spacer adds space before and after the barcode when show data
is enabled.

Show Data
The Show Data option displays the data encoded underneath
the barcode in what is called “human readables.”

Editing The Barcode Background Color
Click on the barcode to select it, then click anywhere on the barcode
with the right mouse button to open the options menu. Select
Background Color. Selecting this menu item brings up a palette of
Basic Colors for changing the barcode background color.

Choose a color, select it with the mouse, and click OK. If a
custom color is needed for the barcode background, it can be
created. See Appendix F.
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Deleting a Barcode
Select the barcode by clicking on it, then click on it with the
RIGHT mouse button to open its options menu. Select Delete.
This menu item removes the barcode from the badge.

Shapes Control

The Badge Layout Utility allows you to place shapes on your
badge. Shapes consist of rectangles, rounded rectangles, ellipses,
and lines. You can change the border or line width, the border
and background color, or make them transparent to frame
photos or text blocks.

Adding a Shape

Adding a shape to a badge is as easy as clicking on the badge with
the shape tool. The cursor can be changed to the shape tool in any
of the following ways:

1. Select Insert Shape from the Object menu.

2. Click the shape button (  ) on the toolbar, or click anywhere
on an empty part of the badge with the RIGHT mouse button
and select Shape.

After the cursor has changed to the shape tool, click on the
badge where you want the upper left-hand corner of the shape
to be. A square will be placed which can be changed to a
different shape, moved, and resized.
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Right-clicking anywhere on the shape opens up the editing
menu. The menu options are explained below.

Border or Line Width...
The Border or Line Width... option allows you to change the
width of the border or line.

Foreground Color...
The Foreground Color... option allows you to change the color
of the border or line.
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Background Color...
The Background Color... allows you to change the color of  the
center of the shape. Not applicable if you have selected
transparent.

Transparent
The Transparent option turns the shape transparent. It is not
applicable if  the shape is a line. For all other shapes, the center
region becomes transparent and only the border is visible. You
can use this option to create frames for other elements on the
badge.
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Line
The Line option turns the shape into a line. If you stretch this
shape so that it is longer horizontally, it will be drawn as a
horizontal line. If you stretch this shape so that it is longer
vertically, it becomes a vertical line.

Rectangle
The Rectangle option turns the shape into a rectangle.

Rounded Rectangle
The Rounded Rectangle option turns the shape into a rectangle
with rounded corners.

Ellipse
The Ellipse option turns the shape into an ellipse.

Delete
Select Delete to delete the object from the badge.
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Signature Placeholder Control

The Badge Layout Utility allows you to place a signature
placeholder to reserve an area of  the badge to where the
signature can be imported.

A signature pad (Northern Computers’ PBSIGCAPLCD) can
be connected to the computer to scan in signatures.  The
signatures are saved in vector format.  They can be placed on
the badges and are proportionally stretched to fill the area
allotted for them. The color and weight of the signature is user
configurable. They can also be made transparent to be placed on
top of any other object on the badge.

Adding a Signature Placeholder

Adding a signature placeholder to a badge is as easy as clicking on
the badge with the signature placeholder tool. The cursor can be
changed to the signature placeholder tool in any of the following
ways:

1. Select Insert Signature from the Object menu.

2. Click the signature placeholder button (  ) on the toolbar, or
click anywhere on an empty part of the badge with the right
mouse button and select Signature.

After the cursor has changed to the signature placeholder tool,
click on the badge where you want the upper left-hand corner of
the signature placeholder to be. The signature placeholder can be
moved and resized or edited.
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Right-clicking anywhere on the signature placeholder opens up
this menu. The menu options are explained below.

Line Width
Selecting the Line Width option the following dialog box will
appear prompting you to enter width of the line used in the
signature. The width is measured in millimeters.

Foreground Color
The Foreground Color option allows you to change the “pen”
color of the signature.

NOTE: Signatures cannot be oriented.

Background Color...
The Background Color... option allows you to change the
background color of the signature block.

Transparent
The Transparent option makes the background color of  the
signature block transparent. When the signature is put on the
badge, it will appear to be written over what is behind it.

Delete
Select Delete to delete the signature block from the badge.
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Magnetic Stripe Encoding

The Badge Layout Utility allows you to setup magnetic stripe
encoding information for each badge that you create.   If  you are
using a supported printer that does magnetic stripe encoding,
you will be able to encode cards when they are printed.

NOTE: The magnetic stripe setup MUST be assigned to the layout used for
the back side of the card when duplex (2-sided) printing. If single side
printing, the magnetic stripe setup is applied to the badge layout.

Each badge layout can have magnetic stripe encoding data
defined for it.  Any combination of text and fields can be
encoded on the magnetic stripe provided it is within the bounds
of  the format.  Individual fields can be placed within any ordinal
character range, justified left, center, or right, and padded with
any character.

To edit the magnetic stripe information for a badge, select the
window containing the badge design that you want to print. Then
select Mag Stripe Setup... from the File menu. Selecting this
option opens a dialog box called Setup Mag Stripe that will allow
you define the magnetic stripe information for that badge.
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How Magnetic Stripe Information Is Defined

As you can see in the above dialog, magnetic stripe data can be
defined for all three tracks. For each track, specify the magnetic
stripe format that will be used: IATA, ABA, or TTS.

NOTE: The following track/format assignments are the industry encoding
standards: IATA=Track 1 ABA=Track 2 TTS=Track 3

Each track can have any number (limited by the amount of data
that will fit on a given track) of data items that can be
consecutively written to it.  The data that can be used is limited
to certain ASCII characters, depending upon the format selected
for that track.

IATA will allow you to enter the numerical characters 0-9, the
alphanumeric characters A-Z, and various punctuation characters
(ASCII 32-95). If  lowercase letters are used, WIN-PAK converts
them to uppercase first, as IATA doesn't understand lowercase. If  a
field separator is required, it is designated by the "^". See your
printer documentation for the number of characters that can be
encoded using the IATA format.

NOTE: Some encoders may not utilize Track 3. Check your printer before
using this feature.

ABA will only allow numeric characters 0-9 and various
punctuation characters (ASCII 48-63). See your printer
documentation for the number of characters that can be
encoded using the ABA format.
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NOTE: Some magnetic stripe cards may not support track 3 encoding.
Check with your card supplier for further information.

TTS will only allow numeric characters 0-9 and various
punctuation characters (ASCII 48-63). See your printer
documentation for the number of characters that can be
encoded using the TTS format.

NOTE: Currently, Northern Computers' readers only read ABA or Wiegand
type encoding. The NR-1 and NR-5 reader reads ABA on Track 2, and
the NR-2 reader reads ABA on Track 1.

Each data item is defined by four fields. The first field is the
length. This is the number of characters that is written to the
track for this data item.  If the data item is longer than the length,
it will be truncated.  If  it is shorter it will be padded with the Fill
character. The data item can be defined as “Variable” length.  This
means the number of characters written to the track is equal to
the length of the data item.  The second field is the Justification.
Justification is only valid for fixed length data items.  If  a data
item is shorter than the number of characters allotted for it, it can
be justified left, center, or right, within those characters.  All other
characters will be set to the Fill character.  The third field is the
Fill character, which is used to pad the data to fit a fixed length
field.  The last field is the Expression.  This can be any
combination of  text or database fields.
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Editing The Tracks

To edit a given track, push the Edit button next to that track, or
double-click on a data item line within the track list box. This
will bring up the Edit Track dialog.

The Edit Track dialog allows you to modify the data format of
each of the tracks on the magnetic stripe. This dialog is shown
below, along with information about the controls on it.

Add
The Add button allows you to add a new data item to this track.
It is initially set to default values. Once created, you can then
edit it to configure the item with the proper data.

Edit...
The Edit button allows you to edit the currently selected data
item. You can also double-click on the desired line in the list
box. See below for information on editing track data items.
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Delete
The Delete button deletes the currently selected data item from
the list.

Move Up
Move Up moves the  selected item up one position in the list.
Use Move Up and Move Down to change the order of the items
in the list.

Move Down
Move Down moves the currently selected item down one
position in the list.

Press OK to exit and keep any changes that have been made, or
Cancel to exit without keeping any changes.

If  you edit any of  the items from the Edit Track Data dialog,
the Edit Track Item dialog opens. This is the lowest level dialog
that allows you to configure each data item.

Expression
Expression data can be any combination of text and database
fields. Double-click an item in the Fields list to insert it in the
Data edit box.  You can also type any text you desire.
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Justify
Select the justification method you would like to use for this
item. If  Length is Variable, justification is not applicable.

Length
Enter the maximum length of  this data item, or Variable to
create a variable length item.

Fill Character
Enter the character you wish to use to fill the blank space in fixed
length data items. You can specify any ASCII value by typing /n,
where n is a number.  You can also just type a character in.

NOTE: To enter empty spaces for your Fill character, either type a space or /
32 in the Fill Character field.

Fields
The Fields list includes the fields available to be used in the
Expression. Double click on a field to insert it in the Expression
edit box.

Press OK to exit and keep any changes that have been made, or
Cancel to exit without keeping any changes.
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Printing a Badge Layout

This section demonstrates how to print a copy of your badge
DEFINITION. It is not used to print badges with personnel
fields, photos, and barcodes filled in – that is done from the
Card Database in the main WIN-PAK component.

NOTE: Printer Drivers are added in the Control Panel of Windows. See your
Window’s manual for more information.

Select the window containing the badge design that you want to
print. Then select Print... from the File menu or click the Print
button (  ) on the toolbar. Selecting this option opens a printer
dialog box.

NOTE: If a printer other than an Ultra Electronics Tango or Fargo printer was
chosen during installation configuration, a different printer dialog box
appears.

Select your printer from the drop-down list and click Print to
print the card design, or Cancel to go back to the database
without printing.

NOTE: A badge layout will not print until it is saved.
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Alarm Monitor
WIN-PAK’s Alarm Monitor Screen reports all alarm and reader
activity as it happens. The user has four viewing options. The
user can view alarms and card reads as they come in (History
View) or in order of priority (Current View). The operator can
also view defined alarm points and their current status in a grid
(Monitor View) or by graphic floor plans (Floor Plan View).
Each of these views is explained in detail in the following
sections.

History View

The History View displays all alarm information and system
communication as they are received from the panels in a list
form with the most recent information appearing at the top of
the list. This list displays information on alarms and readers
including the date, time, and status.
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The operator can use the History View to monitor alarms at a
glance. This view provides an overview of  system activity only.
It does not allow the user to acknowledge or respond to activity.

Browsing On-line History
When alarm and reader information fills the screen, a scroll bar
appears so the operator can browse through past actions.

Freeze Button 
The Freeze button halts the display of actions for a maximum
of  120 seconds to keep the display from showing more alarms
while browsing.

Live Button 
When frozen, the Freeze button changes to Live and begins a
countdown to return to live alarm monitoring. The operator can
use this button to toggle back to Live before the end of  the
countdown.

Current View

The Current View (next illustration) displays information on
incoming alarms. The screen is divided into two sections, one
for incoming alarms and one for acknowledged alarms.
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Incoming Alarm Section
The upper section of  the screen receives alarms based on the
priority threshold for acknowledgment (as defined in the Setup).
All alarms with a priority higher than the threshold (the number
being equal to or lower) are displayed.  All alarms with a priority
lower (the number being higher) than the threshold are not
displayed.

In the Incoming Alarm section of the screen, the colors of the
bars indicate the type of  alarms. A red bar indicates an alarm
condition, a green bar indicates a normal condition, and a yellow
bar indicates a trouble condition. When you click an alarm or
group of  alarms to select them, the bar turns gray.

NOTE: A yellow alarm (input in trouble) only appears with an N-1000-III or IV
board or when and AEP-5 board is used with an N-1000-II.
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Once a point goes into alarm or trouble, the bar color will not go
back to a normal color (green). For example, if  the first message
from that point or card is normal, subsequent alarm or trouble
conditions change the alarm to red or yellow. After that, it will stay
red (or change between yellow and red) but will not go to green on
a normal state. The Count column shows the number of  times a
point changes state while it is in the upper screen.

Double-clicking on a transaction brings up the Alarm Info
screen showing the details of what has been indicated by the
counter, and allowing a Note to be written for that alarm. See the
Alarm Info Screen section of this chapter.

Acknowledging a transaction moves it to the lower portion of
the screen.

Acknowledged Alarm Section
When an alarm is acknowledged, it moves to the Acknowledged
Alarm section of the screen. The background color of the
transaction is black, and the color of the type changes according
to the convention used in the Incoming Alarm section: green for
normal, yellow for trouble, and red for alarm. The color changes
with each new condition. Transactions remain in the
Acknowledged Alarm section until they are cleared.

The position of transactions in both areas of the screen is
determined by priority level and time. The highest priority
transactions are first, while transactions with the same priority are
shown with the most recent being first.

Acknowledging an Alarm or Card Read
Acknowledging an alarm or card read shows that the operator has
seen the alarm/card read status. All alarms received in the
Incoming Alarm Section have a priority high enough to require
acknowledgment.
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To acknowledge an alarm or card read in Current View
 1. Select the alarms to be acknowledged Click on a single alarm or

to select more than one alarm, hold down the Control key and
click each alarm. To select a range of  alarms, press Shift and
then select the first and last alarms in the range.

2. Click the Acknowledge button (  ) on the toolbar or right click
on the alarm(s) and then select Acknowledge from the menu
that appears.

The alarm(s) move to the Acknowledged Alarm section of  the
screen.

Clearing an Alarm or Card Read
Clearing an alarm or card read deletes it from the view.

To clear an alarm from the Current View
1. Select the alarm(s) to be cleared.

2. Click the Clear button (  ) on the toolbar or right-click the
alarm(s) and select Clear from the menu that appears.

The alarm(s) are deleted from the view.

NOTE: Clearing an alarm may require that the alarm point be in the Normal
mode. The Clear Alarm State setting is found in the Setup menu under
Communications.

Viewing and Responding to Alarm and Card Read
Information
To view alarm and card read information, double-click the alarm.
This will open the Alarm Info screen with information on that
alarm.
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Viewing Card Information
Selecting a card read in the current view and clicking on the
Card Lookup tab will display the information and a photograph
(if  existing) of  the card user.

Locating a Card Holder from a Read
Selecting a card read in the current view and selecting Locate...
from the View menu will open up the Locate tool with the card
information pre-entered in the fields.

Monitor View

The Monitor View (next illustration) displays a screen of  alarm
input points defined by the operator. Icons representing these
points show the status of  the alarm point. Green alarms
represent a normal condition, red alarms represent an alarm
condition, and yellow alarms represent a trouble condition.

NOTE: A yellow alarm representing an input in a trouble status will only
appear with an N-1000-II panel when an AEP-5 board is being used, or
with an N-1000-III or IV board.
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A number may appear in the center of  the alarm denoting the
number of times the input point has changed status since the
last time it was cleared. Input points requiring acknowledgment
as defined in the Setup Options and Panel Database will be
flashing when received.

Defining Alarm Input Points
To define alarm points for your grid, select Monitor Points...
from the View menu or click the Monitor Points button (  ) on
the toolbar.



260260260260260 WIN-PAK 1.17 User Manual

A dialog box will open to allow you to select input points to
monitor.

NOTE: System Alarms are not used as Available Input Points.

Loop
Use the Loop drop-down list to select the loop (area) that
contains the point(s) you want to monitor.

Panel
Use the Panel drop-down list to select the panel that contains
the point(s) you want to monitor.

Once the loop and panel are specified, the enabled input points
for that panel will be displayed under Available Input Points.
Simply click once on the point you want to monitor and it will
be added to the Selected Input Points list. Clicking points in the
Selected Input Points list will remove them.

Click OK to add the input points in the Selected Input Points list.
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To identify an alarm, select it, and its name will appear in the
status bar. The number displayed in an alarm icon is the number
of  times the alarm has changed state since it was last cleared.
Double-clicking the alarm will open the Alarm Info screen to
display alarm information and allow the operator to enter a note.

Acknowledging an Alarm
As in the Current View, acknowledging an alarm shows that the
operator has seen the alarm. An alarm in Monitor View blinks
and beeps until it is acknowledged.

 1. Select the alarms to be acknowledged. Click on a single alarm
or, to select more than one alarm, hold down the Control key
and click each alarm. To select a range of  alarms, press Shift
and then select the first and last alarms in the range.

2. Click the Acknowledge button (  ) on the toolbar or  right
click on the alarm(s) and then select Acknowledge from the
menu that appears.

The alarm will stay on the screen but will not flash.

Clearing an Alarm
Clearing an alarm will not delete it from Monitor View, but it
will clear the Alarm Count in the alarm.

1. Select the alarm(s) to be cleared.

2. Click the Clear button (  ) on the toolbar or  right-click the
alarm(s) and select Clear from the menu that appears.

The alarm count will then be cleared on the monitor.
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Polling an Alarm
A panel doesn’t report when a point is shunted. Polling is
valuable when points are shunted and you want to know
whether a point is “open” or “closed.”

To poll an alarm
1. Select the alarm.

2. Right click on it to bring up a menu.

3. Select Poll.

Only points associated with that panel will report.

NOTE: Use of the polling feature requires that the control panel has version
7.46 or higher firmware.

Viewing Alarm Information and Responding to Alarms
To view alarm information, double-click the icon. This opens the
Alarm Info screen with the message defined for the alarm status
in the Panel Database.
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Floor Plan View

The Floor Plan View gives the operator the option of
monitoring alarms by floor plans and/or digital photos. Floor
plans can be representations of a building created in a paint-type
program and saved as a bitmap file. Photos can be taken with a
digital camera or scanned and saved as bitmap files. The bitmap
is referenced and given a descriptive name in the Floor Plan
Database.

Floor Plans are accessed by clicking on the drop-down list at the
bottom of this screen, and selecting the floor plan that you
want. This list consists of floor plans defined in the Floor Plan
Database.
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Using Floor Plan Hot Spots

The Floor Plan Database allows the operator to create hot spots
on the floor plan, which can be linked to another floor plan, an
input point, or both. Hot spots appear as dashed rectangles
when linked to another floor plan or as an alarm when linked to
an input point. When the cursor is over the hot spot, a message
pertaining to it appears in the status bar.

Click the floor plan hot spots to bring up a floor plan or other
graphic. This makes it possible to build detailed graphic maps
where clicking a floor plan hot spot gives a more detailed look at a
specific area.

   

While clicking a floor plan hot spot brings you to another floor plan,
right-clicking the new plan opens a menu listing the floor plans that
you have “traveled through” to get to the current graphic. To get
back to any of  these floor plans, just click its name on the list.

Monitoring Alarm Points
Hot spots can also be defined in the Floor Plan Database as alarm
input points.  These will appear on the floor plan as alarm icons.
This gives the operator the option to monitor alarm points like in
the Monitor View but with points placed on a floor plan. This
makes it easy to recognize where a particular alarm is in a facility.
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Alarm Information

The Alarm Information screen is used to view alarm and card
read information and allow the operator to enter a response.
When an alarm is triggered or a card is read (with the
appropriate threshold settings), it appears in the Alarm Monitor
Screen in the Current View and, if defined, in the Monitor and
Floor Plan views. Double-click the alarm in one of  these views
or select it and click the Alarm Info tab to view alarm
information and the message associated with it. These messages
are defined in the panel and card databases.

NOTE: If a note is to be entered, it must be entered into the Notes field
BEFORE the alarm is acknowledged. After the alarm is
acknowledged, the Notes field cannot be edited.
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Each change of  state of  the alarm is displayed until the point is
cleared.

The Alarm Info screen also provides a field for entering
response notes. To enter a response note to an alarm state,
simply select the state in the Alarm Info field, click within the
Notes field and type your note. If Log Actions is enabled in the
Operator Options screen (Located in the Setup Menu), then
these notes will be saved and can be printed in a history report.

NOTE: It is necessary to press Enter at the end of each line when creating a
comment. Words will not automatically wrap to the next line when
typing.
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Panel Control

The Panel Control screen gives the user direct control over the
panels and the active input and output points connected to
them. This is where panels are buffered, unbuffered, and
initialized and where individual input points can be shunted and
output points can be energized. Command files can be sent to
individual panels and remote areas can be dialed up from this
screen.

All commands sent to area panels are shown in the Progress
Window. This displays a list of  every command and its current
status. When the window fills up, a scroll bar appears allowing you
to browse through all your actions.

Under the Progress Window is the Transaction Status bar. This
bar shows the progress of  the currently sent commands.
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Area
From the list, select the area that you want to communicate
through. All remote and local areas defined as Loops in the Area
Database appear in this list. If a remote area is selected, a
Connect button appears to the screen for additional options.

Controlling Panels

Panel
All Panels defined for the Area that you selected appear in the
Panel list. Select the panel you want to control.

Buffer Panels
The Buffer Panels button buffers the selected panel. Clicking
this button stops all panel information from being sent to
WIN-PAK, and instead stores it in its own memory. This is
useful when WIN-PAK is exited or when troubleshooting panels.

Unbuffer Panels
The Unbuffer Panels button unbuffers the panel selected in the
Panel field. Clicking this button prompts the panel to send all
buffered transactions to WIN-PAK. Alarms that were buffered will
be presented in the alarm monitor with the time that the alarm
occurred at the panel. WIN-PAK will act on the alarms per WIN-
PAK’s program options (buffer, floorplan, command files, messages,
etc...).



System Screens 269269269269269

System
 Screens

Panel Initialization
The Initialize button opens a dialog box allowing you to send
programmed information to the panel(s) selected in the Panel
field. Specify which information you want sent by enabling the
options below.

All panel inputs will report in twice when the Initialize option is
selected.

Initialize
Enabling the Initialize option includes information contained in
the panel definition (anti-passback, free egress, etc.) and site
codes and also deletes all cards in the panel when the OK
button is pushed.

NOTE: When selected, Initialize will reset the panel’s programming.
Therefore, all options should be selected when Initialize is enabled.

Time & Date
Enabling the Time & Date option will include the current time
and date (as defined by the system clock on your PC) when the
OK button is pushed.
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Cards
Enabling the Cards option will include card information when
the OK button is pushed. Cards are automatically updated when
using the Card Database. Therefore, it is not always necessary to
send cards to the panel from this screen.

NOTE: If sending only cards, it is recommended to completely re-initialize
the panel with all options. This is to delete old cards still located at
the panel.

Command File
Enabling the Command File option will send the command file
that is assigned to the panel when the OK button is pushed. A
command file is assigned to a panel in the Panel Screen in the
Panel Database.

Holidays
Enabling the Holidays option will include the Holidays database
when the OK button is pushed.

Timezones
Enabling the Timezones option will include panel timezone
information when the OK button is pushed.

Input Points
Enabling the Input Points option will include input point
information (shunt times, timezone assignments, interlocks,
etc.) when the OK button is pushed.

Output Points
Enabling the Output Points option will include output point
information (pulse times, timezone assignments, interlocks, etc.)
when the OK button is pushed.



System Screens 271271271271271

System
 Screens

Groups
Enabling the Groups option will include group information
(pulse times, timezone assignments, interlocks, etc.) when the
OK button is pushed.

Clicking OK uploads all the information enabled in the Panel
Initialization section to the panel specified in the Panel field.

Sending a Command File
Any command file defined in the Command File Database can
be manually sent to a panel. To send a command file, (1) select
it from the drop-down list and (2) Click the Send button.

NOTE: The command file will be sent to the “Area” defined in the command
file.

Controlling Remote Panels
If the area that you select in the Area drop-down box is defined
as a remote area, and has panels assigned to it, a button labeled
Connect will be visible. Clicking this button opens a dialog box
allowing the operator  to send commands via modem to a
remote area. The commands appear in the order that they will
be performed.
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Connect
Enable the Connect option to dial the remote site. This option is
unavailable if the current area is already on-line. The option will
be selected and unavailable if it is not connected and you click on
Connect.

NOTE: Panel control of the remote loop will be grayed out until a connection
is made with the remote site and if unbuffer is selected. The control
options will remain grayed out until the panel is
unbuffered.

Send Date & Time
The Send Date & Time option is recommended to maintain time
sync with the system.

Unbuffer
Enable the Unbuffer option to unbuffer the panels at the remote
location. It is recommended that this option be selected if the
Send Commands option is selected. When sending commands,
information at the panel may be lost if  not unbuffered.

Send Commands
Enable the Send Commands option to send the card database
updates to the remote site. It is recommended that if buffered
information is needed, to unbuffer the panel as well. If  Send
Commands is enabled, and Unbuffer is not, then buffered events
may be lost.

Buffer
Enable the Buffer option to buffer information at the remote
panels after unbuffering and sending commands.
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Disconnect
Enabling the Disconnect option will disconnect the remote area
from WIN-PAK when completed. If  you do not disconnect
automatically, you will remain on-line until you select the “Area”
and click the Disconnect button.

Clicking OK performs all enabled commands in the order they
appear for the remote area selected. If all commands are enabled,
the following happens:

1. WIN-PAK connects to the remote site.

2. WIN-PAK updates the remote site's date and time.

3. WIN-PAK unbuffers information from the remote panels and
downloads them to the Alarm Monitoring views.

4. WIN-PAK  sends the card updates.

5. WIN-PAK re-buffers the panels at the remote site.

6. WIN-PAK disconnects from the remote site.

If  the Disconnect option is not selected in the Remote Dial-up,
a Disconnect box replaces the Connect box. Clicking on the
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Disconnect box will provide similar options. The Remote Dial-
up box will show the Buffer option marked (suggesting to buffer
remote panels) and the Disconnect option marked and grayed, to
allow disconnect.

Controlling Input Points

Shunt
Click the Shunt button to shunt the currently selected input
point.

Unshunt
Click the Unshunt button to unshunt the currently selected
input point.

Restore to TZ (Timezone)
When a point has been shunted or unshunted during a timezone,
it should be returned to the timezone when the override is done.
Click the Restore to TZ button to restore the selected input to
the programmed timezone.

Controlling Output Points

Energize
Click the Energize button to energize the currently selected
output point.

De-Energize
Click the De-Energize button to de-energize the currently
selected output point.

Pulse
Click the Pulse button to pulse the currently selected output
point.
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Restore to TZ (Timezone)
When a point has been energized or de-energized during a
timezone, it should be returned to the timezone when the over-
ride is completed. Click Restore to TZ button to restore the
selected output to the programmed timezone.

Muster Report

Muster reporting allows an operator to track where card holders
are in the event of  an emergency. Tracking depends upon the
setup of  tracking areas in the Tracking Areas database. These
areas are based on the readers used to enter areas of  a facility.

Once tracking areas have been defined, a new screen will be
added to the operations screens. Clicking the Muster Report Tab
opens up this screen.
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The upper section is the Muster Area Card Transactions
section.  Normally this section will be empty. If  a muster is
declared, people will go to the muster readers to present their
cards, and this section will show those card reads.  If  people go
back into the tracking areas, or use an exit reader (to go home,
for example) their card read record is removed from this area.

The updating of  this view is done automatically, but can be
frozen to view the muster area list. To do this, disable the
Refresh Muster Report option by clicking on the box in the
lower left hand corner.  When you click on this box the check
mark disappears, and the card read records coming in from then
on are stored in a buffer rather than written to the screen.  This
allows you to work with an unchanging screen.  When you click
on the box again to enable the option, the card reads stored in
the buffer are written to the screen and all card reads from then
on are recorded until you disable the option again.

You can delete card read records from the Muster Area Card
Transactions screen by selecting a card and clicking the Delete
button under the right corner of the list. The Refresh Muster
Report option must be disabled (unchecked) to delete a card.

The lower section of the screen is the Non-Muster Area Card
Transactions section.  This section functions generally in the
same manner as the Muster Area Card Transaction section
except that it is dealing with card reads from the tracking
readers.  This section will experience significant activity most of
the time.  During a muster call, some or all of the activity would
switch to the Muster Area Card Transaction screen.  The
Refresh Muster Report box affects this section of  the screen
in the same manner that it affects the upper section.
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Sort Order
The Sort Order selections for both the upper and lower sections
work in the same manner as the sort order selectors in other
areas of  the Database structure. Options include sorting by card
number (if the operator has the View privilege), card holder
name, tracking area, and date/time.

Filter
The Filter selections allow you to view reads from all areas at
one time, or only the reads from a particular area.

Reports

Print Reports will print a report based upon the sort order and
filters you have selected.  It gives you the option of  reporting
on the muster area only, the non-muster area only, or both areas.
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Muster System Precautions

When designing a muster system for use with WIN-PAK, it is
important to keep the following precautions in mind:

1. Use a separate dropline (COM port) to isolate the muster
readers from the tracking units. A special line should be run to
provide a unique data path that will still be intact should the
wiring from the main facility get damaged.

2. A “cold restart” of the access control panel could occur from a
serious surge on the power or communication lines. This can
cause corruption of  the panel’s database and time functions.
Version 8.01.10 and higher firmware address the time problem
by generating a system alarm 99 (Panel Database, System
Alarms, Panel Reset Alarm) when the panel experiences a cold
restart. WIN-PAK will then send the current Time and Date to
the panel within 60 seconds of  receiving this alarm. The default
time and date after a cold restart is January 1st, Monday at 12:00
am. You will be able to see this time stamp on activities in the
History view. Panel Time is critical to the proper operation of
the Muster function as the most recent event is used to
determine the Tracking/Muster status of  a Card holder. If  a
card is presented to the Muster reader and the time and date
stamp is earlier than from another reader location, there will not
be a change of status to the Muster (safe) location.

3. In the event that the card database is lost or corrupted at the
muster reader, WIN-PAK will recognize all reader types (Not
Found, Timezone, Normal, Trace, Pin Violation, and Expired)
as “valid” muster reads (provided that the time is later than the
previous card read as described above). This function will
prevent the need to reload the cards to a muster panel during a
muster event. Only Valid and Trace card reads will count at a
Tracking reader.
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4. The communication loops should be RS-485. WIN-PAK should
have corresponding Areas defined as RS-485 with ACK-NAK
enabled. If using N-485-API-2s, they must be powered by a
battery backed up power supply (not required for N-1000-III or
N-1000-IV where the 485 is built into the control panel and is
already using the battery backup of the control panel).

5. An UPS or other backup power source should power the WIN-
PAK computer, N-485-PCI-2 and other associated
communication devices. Installation of  the equipment should be
in a location that is considered “safe” from known hazards.

6. The muster system should be on-line (not buffered) to ensure
timely and complete information. Regular checks to insure that
the muster system is functioning properly should be performed
as part of the security routine and should be rigorously enforced.

7. As mentioned above, it is critical that the time and date be
correct on card reads at the Muster readers. If  the time and/or
date are earlier than that of other reads in the system they will
be ignored. For this reason, regular checks should be made to
see that all panels are maintaining the correct time and date. The
checklist for actions to be performed at the computer during the
time of the muster should include several checks to be sure that
the muster reads are coming in from the panel with the correct
time and date. If  it is observed that they are not, officials should
order the presentation of cards stopped, and the time and date
should be sent to the panel. A quick test should then be run and
all people who might have swiped their card during a time when
the time and/or date were incorrect should be directed to repeat
their swipe. Multiple swiping of the same card at the Muster
reader will not adversely affect the result of the Muster as the
most recent time/date stamp is the one that is “displayed” in the
Muster section. This procedure should be practiced regularly, so
personnel have a clear familiarity with it. The Scheduler should
also be programmed to update time and date at least once a day.
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Camera Control

The Camera Control Screen is used to assign cameras to
monitors and to make adjustments to cameras in a CCTV
monitoring system.

NOTE: This function of WIN-PAK is for facilities with CCTV systems. Setting up
WIN-PAK for these systems requires that the Camera and Monitor
Databases contain records and that an area is defined as a CCTV
network.
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Assigning Cameras and Monitors
To assign a monitor to a camera view, select the monitor name
from the left column, the camera name from the right column,
and click Select. The camera view selected will then appear on
the selected monitor.

To view the titles of  the camera views on the appropriate
monitors, click Send Titles. This will display titles on all camera
views being monitored. See your CCTV equipment manual to
see if the title feature is supported.

Controlling a Camera
Adjustments can be made to cameras remotely from within WIN-
PAK. Select the camera that you want to control from the Camera
to View drop-down list. Once you have a camera selected, you can
adjust it in any number of the following ways:

 Focus on Closer Objects

Clicking and holding down the Focus on Closer Objects (top)
button slowly brings objects into focus.



282282282282282 WIN-PAK 1.17 User Manual

 Focus on Farther Objects

Clicking and holding down the Focus on Farther Objects
(bottom) button slowly brings objects farther away into focus.

NOTE: Your camera must support focus, aperture adjustment, zoom, pan
and tilt, homing presets, and titling to take advantage of these
features.

  Increase Aperture

Clicking and holding down the Increase Aperture (top) button
slowly increases the aperture of the camera iris, letting in more
light. The icon will change showing the center more open when
“pushed”.

  Decrease Aperture

Clicking and holding down the Decrease Aperture (bottom)
button slowly decreases the aperture of the camera iris, letting
in less light. The icon will change showing the center closed
when “pushed”.
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   Zoom In

Clicking and holding down the Zoom In button slowly zooms
the camera in closer.

   Zoom Out

Clicking and holding down the Zoom Out button slowly zooms
the camera out farther.

Camera Pan and Tilt Control

 Control Arrows

Clicking and holding down the camera control arrows move the
camera. Clicking and holding down the Left Arrow pans to the
left, while clicking and holding down the Right Arrow pans to the
right. Clicking and holding down the Up Arrow tilts the camera
up, while clicking and holding down the Down Arrow tilts the
camera down.
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Setting Pan and Tilt Limits
Limits should be set on each camera’s panning and tilting actions.
Limits are used to keep a camera from tilting and panning to a
point that is stressful on the hardware and to limit a camera’s view
to that which is useful. The following steps demonstrate how to
set the upward tilt limit for a camera. Repeat these steps for
downward tilt, left pan, and right pan on each camera.

NOTE: Your CCTV equipment must support preset limits to use this feature.

1. Use the up and down arrows to tilt the camera to the highest
point needed.

2. Right-click on the up arrow with the mouse.

3. Click Set Limit from the pop-up menu.

To clear a limit that has been set:
1. Right-click on the arrow with the limit you want to clear.

2. Click Clear Limit from the pop-up menu.
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Setting Home Position
A Home Position is the most utilized view of a camera. It can be
set for each camera so that it will return to its home position
with the correct focus, aperture, and zoom settings when the
Home button is pushed. The following steps outline setting a
home position:

NOTE: Your CCTV equipment must support the home position to use this
feature.

1. Adjust the pan, tilt, and adjustment settings for the view that
you want to make your home position.

2. Right-click the Home button and click Set Home from the
pop-up menu.

Now your camera will return to this view when you click the
Home button.
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Live Camera View

Monitoring of cameras can be done without using the Camera
Control Screen if a video capture board is installed. Simply
select Live Camera from the View menu to bring up the live
camera dialog box. This screen is adjustable in size and can be
located anywhere on the WIN-PAK screen.
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NOTE: Live Camera View is not an option if TWAIN interface was chosen
instead of a video capture card during WIN-PAK installation. It will
only display video when the Flashpoint or Flash Bus board is
installed.

Select the CCTV Area that contains the camera that you want to
view from the Area drop-down list. If you would like to see the
camera view on a monitor as well as live on your screen, select
the monitor you want to view it on from the Monitor drop-down
list. Select the Camera that you want to view from the Camera
drop-down list.

Adjustments made to Iris, Zoom and Focus are done the same
way as outlined in the Camera Control screen section.

Panning is done differently in the Live Camera dialog box. As
you move the cursor over the live camera view portion of the
screen you will notice that the cursor turns into an arrow. The
arrow will point in the direction of  the closest edge of  the view.
Depressing the left mouse button will pan in the direction the
arrow is pointing.

A command file can also be sent from this dialog box. Select the
command file that you want to send from the drop-down list, and
click Send.

NOTE: Displayed areas and command files are only those associated with an
area defined as camera.
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Card Lookup

The Card Lookup screen is designed to be a quick way for the
operator to access card information without having to enter the
card database. Its screen offers the operator the card number,
name, card status, PIN number, access level, expiration date, and
user-defined note fields for the card holder. It also displays the
card holder’s badge photo.

The records in the database can be browsed using the navigation
buttons at the bottom of the screen. Each button will take you
to a record based upon the record you are currently viewing and
the index used in the last search. The buttons are described below:

 First Record
Click the First Record button to bring up the first record in the
card database.
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 Previous Record
Click the Previous Record button to bring up the record
preceding the currently viewed record in the card database.

 Next Record
Click the Next Record button to bring up the record following
the currently viewed record in the card database.

 Last Record
Click the Last Record button to bring up the last record in the
card database.

Card Search

Besides browsing records one at a time, it is also possible to
search for a card record using the search tool. To find a
particular card holder, simply click in the information space next
to a key field name, type in the [case sensitive] criteria, and click
the Search button (  ). The key fields that can be searched by
are described below:

NOTE: You cannot search on any of the following fields from this screen:
Status, PIN, Access Level, or Card Limit. You also cannot search on
the Card Number if the operator doesn’t have access to view the
number.

Card Number
Click next to this label and type in the card user’s card number.
If the full card number is not known, type in the beginning
digit(s) of  the number. Clicking the search button (  ) will
bring up the first occurrence of that number and the records will
be indexed by the Card Number field. Click the next button (  )
for successive occurrences of that number (if available).
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Name
Click next to this label and type in the card user’s name using
the Lastname, Firstname format. You can also type in the
beginning characters of the last name. Clicking the search
button (  ) will bring up the first occurrence of a record with a
last name beginning with those letters. The records will be
indexed by last name so that clicking the next button (  ) will
bring up successive alphabetical records.

NOTE: You cannot locate by using the first name only.

Any User-Defined Field
Click next to any of the user-defined fields and enter the
information for that field. Enter as much of  the beginning
characters that you want. Clicking the search button (  ) will
bring up the first occurrence of those characters indexed by the
user-defined field. Clicking the next button (  ) will bring up
successive alphabetical records.

Automatic Card Lookup
WIN-PAK can be set to automatically look up cards that come
from readers or cards with status priorities higher than a particular
threshold. The operator can determine this priority threshold by
selecting Options from the Setup menu and clicking the
Communications tab to open the Communications Screen.

In the Alarm Monitoring section, note the number box labeled
Auto card lookup priorities less than and adjust the number by
typing it in the box or by using the arrow keys to increase or
decrease the number. All read statuses that are a higher priority
(lower number) than this threshold will pop up a card lookup
screen (next illustration).
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The card lookup screen will show the card holder’s photo and
card number (if operator has View privilege), the reader name,
transaction status, and the message associated with the card or
reader status (card status will appear first). Clicking the Alarm
Info... button will bring up the Alarm Info Screen so that a
comment may be entered.

This dialog box is re-sizable and can be placed anywhere on the
WIN-PAK screen. A gray box will appear where the photo
would be when a card that is not in the database is read or if
there is no photo attached to the card holder.

Locate Tool

WIN-PAK includes a function to help identify the whereabouts
of  a particular card holder. This is called the Locate tool. Use
the following steps to find the last place and time that a card
holder presented their card.

1. Select Locate... from the View menu. The locate dialog box will
appear.
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2. Fill in the card number or last and first name of the person you
are trying to locate. Card numbers MUST be entered in entirely,
but you only need to type in the first part of the last name to do
a search. All card holders whose last names begin with those
letters will be reported on.

If the last name and card number aren’t known, it will be easier
to use the Cards... button to fill in those fields for you. Clicking
the Cards... button opens the Card Database.

Select a sort order and use the scroll bar (if needed) to find the
person you want to locate and select that record. Click Close to
return to the Locate tool and the information of  the selected
record will automatically be filled in the fields.
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3. Click Locate. A report (next illustration) will be generated
providing you with information on the last time the card holder
presented the card at a reader. The information includes the date
and time of the event, the reader name, the card number and
name of the card holder, the area and panel name, the card and
read statuses, and the tracking area.

When the Locate tool is accessed while browsing cards in the
Card Lookup screen, the information of  the currently viewed
card record will automatically be filled in the Locate fields.
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Mail

The Mail screen is only visible if  WIN-PAK is installed as a
client or server. It is not displayed if  stand alone. The Mail
screen is used to communicate from the server to the network
stations. Although labeled mail, it is actually a chat function
with the ability to broadcast a message to all WIN-PAK stations
currently networked and on-line in WIN-PAK.

In Box
The In Box is used by network clients to display messages sent
from the server.
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Out Box
The Out Box is used by the network server to send messages to
one or more on-line operators at client stations in the network.

Sending a Message from the Server

1. Type a message in the Message box that you want to send to
another operator at a client station.

2. In the Users box, click on the operator(s) to whom you want to
send the message. The Refresh List button will update the
display of  all operators currently on the network and logged into
WIN-PAK. When sending a message to more than one operator,
it is a good idea to refresh the list before you send a message, so
that you can select recently logged on operators. Clicking the
Select All button is a quick way to select every operator listed
in the Users box.

3. Click Send to send your message to the operators you selected.
The Mail Screen will automatically be opened on the monitors
of those operators and your message will appear in their In Box.

NOTE: The Mail function only allows one way information from the server to
the clients.
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Viewing Reports
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Generating Database Reports
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Viewing Reports

Using WIN-PAK you can generate a wide range of  reports to
view on-screen and print out. To generate a report, select the
Reports menu.

Available reports include History Reports, Database Reports and
Attendance Reports.

The report viewer, as shown below, is used to browse reports
on-screen.

The report is displayed in the viewer as it will appear when it is
printed. The name of the report and date it is generated are at the
top left of  the page. Reports are in a column format with the
headings for each column at the top of each page.
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NOTE: In order to preview a page, the report printer must be defined. If
Windows does not have a printer driver loaded, no preview is
available.

Viewer Tools

 Scroll Bar
Use the scroll bar to view the entire length of a page. Click on
the arrows to browse slowly or on the bar itself to move up or
down a screen at a time.

 First Page
Click the First Page button to view the first page of the report

 Previous Page
Click the Previous Page button to view the previous page.

 Next Page
Click the Next Page button to view the page next page.

 Last Page
Click the Last Page button to view the last page of the report.

 Cancel
Click the Cancel button to cancel a requested report.

 3-View Zoom
Use the 3-View Zoom button to display the page at 100%, sized
to fit the entire page in the window, or sized to fit the page
width in the window.

 Print
Click the Print button to print the report.
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Exporting Reports

Reports can be exported to various file types. Click either of  the
following buttons to bring up the Export dialog box:  .

Format
From the list, select the file type you want. A number of data,
word processing, and spreadsheet formats are available. Some file
types require additional information before the data is exported.

Destination
To export the data to a file on your own computer, select Disk File
from the Destination drop-down list. You will be prompted to
navigate to the directory where the file is to be saved. To send the
exported data directly to someone via e-mail system, select the
mail system you have installed. You will be prompted for a person
to receive the report.
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Status Information

Page 
Page displays the current page and the total number of  pages.

Records 
Records displays the number of transactions in the report. This
number increases as the report is generated.

History Reports

A history report is a log of transactions that occur between two
points in time. The report can include card, input point, operator,
guard, and system transactions. An operator with report generating
privileges (see Operator Database) can generate reports for any time
period, for any or all areas and panels. The report, shown below,
includes transaction date and time, type of transaction, status
(activity), card name, reader, tracking area, acknowledge time and date
(if enabled), and operator (if enabled).
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Generating History Reports

Select History Reports... from the Reports menu. Enter selection
criteria in the dialog box.

To narrow your search and determine the information reported,
type criteria in the spaces provided.
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Date Range

The Date Range is defaulted as today and yesterday. To change
the start date, click the   button next to the From. Scroll to the
desired year and month, then highlight the start date.

NOTE: Purged information cannot be displayed. Archived information
(beyond date/time range) may be retrieved by selecting the "From
Archives Option" shown below.

To enter the end date of  your desired range click the button next
to the To box and choose the desired date from the calendar.
The dates are formatted MM/DD/YY, where MM is the month,
DD is the date and YY is the year.

Time Range
Enter the time range to be reported, type the start time in the
first text entry space and the end time in the second text entry
space. Follow the format HHMMSS, where HH is hours, MM is
minutes and SS is seconds. For example: 133000 would be 1:30
p.m. Leaving these spaces blank will generate a report on all
times for the dates specified above.

NOTE: Seconds are currently not monitored at the panel.
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If both the date and time ranges are left blank, a report is
generated on all dates and times currently in un-purged history
files. This process could take some time, depending on how
much history has been generated.

If the date range is specified, but the time range is left blank, then
history for the specified dates (that are not purged) are reported.

If both the date range and time range are specified, then history
that is between the defined hours and not purged is reported for
the dates specified. The hours cannot cross midnight.

The Daily option allows two ways of using the date and time
ranges:

Daily Enabled
If Daily is enabled (box checked), then history is reported on the
specified time range for each day in the date range. See the chart
below.

Daily Disabled
If Daily is disabled (box NOT checked), then history is reported
from the starting time of the starting date continuously to the
ending time of the ending date. See the chart on the opposite
page.

Area
Choose an Area from the drop-down list if you want only the
history for a specific area generated or choose ALL for a full
system history report.

Panel
Choose a name from the Panel drop-down list if you want only
the history for a specific panel generated, or choose ALL for a
full system history report.
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Enabling the Daily Option
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Transaction Types
All transaction types are included by default. You can enable or
disable Card, Point, Guard, Operator, and System
Transactions for inclusion in the history report.

If  you select transaction types, use the three buttons at the lower
right hand corner of  the dialog box (Card..., Point..., &
Operator...) to select transaction criteria.

The operator’s alarm acknowledgment information is
automatically included when either the Card Transaction or the
Point Transaction options are enabled.

From Archives
History reports can be generated from archived history. By
enabling the From Archives option in the History Selection
Criteria box, another dialog box (next illustration) will appear
when you click OK, prompting you to select which archive file
you would like to run the report on.

NOTE: Remember that the date of the archived file does NOT include
transactions for that particular day. For example, the file
19981101.DBF does not include or contain transactions for
November  1, 1998. See Chapter 7 for more information.
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Archive files are named by the date from which they were
archived. For example, if  the date selected in the archive
procedure was November 1, 1998, then the file would be called
19981101.DBF. Select the archive file you want to report on
and click OK.

Remember that the date range must reflect dates included in the
archived file, otherwise you will not get the desired results.
Leave the date range empty to report on all dates in the archived
file. Further, the Daily option can be used to report on a time
range for each of  those days.

Card...

Click Card... to select the card information you want included in
the report. The first four fields allow you to narrow your search
by first name, last name, card number, or reader.

NOTE: ALL criteria must be met for data to appear on the report.

First Name
Enter a first name to narrow your search. For example, entering



Reports 309309309309309

Reports

Jim reports on all card holders with the first name Jim. This field
is case sensitive and must be typed in as it appears in the card
database.

Last Name
Enter a last name to narrow your search. For example, entering
Smith reports on all card holders with the last name Smith. This
field is case sensitive and must be typed in as it appears in the card
database.

Card Number
Enter a specific card number that you want to report on.

Reader
Enter a specific reader that you want to report on. This field is
case sensitive and must be typed in as it appears in the Reader
Screen of the Panel Database.

Note Ranges
WIN-PAK lets you specify reports using criteria for up to three
of  the 25 note fields. Select a note field from the drop-down list.
Then select the beginning and ending (alphabetically) criteria for
the range. Beginning partial criteria is acceptable for these fields.
For example, to you wanted to generate a report for departments
that begin with letters A through F:

1. From the drop-down list, select the note number that you
defined as Department. (See Note Fields under the Setup menu)

2. Type the letter A in the first text entry space and F in the second
text entry space.

The report is generated for all departments from A through F
including Accounting, Distribution, Financing, etc. This can be done
for up to three note fields.
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Card Codes
Enable the card read statuses that you want included in the
reported or leave them all disabled to report on them all.

NOTE: When enabling the Actioned Only option in the Card Codes section,
only card transactions that have operator notes assigned to them are
printed.

Point...

Clicking the Point... button will bring up a dialog box
(illustration below) to enter selection criteria pertaining to alarm
point information.

Alarm Point
Enter a specific alarm point that you want to report history on.
This field is case sensitive and must be typed in as it appears in
the Input Point Screen of  the Panel Database. Leaving this
blank reports on all alarm points.

Alarm States
Enable the alarm states that you want reported on for alarms or
leave them all disabled to report on them all.
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Operator...

Clicking the Operator... button will bring up a dialog box
(illustration below) to enter selection criteria pertaining to a
particular operator.

Operator
Enter an operator that you want to view transactions for. This
field is case sensitive and must be typed in as it appears in the
operator database. Leaving this blank will include transactions
from all operators.

Operator Transactions
Enable the operator transactions that you want included in the
report or leave them all disabled to report them all.

Acknowledged Transactions shows transactions that have been
acknowledged and the time.

Database Record Modifications shows any editing of  databases.

Other Operator Activities includes login, logout, alarm
acknowledgment and clearing.
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Generating Database Reports

WIN-PAK can generate a report for any of  its databases. Select
Database Reports from the Reports menu to see a list of
databases. Selecting a database from this list will either generate
a report automatically or prompt you for selection criteria,
depending upon the database.

Databases that prompt you for more than one set of criteria will
report only those records that meet all of your selection
requirements.

Timezone Report
1. Select Timezones from the Database Reports list. The Timezone

Selection Criteria dialog box opens.

2. Define the report range by entering starting and ending criteria
for an alphabetical list of  timezones. Enter the timezone name
(or a partial name) in these two boxes. To report on all
timezones, leave these fields empty.
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A sample Timezone Report shows the timezone name, start
time, end time, days of the week included, and whether holidays
are included.

Areas Report
Select Areas from the Database Reports list. A sample report is
shown below. It includes the area name, port, baud rate, and area
type.

Ports in the Area Report are numbered as follows:

1 = Com Port 1 (Multiport or COM1)
2 = Com Port 2 (Multiport or COM2)
3 = Com Port 3 (Multiport only) and so on...
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Panel Report
1. Select Panels from the Database Reports list. The Panel

Selection Criteria dialog box opens.

2. Define the panel report range by entering a 10-digit panel ID
number in the From field and in the to field. This generates a
numerical list of  panels.  For example, enter From: 0000000001
to 0000000001 to get a report on Panel 1. Panels with the same
Panel ID from other areas are also included in the report.

3. Define the panel report range by entering a panel name (or first
letters of  a name) in the From and to fields. This generates an
alphabetical list of  panels.

4. Define the report range by entering an area name (or the first
letters of  a name) in the From and to fields. This generates an
alphabetical list of  panels for the selected areas.

A sample report is shown on the facing page. It includes the
panel ID, panel name, area name, panel type, version, number of
card digits, hardware and programming options enabled, readers
enabled, timezones included, and inputs, outputs, and groups
defined. It also shows information on interlocks, pulse time, and
shunt time.
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ReportsSchedules Report
Select Schedules from the Database Report list. A sample report
is shown below. It includes the schedule name, type, frequency and
the next scheduled date and time.
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Guard Tour Report
1. Select Guard Tours from the Database Report list. The Guard

Tour Selection Criteria dialog box opens.

2. Define a report range by entering a guard tour name (or the first
letters of  a name) in the From and to fields. This generates an
alphabetical list of  Guard Tours. Or leave the fields empty to
generate a list of  all Guard Tours defined in the database.

A sample report is shown below. It includes the Guard Tour
name(s), stop number(s), check point name(s), and time(s). It
also gives a tolerance value for the check in times.
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Tracking Area Report
1. Select Tracking Areas...  from Database Reports. The Tracking

Area Selection Criteria dialog box opens.

2. Define a report range by entering a tracking area name (or the
first letters of  a name) in the From and to fields. This generates
an alphabetical list of  Tracking Areas. Or leave the fields empty
to generate a list of  all Tracking Areas.

3. Use the drop down list to choose the type of area you want
listed or select ALL.

4. Use the drop down box to choose the sort order. The report
information can be sorted either by the name of  the tracking
area or by type of area.

A sample report is shown below. It includes the tracking area
name(s), area type(s), and reader name(s).
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Access Level Report
1. Select Access Levels from the Database Reports list. The

Access Level Selection Criteria dialog box opens.

2. Define a report range by entering an access level name (or the
first letters of  a name) in the From and to fields. This generates
an alphabetical list of  Access Levels. Or leave the fields empty
to generate a list of  all Access Levels.

A sample report is shown below. It includes the access level
name(s), reader name(s), timezone name(s), and group name(s).
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Card Report
1. Select Cards from the Database Reports list. A submenu opens

with the choice of Cards or Cards & Notes.

2. To generate a Card Report without notes, select Cards... The
Card Selection Criteria dialog box opens.

3. Define a report range by entering a card holder name (or the first
letters of  a name) in the From and to fields. This generates an
alphabetical list of  Card Holders. Or leave the fields empty to
generate a list of  all Card Holders.

NOTE: Using Name Range from A to C includes all the card holders with last
names beginning with A and B. Names that begin with C are not
included.
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4. Define a report range by entering a card number in the From
and to fields. This generates a list of  cards by number.

5. From the Access Level drop-down list, select an Access Level to
narrow the report or choose All.

6. Select the preferred sort order. Card reports can be sorted by
either the card number or card holder name.

A sample report is shown below. It includes last name, first
name, card number, expiration date, access level, if the card
uses a PIN and indicates if there is a photo on the card.

Card Report with Notes
1. Select Cards from the Database Reports list. A submenu opens

with the choice of Cards or Cards & Notes.

2. To generate a Card Report with notes, select Cards & Notes.
The Card Selection Criteria dialog box opens (next illustration).
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3. Define a report range by entering a card holder name (or the first
letters of  a name) in the From and to fields. This generates an
alphabetical list of  Card Holders. Or leave the fields empty to
generate a list of  all Card Holders.

4. Define a report range by entering a card number in the From
and to fields. This generates a list of  cards by number.

5. From the Access Level drop-down list, select an Access Level to
narrow the report or choose All.

6. Select the preferred sort order. Card reports can be sorted by
either the card number or card holder name.

7. Define a report range by entering the names (or first letters of
the names) of  up to three note fields in the From and to fields.
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8. Enable the Print Valid and Invalid Detail option to include the
valid and invalid card detail information in the report. This
includes the type of  read (normal, timezone error, not found,
etc...), priority, and message.

A sample report is shown below. It includes last name, first
name, card number, access level, all note fields, and valid/
invalid read details (if selected).

To Generate a Camera Report:
Select Cameras from the Database Reports list. A sample report
is shown below. It includes the camera ID, name, and title.
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Holiday Report
Select Holidays from the Database Report  list. A sample report
is shown below. It includes the holiday name and date.

To Generate a Monitor Report:
Select Monitors from the Database Reports list. A sample report
is shown below. It includes the monitor ID and name.
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Command File Report
1. Select Command File from the Database Reports list. The

Command File Selection Criteria dialog box opens.

2. Define a report range by entering a  command file name (or first
letters of  a name) in the From and to fields.  This generates an
alphabetical list of  command files.

A sample file is shown below. It includes the command file
name, area name, and the commands in the file.

To Generate An Attendance Report:
An attendance report answers the questions:

• How long was a card holder in an area of the
building?

• How long was a group of card holders in an
area of the building?

To generate these reports, select Attendance… from the
Reports menu, the Attendance Selection Criteria dialog
box opens (next illustration).
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NOTE: A card presented at a reader outside of a Tracking Area, removes it
from that Tracking Area and prohibits it from being reported in the
Attendance Report.

To determine how long a particular card holder was in
an area:

1. Select a specific Tracking Area or use the default value of  ALL
Tracking Areas in the building.

2. Enter the card holder information. Either enter the card number
or last and first name in the text entry spaces provided. Or
simply click the Cards… button to browse the card database to
find the desired card.

3. Optionally, enter the time interval. If  not specified, the entire
time span of the history database is used.

4. Click OK for a report on the time range.
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To determine how long a group of card holders was in
an area:

Method 1
Select the Tracking Area. Then Select an Access Level that
includes all of  the card holders.

Optionally, enter the time interval as above.

Method 2
Select the Tracking Area. Then select a “Note Field” and enter
the exact value to which all of  the card holders belong.

Optionally, enter the time interval as above.

The report uses the current history database records to
extrapolate the attendance information requested.

The report displays how long a card holder was in an area via
the Elapsed Time field.  This value represents the number of
hours and minutes. If  no Exit Time found, the elapsed time is
based on the current date and time.
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In the process of maintaining your access control system, your
data should be carefully and systematically managed to prevent
loss of  information. WIN-PAK provides tools for keeping your
data clean and safe. The following sections cover how to
maintain your files using Archive, Purge, Backup, Restore, and
the Rebuild functions.

NOTE: Maintenance functions in a WIN-PAK network can only be performed
from the WIN-PAK server. WIN-PAK clients will also have to be logged
out when maintenance functions are performed.

Archiving

Archiving refers to moving a range of history records to a
separate file. Normally, this would be done with history that
doesn't need to be viewed regularly. Although these records will
still be accessible, they will not be searched when running a
History Report unless specified. This speeds up the history
report process by eliminating old transactions.

NOTE: It is up to the user to determine how often to perform the archive
operation. It depends on how much data the user needs immediate
access to.

Archiving is done by selecting Archive... from the File menu.
This will open a calendar dialog prompting you to enter a date.
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Click the arrow buttons to move forward or back one month at a
time, then click the exact date that you want WIN-PAK to
archive PRIOR TO (not including the date). Then click Archive
to continue or Cancel to abort the operation.

Serial communications must be halted, so you will be prompted
to buffer your panels. If  you choose not to buffer your panels,
then any incoming transactions will be lost. If you choose to
buffer the panels and if some panels are already buffered,
WIN-PAK will unbuffer all connected panels. You will have to
rebuffer these panels manually. If  you are using N-485 with
ACK/NAK, you will not need to buffer the panels, as the ACK
/NAK will make sure that transactions are not lost.

If history was archived through January 1, 2002 as shown
above, then an archive file containing history PRIOR TO
January 1st would be created named 20020101.DBF. All history
information PREVIOUS to January 1st would then be purged
(deleted) from the main history file. The archived information
would then only be retrievable by enabling From archive in the
History Selection Criteria dialog when generating a history
report, and selecting the 20020101.DBF file.

NOTE: In this example, the transactions from 01/01/02 WILL NOT be in the
archived file.
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Purging

Purging refers to removing records from the active WIN-PAK
history (not archived). This is for deleting history that will never
need to be accessed again.

To delete records, select Purge... from the File menu. This will
open a calendar dialog prompting you to enter a date.

Click the arrow buttons to move forward and back one month at
a time, then click the exact date that will define the first date
after the time range you want WIN-PAK to purge. Click Purge
to continue or Cancel to abort the operation.

Serial communications must be halted, so you will be prompted
to buffer your panels.

NOTE: When completed, your history records prior to the date you selected
will be removed.
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Backing Up WIN-PAK Files

An important part of keeping data safe is backing up files on a
regular basis. WIN-PAK allows you to do a backup of  your
databases (and indexes) to a separate sub-directory.

CAUTION: NEVER DO A BACKUP WHEN YOU THINK A DATABASE IS
CORRUPTED! First copy the databases to another backup
subdirectory. Then rebuild the databases using the Repair function.

A backup will save your WIN-PAK database (and index) files to
a separate subdirectory. This is useful if  one or more of  your
databases becomes corrupt. It will not protect your data or
system, however, from hardware failures, so it is important to
conduct regularly scheduled complete backups to some form of
removable media (floppy disks, tapes, etc..) in addition to
WIN-PAK backups. To perform a backup operation:

1. Select Backup from the File Menu. The backup operation will
verify that all clients are logged out and disable new client
logins.

NOTE: The Backup operation requires exclusive use of the databases.

2. You will be prompted to buffer panels. Click Yes if  you want to
buffer panels or No if you do not. If you choose not to buffer
your panels, then any incoming transactions will be lost. If you
choose to buffer the panels and if some panels are already
buffered, WIN-PAK will unbuffer all connected panels. You will
have to rebuffer these panels manually. If  you are using N-485
with ACK/NAK, you will not need to buffer the panels, as the
ACK/NAK will make sure that transactions are not lost.

The Backup operation shuts down communications (closes
databases) and copies all database files (PK*.DBF and
PK*.MDX) and archived history files from the WIN-PAK
database directory (usually C:\WINPAK\DATABASE) to the
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backup subdirectory ( usually C:\WINPAK\DATABASE
\BACKUP). If  the BACKUP sub directory doesn’t exist,
WIN-PAK creates it. The Backup operation finishes by
restarting communications, unbuffering panels, and enabling
client logins. Databases can now be copied from BACKUP
subdirectory to tape or other backup media.

NOTE: Images, badges, and signatures are not backed up through the
backup procedure. These files are found in the C:\WINPAK\DATA
subdirectory and should be backed up to a tape or other storage
media.

Restoration from a Backup

If you are experiencing database difficulties or data loss in
WIN-PAK that rebuilding will not correct, you can restore your
databases from the last backup. Any data entered since the last
backup will need to be re-entered. To restore from a backup:

1. Restore your most recently backed up files from your backup
media to the C:\WINPAK\DATABASE\BACKUP directory.
Images, badges, and signatures should be copied to the
C:\WINPAK\DATA directory.

History transactions are also stored in a database file. Therefore, a
restore will overwrite the "current" history.

2. Select Restore from the File menu. The restore operation will
verify that all clients are logged out and disable new client logins

NOTE: Restore requires exclusive use of the databases.

IMPORTANT: To keep images and the Card Database in sync, the backup and
restore functions should be done for both sets of information at the
same time.
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4. You will be prompted to buffer panels. Click Yes if  you want to
buffer panels or No if you do not. If you choose not to buffer
your panels, then any incoming transactions will be lost. If you
choose to buffer the panels and if some panels are already
buffered, WIN-PAK will unbuffer all connected panels. You will
have to rebuffer these panels manually. If  you are using N-485
with ACK/NAK, you will not need to buffer the panels, as the
ACK/NAK will make sure that transactions are not lost.

The restore operation then shuts down communications (closes
databases) and copies all database files (PK*.DBF and
PK*.MDX) and archived history files from the backup
subdirectory (usually C:\WINPAK\DATABASE\BACKUP) to
the WIN-PAK database directory (usually C:\WINPAK
\DATABASE). The operation finishes by restarting
communications, unbuffering panels, and enabling client logins.

Rebuilding Databases

Databases can become corrupt when there is a power outage or
if  WIN-PAK is exited improperly. This corruption can cause
databases to lose data or act irregularly. It is important that
operators know the correct procedure for exiting both
WIN-PAK and Windows.

NOTE: Clients MUST be logged off to use any rebuilding functions.

WIN-PAK provides the ability to maintain and repair databases
using the Create, Pack, Reindex, and Repair functions. All of
these can be accessed by selecting Rebuild... from the File
menu. A large dialog (next illustration) box will open with a
matrix that contains Databases on the side and functions along
the top.
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Select the operations that you want to perform in the row of  the
database(s) on which you want them performed.

Create

WARNING: The Create function erase database records.

Select the Create function if you want to recreate the database
from scratch. When this operation is performed, the existing
records in the database are overwritten. Databases that relate to
others can cause programming problems if  deleted. For example,
if the Timezone Database was recreated, all timezones used in
the Panel and Access Level databases would be out of sync
because the link would no longer be available.

CAUTION: Exercise caution when assigning an operator the Create right. It is
possible to be locked out of the software, if an operator inadvertently
recreates the operator database and assigns new passwords.
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Pack
Databases keep track of records even when they have been
deleted. This is why records continue to appear “grayed” in the
Data List. Packing the database purges these deleted records
and make your system run more efficiently.

Reindex
The Reindex function deletes the indexes of the database and
rebuilds them.

Repair
The Repair function looks for records that are corrupt and strips
them out of the database. It then reindexes and rebuilds the
integrity table. This can take a while depending upon the size of
the databases.
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Pelco CM9750 Camera Support

WIN-PAK 1.17 supports the Pelco CM9750 camera switcher.

Operation Disk

Use the Pelco Installer to create an operation disk, which is necessary to
boot-up the 9750 controller. Refer to the Pelco System CM9750
Programming Manual for instructions on creating an operation disk. When
creating the operation disk, note the following points:

• Program all cameras and monitors that are to be used on the
Matrix Bay.

• Program all communication ports.

• The WIN-PAK default baud rate for the ASCII
communication port is 4800.

• The ASCII port may need to be special ordered from Pelco.

Required Hardware

CM9750 Controller
The CM9750 controller sends commands to the appropriate  devices. The
controller is initialized by an operation disk, which sets all equipment
parameters.

CM9750 VMM Video Output Module
The CM9750 VMM video output module is a Matrix Bay monitor and
camera output device.
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9750 RCV/DRV Receiver Driver
The 9750 RCV/DRV receiver driver controls a pan/tilt camera.

Null Modem Adapter
The null modem adapter provides the ASCII communication
port and the WIN-PAK computer cable (serial cable 25-9 or 9-
9). If a multiport board is used, use the null modem adapter
with the provided connector(s).

WIN-PAK Capabilities

• Pan/Tilt (up/down, left/right)

• Camera to monitor switching

• Focus (near and far)

• Iris (open and close)

• Zoom (telephoto and wide)

Functions Not Supported

• Send titles: This series of Pelco equipment does not allow
titles to be sent.

• Macros: Macros cannot be sent by WIN-PAK when Pelco is
selected for a CCTV loop.

• Set limits: Preset position limits are not supported by this
series of Pelco equipment.
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WIN-PAK Setup

1. Set the baud rate to 4800 in the Area and Serial Port setup.

2. Select CCTV for the Area loop.

3. Select Pelco for the Area name.

4. Set the following parameters:

• Parity: Even

• Data bits: 8

• Stop bits: 1

5. Program the camera and monitor to match the programming of
the operation disk. Only cameras and monitors programmed on
the operation disk can be controlled by WIN-PAK.

NOTE: Refer to the Pelco System CM9750 Programming Manual for
additional information.
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Commands Supported by WIN-PAK 1.17
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FlashPoint Video Capture Card Settings

Settings for the FlashPoint 3D Capture Card (PBVC10) include:
• Preview Brightness, Preview Contrast
• Capture Brightness, Capture Contrast

These setup controls allow different settings for previewing the
video image and capturing it. The image seen in the Preview
mode can be brightened electronically. When the flash is tripped,
the amount of  light entering the camera’s iris is reduced
compared to the preview, allowing the flash to provide enough
light to saturate the subject without over exposing the picture.

NOTE: Note that the Preview brightness setting is higher than the Capture
brightness setting. You must adjust these settings for your specific
lighting conditions.
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To function properly, changes need to be made in the FlashPoint
FPG program setup. Below are sample settings that can be used.

To Change the Grab Settings

1. Click the Windows Start button, Program menu, FlashPoint,
FPG.

2. Click Setup, and then click Grab. Start with these values:
• Brightness 25
• Contrast 23
• Field 2
• Align Odd
• Type Universal

3. Test the flash sync by clicking Grab on the menu bar (the
camera and flash devices must be connected and working
properly).  If a flash occurs but does not illuminate the subject
(out of sync), try changing the value of the Field setting by a
unit of 1.

4. Repeat the flash test after each change in the field value.
Generally, an acceptable field value will be between 0 and 5.

5. If the sync still doesn’t work, change the Align feature to a
different setting (try Even first and then, lastly, Any).

6. After changing the Align setting, repeat the field test, changing
the field value 1 unit at a time.

Field Rep Setting
The Field Rep needs to be enabled with standard (field capture)
cameras. The PBCAM10 camera supplied by Northern
Computers is a field capture type of camera. If you are using a
frame capture type camera, you do not need to use the Field Rep
in your setup.
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To Enable the Field Rep Setting
1. Click Tools, Configuration.

2. Check the Field Rep box to enable this option. When Field Rep
is enabled, both video fields from the camera are illuminated by
the flash. If it is not enabled, a striping effect results because the
second field is not illuminated by the flash. With Field Rep
enabled, you may notice a reduction in the resolution of the
picture.

3. For further information, refer to the video capture card manual.

TWAIN Interface Flash Method

An alternate method of  using the Flash option with WIN-PAK
1.17 is to utilize the TWAIN interface of  the capture card. The
TWAIN Interface provides a number of  advantages:

• Captures the full camera view.

• Crops the image after the picture is captured.

• With a field camera, the resolution can be reduced by half,
without reducing the apparent resolution of the captured
picture. When properly setup, it is not necessarry to use the
Field Rep setting, which gives the appearance of more
resolution.

To Setup a TWAIN Interface for Flash
1. Select the TWAIN interface during WIN-PAK installation. The

settings for a TWAIN interface are similar to those just
described, except there are no separate capture or preview
brightness/contrast settings.
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2. Use the sample settings shown here as a starting point for your
TWAIN setup. Test the settings and then adjust them as
necessary for your system.

3. If a frame capture camera is used or if flash is not being utilized,
the width and height settings should be set to the maximum
settings.
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Interlocking

The interlocking feature allows an input point or output point to
take a specified action based upon another input point or output
point changing state.  In an interlock sequence, an action on one
point causes a reaction from a second point.

Interlocks initiated with an input point change of state are
defined in the Input screen of the Panel Database.

Interlocks initiated with an output point change of state are
defined in the Output screen of the Panel Database.

NOTE: A group is considered an output. Input to Output could be an input
interlocked to an output group. Output to Output could be an output
interlocked to a group or one group interlocked to another.

In either screen, click the box labeled Interlocking to enable the
interlocking section.
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Select Input to Output or Input to Input from the Input Point
screen to define the interlock type when initiating from an input
point change of state.

Input to Output
When an input is interlocked to an output, a change of state on
the input causes the output to react.

Input to Input
When input A is interlocked to input B, a change of state on
input A causes input B to react.

OR
Select Output to Output or Output to Input from the Output
Point screen to define the interlock type when initiating from an
output point change of state.

Output to Input
When an output is interlocked to an input, a change of state on
the output causes the input to react.

Output to Output
When output A is interlocked to output B, a change of  state on
output A causes output B to react.

The parameters that must be specified in an interlock sequence
are shown below:

Component A:
Specify an input or output to initiate the interlock sequence.  A
change of state on Component A causes a reaction from
Component B.
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Component B:
Specify an input or output to react upon a change of state on
Component A.

Action 1:
Specify the action for Component B to take when Component A
goes into an alarm state (input) or energized state (output).

Action 2:
Specify the action for Component B to take when Component A
returns to a normal state (input) or de-energized state (output).

A diagram of where these parameters are found in the Panel
database is shown on the following page. The top screen
illustrates an interlocking scheme for a free egress situation for
door address 1.

The following actions are available for the Action 1 and
Action 2:
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Component A
Specify an input or
output to initiate the
interlock sequence. A
change of state on
Component A causes
a reaction from Com-
ponent B.

Component B
Specify an input or
output to react upon a
change of state on
Component A.

Action 1
Specify the action for
Component B to take
when Component A goes
into an alarm state (input)
or energized state
(output).

Action 2
Specify the action for
Component B to take
when Component A
returns to normal
state (input) or de-
energized state
(output).
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Energize: Applicable only when Component B is an output
point, this action turns the point on.
De-Energize: Applicable only when Component B is an output
point, this action turns the point off.
Shunt: Applicable only when Component B is an input point,
this action shuts off the point.
Un-Shunt: Applicable only when Component B is an input
point, this action reactivates the point.
Pulse: Energizes the output point (or momentarily shunts an
input point) for a set amount of time.
Pulse Off: Turns off  a point currently being pulsed. When relay
is energized, it will Pulse Off and then return to Energized
state. (This is rarely used and must be used in addition to a
command file.)
No Action: No change of state.
Follow: Take the state of  Component A.
Invert Follow: Take the opposite state of  Component A.
When a Follow action is specified for Action 1, No Action must
be specified for Action 2.  A Follow/No Action specification
causes Component B to follow any change of state on
Component A.

Example 1Example 1Example 1Example 1Example 1
Component A: Input #5 (motion detector)
Component B: Output #3 (siren)
Action 1: Energize
Action 2: De-energize

When input #5 goes into alarm state (motion detector
triggered), output #3 energizes (sounding the alarm). When
input #5 returns to normal state, output #3 de-energizes
(turning off the siren).
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Example 2
Component A: Input #6 (door status switch)
Component B: Output #4 (bell)
Action 1: Pulse
Action 2: No Action

When input #6 goes into alarm state (door status switch open
illegally), output #4 pulses for its predetermined pulse time.
The pulse time is set in the Output Point screen in the Panel
Data section of  WIN-PAK.

Example 3
Component A: Input #1 (door strike relay)
Component B: Input #1 (door status switch)
Action 1: Follow
Action 2: No action

When output #1 energizes (upon a valid card read or egress),
input #1 is shunted for the defined shunt time specified in the
panel database.  Input #1 follows the state of output #1.

Example 4
Component A: Input #7 (push button)
Component B: Input #8 (motion detector)
Action 1: Pulse
Action 2: No Action

When input #7 goes into alarm state (push button activated),
input #8 pulses (shunts) for its set shunt time, deactivating the
motion detector.
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Elevator Control

Elevator control is accomplished through the use of the Group
Option, which allows activation of a combination of output
points upon a valid card read. The N-1000-II/N-800 output
points are used to enable the operation of the floor select
buttons of  the elevator controller. Normally-open floor select
buttons should be wired in series through the normally-open
side of  the N-1000-II/ N-800 relays. This configuration is
shown is shown below.
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In normal operation, when a valid card is read, the group of
output points assigned to the card change state, enabling the
appropriate floor select buttons. The user then makes a floor
selection.

Group definitions and pulse times are programmed in the Panel
Database. The groups are then assigned to access levels in the
Access Level Database. The access levels are then assigned to
cards in the Card Database.

Example
Given: Jim Johnson (card #22435) needs access to all eight
floors. Jane Doe (card #17732) needs access to floors 1-4 only.

NOTE: Addresses indicated by 1xx are groups.

1: Create a panel in the Panel Database where the Group Option is
enabled.  

The Groups tab will now be accessible.

2: In the Output Points Screen, make all output points that you
want to include in your group “Active”. In this example, activate
outputs 1 through 8 to represent the 8 floors.
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3: From the Groups Screen (next illustration), make Group #1
“Active” and select output points 1-8 to include all 8 floors.
Make Group #2 “Active” and select as output points 1-4 to
include only the first 4 floors.

  

4: Return to the Output Points Screen and scroll down to the
bottom of  the Output Points list to view groups. Groups have  a
“G” in the name and have an address greater than 100. Select
Group #1 and assign it a pulse time of  10 seconds. The pulse
time is the amount of time that the card holder will have to
select a floor after presenting the card. Do the same for Group
#2.

5: Define Access Levels for Jim Johnson (All Eight Level) and Jane
Doe (Only Four Level), in the Access Level Database, as
shown:
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6: Assign the access levels to the cards, in the Card Database, as
shown:

 

When Jim Johnson presents card #22435, output points #1-8
pulse for 10 seconds, allowing selection of floors 1-8. When
Jane Doe presents card #17732, output points #1-4 pulse for 10
seconds, allowing selection of floors 1-4.
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FBD.SNOITCA snoitcAkcolretnI .xirtamsnoitcAkcolretnIehtsniatnoC

FBD.NIAMLAKP niaMleveLsseccA
eliF

DIdnasemaNleveLsseccAehtsniatnoC
srebmun

FBD.KLDRLAKP redaeRleveLsseccA
pukooL

sseccAneewtebpihsnoitalerM:1ehtsniatnoC
LA1eblliwerehT(sredaeRlenaPdnaDIleveL

)sredaeRMotDI

FBD.PUKLMAKP egasseMnoitcA
pukooLredaeR

lenaPneewtebpihsnoitalerehtsniatnoC
sdraCdna,segasseMnoitcA,stupnI/sredaeR

FBD.NIAMRAKP eliFniaMaerA aeranasenifedtahtnoitamrofniehtsniatnoC
DIAERAdnaEMANAERA,troPsahcus

FBD.NIAMACKP eliFniaMaremaC sdIdnasemanaremaCsniatnoC

FBD.NIAMDCKP esabataDniaMdraC DILAsallewsaataddracehtsniatnoC

FBD.KLTNDCKP eliFsetoNdraC sdleifetondracsniatnoC

FBD.KLMCFCKP pukoolelifdnammoC ahtiwdetaicossasdnammocehtsniatnoC
elifdnammoc

FBD.NIAMFCKP eliFniaMdnammoC &aerA,emandnammocehtsniatnoC
DIeliFdnammoC

FBD.CFERKFKP ytirgetnIlaitnerefeR seicnednepedyfingistahtstnuocsniatnoC
eboteraselifnehwdesueratahtselifneewteb

deteled

FBD.TPSHPFKP topStoHnalProolF nalproolfottnenitrepnoitamrofnisniatnoC
stopstoh

FBD.KLSHPFKP topStoHnalProolF
pukooL

stopstohrofnoitamrofnidetaicossasniatnoC

FBD.NIAMPFKP eliFniaMnialProolF elifpamtiBdnaemaN,DInalproolfehtsniatnoC
eman

FBD.NIAMTGKP eliFniaMruoTdrauG noitamrofniDIruoTdrauGsniatnoC

FBD.KLTSTGKP pukoolruoTdrauG pukoolredaerrofevitceridsniatnoC

Database and *.INI FIles
The 35 WIN-PAK System database files are located in the
WINPAK\DATABASE subdirectory:
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FBD.NIAMLHKP eliFniaMyadiloH DIybdecnerefersyadilohfotsilasniatnoC

FBD.NIAMOIKP niaMaerAgnikcarT
esabataD

noitamrofniaeragnikcartniamehtsniatnoC

FBD.KLDROIKP aerAgnikcarT
pukooLredaeR

gnikcartehtrofnoitamrofniredaerehtsniatnoC
esabatadaera

FBD.NIAMSHKP eliFniaMyrotsiH atadelifyortsihtnerrucehtsniatnoC

FBD.NIAMNMKP eliFniaMrotinoM dnaDIfonoitamrofnirotinoMehtsniatnoC
EMAN

FBD.NIAMPOKP eliFniaMrotarepO ,emaN,DI,noitamrofnirotarepOehtsniatnoC
drowssaP

FBD.1LPGNPKP 1spuorGlenaP yrtne1-elifsihtnidedrocereraspuorGniaM
puorgrep

FBD.2LPGNPKP stnioPpuorGlenaP puorgrepyrtne1-spuorgrofelifpukoolstnioP
tniop

FBD.KLAHNPKP erawdraHlenaP
smralA

1-stupnimralaerawdrahlenaprofstnuoccA
tniopmralarepyrtne

FBD.KLNINPKP stnioPtupnIlenaP tupnirepyrtne1-esabatadpukooltnioptupnI

FBD.NIAMNPKP eliFniaMlenaP 1-ofninoitarugifnoclenapniamehtsniatnoC
lenaprepyrtne

FBD.KLTONPKP stnioPtuptuOlenaP repyrtne1-esabatadpukooltnioPtuptuO
tuptuo

FBD.KLDRNPKP redaeRlenaP
pukooL

redaerrepyrtne1-noitamrofniredaeR

FBD.KLCSNPKP edoCetiSlenaP lenaprepyrtne1-sedocetislenapsniatnoC
edocetis

FBD.KLSTNPKP stolSenozemiTlenaP lenaprofsenozemiTotsecnerefersniatnoC
stols

FBD.10000TKP .KAP-NIWYBYLLANRETNIDESUELIFYRAROPMETASISIHT

FBD.NIAMCSKP eliFniaMreludehcS eliFreludehcS

FBD.NIAMZTKP eliFniaMenozemiT DIdnaemanenozemitsniatnoC

FBD.KLGRZTKP segnaRenozemiT repyrtne1-senozemitrofsegnarsniatnoC
egnarenozemit
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WINPAK1.INI File

(found in the WINDOWS directory)

Registration Section
The Registration Section contains registration information as
well as the operator that last logged in successfully.

[Registration]
Administrator=John Doe
Organization=ABC, Inc.
Operator=Vinnie

Network Section
The Network Section details important network information.

[Network]
NodeType=0
NodeType: 0 describes a standalone system,

1 describes a network server,
2 or any other integer describes a network client

Node ID=
Server Name=
The server name can equal the actual machine name of  the
server or the TCP/IP address of  the server. Only used on client
machines.

Control Panel Section
The Control Panel Section contains information on the Main
Control Panel.

[Control Panel]
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Options Section
[Options]
Shutdown Buffer=0
Shutdown Buffer: 0 means default is NOT to put panels int
a buffer mode. 1 means default IS to put panels into a
buffer mode

Database Directory=C:\WINPAK\DATABASE
The directory where WIN-PAK looks for databases. In a
network configuration, this may change depending on what
directory or drive the server is sharing. For example, if  the
server is sharing the root drive (C:\), then the database directory
on the client would be C:\WINPAK\DATABASE. If  the server
is only sharing the WINPAK directory, it would be
C:\DATABASE.

Transaction Buffer Size=1000
The number of uncleared transactions allowed before old data is
deleted.

Note Fields Section
The Note Fields section contains the labels that note fields are
identified by in WIN-PAK. These are set in the Note Fields
section of the Setup menu.

[Note Fields]
Note 1 Desc=Department
Note 2 Desc=Title
Note 3 Desc=Phone #
Note 4 Desc=License Plate #
Note 5 Desc=Note 5
Note 6 Desc=Note 6
Note 7 Desc=Note 7
Note 8 Desc=Note 8
Note 9 Desc=Note 9
Note 10 Desc=Note 10
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Note 11 Desc=Note 11
Note 12 Desc=Note 12
Note 13 Desc=Note 13
Note 14 Desc=Note 14
Note 15 Desc=Note 15
Note 16 Desc=Note 16
Note 17 Desc=Note 17
Note 18 Desc=Note 18
Note 19 Desc=Note 19
Note 20 Desc=Note 20
Note 21 Desc=Note 21
Note 22 Desc=Note 22
Note 23 Desc=Note 23
Note 24 Desc=Note 24
Note 25 Desc=Note 25

Serial Ports Section
The Serial Ports Section contains information that defines the
number of  COM ports and their settings.

[Serial Ports]
Type=0
Type: 0 = COM1 & COM2
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NOTE: The statement: Debug Dump=1 can be added to the Serial Ports
section for troubleshooting what WIN-PAK is sending and how the
panel responds. When entering WIN-PAK it will create a dump file in
C:\WINPAK called RSDUMP01.TXT that can be viewed with a text
editor after exiting WIN-PAK. A new text file is generated every time
you enter WIN-PAK (RSDUMP02.TXT, etc.). Delete the statement, or
change the variable to “Ø” to turn it off when you are done
troubleshooting.

First Port=4
P1Modem=0
P2Modem=0
IRQ=0
P1Use=1
P1BaudRate=1200
P1Init=
P1Phone=
P1Address=0      In general:  0=NO 1=YES
P2Use=1
P2BaudRate=1200
P2Init=
P2Phone=
P2Address=0
Status Port Address=0
retries=10
timeout=120    The maximum number of  seconds between retries. (See “retries” above.)

Printers Section
The Printers section determines the operation of  printers in
WIN-PAK.

[Printers]
Print Alarms=1
Print Alarms: 0 DISABLES the printing of system

responses
1 ENABLES the printing of system
responses
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NOTE: If the line: Beep Alarm=0 is added to the Printers section, you will not
hear the alarms when they come in.

Report Printer=

Server Options Section
The Server Options Section contains information specific to the
server.

[Server Options]
Card Digits=5
Card Digits: 5 means 5-digit programming has been chosen. This
allows card numbers between 1 and 65534 in the card database.
12 means 12-digit programming has been chosen. This allows
card numbers between 1 and 999999999999 in the card
database.

Card Limiting=1
Clear Alarm OK=1
Clear Alarm OK: 0 = Normal only. 1 = Alarm or Normal.

Command File Send=1
Alarm Priorities=50  Priority Threshold
Auto Card Lookup=50  Card Lookup Threshold
Security=13,70,30,90,27,133,117,26,85,25
Log Operator Actions=1
Muster History Init=0    Hours to “Prime”
[Recent File List]
File1=C:\Program File\WINPAK\CONTROL.MTR
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The BADGER.INI File (found in the WINPAK\DATA directory)

Preferences Section
[Preferences]
DataPath=C:\Program Files\Winpak\DATA  Where images are stored.
JPEG Compression=100
Compression setting for images: 100 = least compression, best
quality.   30 = most compression, least quality.

VideoDLL=FLASHPT3D.dll
Video capture device

PrintDLL=FARGO.DLL  Printer used (may not be present if  “Other” was chosen during
installation or a different printer is used).
Inches=1 Default (blank) is in mm
ShowGrid=0
SnapGrid=1
SigPad=PenWare   Present if  Signature Pad was checked during installation.
[Misc]
Parent=WINPAK
[Fargo]
Encode=0
EncodeOnly=0
Duplex=0
RotateBack=1
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Custom Badge Colors

If the colors on the palette don’t meet your specifications for a
background color or for a text color, it is possible to define a
custom color. Clicking Define Custom Colors... from the Color
dialog box extends the box to include a spectrum map.

    

A color can be entered in one of  two ways. The first is by
clicking on an area in the large square spectrum map. This map
measures hue horizontally and saturation vertically. Hue is color.
Saturation is the amount of  gray in the color.

After a color is chosen here, we can then adjust the luminosity
of the color by moving the slider along the bar at the right of
the map. Luminosity is the amount of  black or white that we
add to a color to darken or lighten it.
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Hue/Saturation/Luminosity
This process can also be done by entering specific
numbers for hue, saturation, and luminosity in the
text entry spaces provided. Hue can contain the
values 0 through 239, starting with red and running
through the spectrum of  colors and ending with red.
Saturation can contain the values 0 (gray with no
trace of color) through 240 (the full value of the
color). Luminosity can contain the values 0 (black)
through 240 (white) with the untinted color at about
120.

Red/Green/Blue
Color can also be measured by the three hues used
to create color on the monitor - red, green, and blue.
Simply enter in the values for each of these colors
to produce a combined color.

NOTE: Monitors use red, green, and blue light to create the colors that you
see. Most color printing devices use cyan, magenta, yellow, and
black to create colors. You may need to experiment with printing if
you are trying to match a color exactly. Keep track of either the red/
green/blue values or the hue/saturation/luminosity values when testing
because you cannot save your custom color to the palette.

Color | Solid
The Color  swatch will show you how your color will appear on
the monitor and is a representation of how your color will
appear when printed. Because monitors can only show a certain
number of colors at a time, the colors may be dithered. This
dithering will be on your monitor only - when printed, it will
appear as a solid color.
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The Solid swatch shows the closest solid color your monitor
would pick with its current settings. If  your monitor is set to
display 256 colors, the closest match to the Color swatch from
those colors would be picked. If your monitor can display more
colors, the Solid swatch may match the Color swatch exactly.

If you double-click the Solid swatch, your color will
automatically be changed to that color.

Click OK to change the color of your backdrop or text or click
Cancel to return to the badge without changing the color.
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Setting Up a Network Server

Following the steps in the sections below will assist you in
setting up a WIN-PAK network server.

This guide assumes that the network card and network card
configurations are complete and functional to the manufacturer’s
specifications. It is also based on a first time installation of
WIN-PAK (no existing databases).

NOTE: WIN-PAK requires the TCP/IP protocol to function properly.

Server WIN-PAK INSTALLATION

1. Insert WIN-PAK installation CD. It will automatically launch
the installation program. If the program does not launch
automatically, launch it manually: From the Windows Start
menu, click Run. Then type D:\Demo32.exe (where D is the CD
drive) then click OK.

2. Click Install Software.

3. Click Install WIN-PAK 1.17

4. Click OK to the Northern Computers' WIN-PAK Setup
window.

5. Click OK to the Northern Computers' WIN-PAK Setup
window.

6. Select Server and click OK.

7. Select appropriate answer to video capture card option.

8. Select appropriate answer to badge printer if used.

9. Select appropriate answer to Signature Capture option.

10. Click OK to Select WIN-PAK Directory.
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11. Enter registration information for the user and company.

12. Select No to Alarm Printing and click OK. Installation begins
and several files are copied.

13. Click OK to the final Northern Computers' WIN-PAK
Setup.

14. Click OK to restart the computer. WIN-PAK will restart
Windows for you.

NOTE: WIN-PAK may require the computer to be rebooted (exit Windows,
turn the computer off for a few seconds, turn it back on, and re-enter
Windows).

Setting WIN-PAK Server for Sharing

If  you are going to have a WIN-PAK client on the network that
requires access to reports, you will need to share a folder on the
WIN-PAK Server PC. You will only need Read permissions to
the WIN-PAK/DATABASE folder, where the reports (rpt files)
are stored.

If you are going to do video-badging image capture from a
client, you will need to share the WIN-PAK/DATA folder with
Change permission enabled.
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Connecting WIN-PAK Clients to the
WIN-PAK Server

1. While WIN-PAK is running at the server, start WIN-PAK at the
client.

2. When the client comes online, the client’s name appears in the
Alarm Monitor History View as a logon and in the Mail
Screen as a User.

Shutting off WIN-PAK Server

1. Verify that all WIN-PAK clients are logged off.

2. At the Server, select Exit from the File menu.

3. Select the Shutdown option with or without buffering as
needed.

4. Click Shut Down.
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Setting Up a Network Client

This guide assumes that the network card and network card
configurations are complete and functional to the manufacturer’s
specifications and that the WIN-PAK Server database is
accessible on the network.

NOTE: WIN-PAK requires the TCP/IP protocol to function properly.

NOTE: Before proceeding with installation, verify whether reporting will be
necessary from the client.

If you will need to access reports from the client station, then
the WIN-PAK/DATABASE directory should have already been
shared with at least Read permissions. The Client PC requires
one of  following: 1) You either map a drive to the shared
directory on the WIN-PAK Server, or 2) you add the network
path during the installation on the client, for example:
\\WINPAKSERVER\WIN-PAK\DATABASE, as indicated
below.
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Client WIN-PAK Installation

1. Insert WIN-PAK installation CD. It will automatically launch
the installation program. If the program does not automatically
launch, launch it manually: From the Windows Start menu, click
Run. Type D:\Demo32.exe (where D is the CD drive) then click
OK.

2. Click Install Software.

3. Click Install WIN-PAK 1.17

4. Click OK to the Northern Computers' WIN-PAK Setup
window.

5. Select Client and click OK.

6. Select appropriate answer to video capture card option.

7. Select appropriate answer to badge printer if used.

8. Select appropriate answer to Signature Capture option.

9. Click OK to Select WIN-PAK Directory.

10. Select the drive (mapped WIN-PAK server drive) from the drop-
down list, or type in the appropriate network path.

11. Enter registration information for the user and company.

12. For Server Name: type in WINPAKSERVER (name of  server
machine) and click OK or IP address (used mostly for dial-up
networks).
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13. Enter 2 (3,4,5... if more than 1 client is used) for the Client ID:
and click OK. This must be numeric (no alphabetical
characters).

14. Select the drive (mapped WIN-PAK server drive) from the drop-
down list where the images will be located, or type in the
appropriate network path.

15. Select No to Alarm printing and click OK. Installation will begin
and several files will be copied.

16. Click OK to the final Northern Computers' WIN-PAK
Setup.

17. Click OK to restart the computer in the Install window. WIN-
PAK may restart Windows for you. If  so, remember to log in
using the SYSTEM operator and startup for the password.
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Ultra Electronics Tango Printer Setup for
Magnetic Stripe Encoding

NOTE: The following illustrations are Windows XP illustrations.

There are printer driver setup requirements for magnetic stripe
encoding when using an Ultra Electronics Tango printer for
magnetic encoding.

1. From within the printer section on your operating system, open
the properties area to adjust the printer driver configuration and
make changes in the Device Settings tab.

2. Press the Properties button to bring up the Encoder settings
dialog box (next illustration).
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3. Click the Advanced Settings button to bring up the advanced
encoder settings dialog (next illustration).

4. Click the Set User Specify button to enable WIN-PAK software
to control of  the encoded information which is sent to each of
the three tracks. All three tracks will be affected.

5. Select either High Coercivity or Low Coercivity to match the
type of card used.

NOTE: The remaining encoder settings do not necessarily have to be
changed.

6. Click OK to save all settings.
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SETUP WORKSHEET

Field # Field #

Note 1 Note 14

Note 2 Note 15

Note 3 Note 16

Note 4 Note 17

Note 5 Note 18

Note 6 Note 19

Note 7 Note 20

Note 8 Note 21

Note 9 Note 22

Note 10 Note 23

Note 11 Note 24

Note 12 Note 25

Note 13

Field Name Label Field Name Label

(Note Fields) 1 PER SYSTEM (Setup Worksheet 3 of 3)
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TIMEZONE WORKSHEET 1 TIMEZONE GROUP PER PAGE

Timezone Name:

HoSuSaFrThWeTuMoEnd TimeStart Time

Note:
Remember that you cannot cross midnight.
One line should be used to define the P.M.
ending time, and the next line should
define the A.M. time.

Denoting Time in WIN-PAK
Time in WIN-PAK is always displayed in what we consider a normal time format (i.e. 1:30 p.m., 7:00
p.m., etc.). However, time can be ENTERED in two ways, normal time format or 24-hour time format.
To enter a time in normal format, simply type in the time: 1:35 am (it is important that you use a space
to separate the time and am/pm).

WIN-PAK also accepts 24-hour time input, if you fail to include an am/pm distinction, the program
will assume am. To enter a time in 24 hour format, simply type in the time: 13:35 (it is important that
you use a colon to separate hours and minutes. Your entry will be displayed in normal time when you
hit enter.
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AREAS WORKSHEET

Area Name:

Password::

Loop

Local

C-100
485
485 ACK-NAK

Other

TYPE:

STYLE:

COMMUNICATIONS:

Camera Control

Parity:COM Port:

Data Bits:Baud Rate:

Stop Bits:

Phone:

Remote

CCTV Brand

Unknown

HUB SETUP

Number of Redial Attempts: ____

Pause Between Calls: ____ sec

Wait Time Before Disconnect: ____ sec

Modem Initialize: ____________

Dial Command Prefix: ____________

Call In Option: On invalid transaction Never

Verify Communications

1 AREA PER PAGE

Site ID:
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PANEL WORKSHEET

Panel Name:

Loop (Area):

Command File:

Site Codes

System Hardware Alarms (all versions)

Hardware Options

Antipassback

Forgiveness

Free Egress

Split Timezones
(version 8.xx firmware only)

Keypads

PIN Numbers

Reverse Reader LEDs

AEP-5

ERB

AEP-3

AEP-3

Continuous Card Reads

Groups

Type: Version:

Panel Address:

1 PANEL PER PAGE (1 of 7 Panel Worksheets)

Panel Communications

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

AUX Port

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Panel Primary Power

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.
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PANEL WORKSHEET 1 PANEL PER PAGE (2 of 7 Panel Worksheets)

System Hardware Alarms (cont.)

Tamper Switch (N-1000-III & N-1000-IV only)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Ground Fault (N-1000-III & N-1000-IV only)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Low Voltage (N-1000-III & N-1000-IV only)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

External 5 Volt (N-1000-III & N-1000-IV only)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Panel Reset (Available with version 8.2 firmware)(and later)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Poll Response

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.



408408408408408 WIN-PAK 1.17 User Manual

PANEL WORKSHEET 1 PANEL PER PAGE (3 of 7 Panel Worksheets)

Timezones (names from Timezone worksheets)
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READER WORKSHEET

Valid Reads

Invalid Reads

Panel Name: (not a database requirement)

Reader Name:

Monitor:

Priority

Priority

Normal

Timezone

Trace

Not Found

PIN

Site Code

Expired

Anti-Passbk

Message

Message

Command File

Command File

Print

Print

Hist.

Hist.

Camera:

Address:

1 READER PER PAGE (4 of 7 Panel Worksheets)

2 READERS PER N-1000 PANEL
(4 READERS PER N-1000-IV PANEL)
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SCHEDULES WORKSHEET 1 SCHEDULE PER PAGE (1 of 1 Schedule Worksheet)

Schedule Name:

Remote Area Name:

Time of Day:

Panel Time & Date Update

Once

Every Hour

Every Day

Unbuffer

Send Commands

Auto Dial-Up

Every Week

Send Time & Date

Backup Reminder

Every Two Weeks

Every Month

Never

Card Activation & Deactivation

Type:

Frequency: Next Date/Time:
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ACCESS LEVEL WORKSHEET

Access Level Name:

TimezoneReader Group

1 ACCESS LEVEL PER PAGE
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HOLIDAY WORKSHEET

Holiday Name Holiday Date

19 HOLIDAYS PER PAGE
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FLOOR PLAN WORKSHEET

Floor Plan Name:

Floor Plan File:

Attach Drawing
or Print Out
of Floor Plan

This floorplan is
attached as a hot
spot to:

Parent Floor Plan Name

Floor Plans

HOT
SPOTS

Input Points

1 FLOOR PLAN PER PAGE
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COMMAND FILE WORKSHEET
Command File Name:

Area:

1 COMMAND FILE PER PAGE

Commands

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18
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BACKDROP WORKSHEET

Backdrop Name:

1 BACKDROP PER PAGE

Sketch your badge backdrop ideas.

Elements that can be added are:
1. Photo(1) and Photo(2)
2. Bitmap
3. Text
4. Barcode
5. Shapes
6. Signature

Backdrops can be:
Single Color
Imported Bitmap
Captured Bitmap

❏
❏
❏

❍

❍

❍

IATA

ABA

TTS

❍

❍

❍

IATA

ABA

TTS

❍

❍

❍

IATA

ABA

TTS

Vertical

Height=

______

Width= ______

Width= ______ Horizontal

Print Area Margins
Width Height Left Right Top Bottom

LengthMagnetic Stripe

Track 1

Track 2

Track 3

Justify Fill Expression
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WIN-PAK Upgrade Procedure

Upgrading From Version 1.16 to Version 1.17

1. If required, install the supported video capture card, multi-port device or
printer and  driver on your PC that will use WIN-PAK 1.17. If you have
ordered a configuration from Northern Computers Inc. these items may
already be present and configured. Refer to appropriate documentation for
descriptions of what is supported as well as new features. You can skip steps
2 and 3 if you already have a pre-configured PC from Northern Computers
Inc.

2. Install fresh, WIN-PAK 1.17 on Windows NT,  Windows 2000 or Windows
XP. During the installation be sure to select the appropriate hardware as
well as necessary configuration items. This may include signature capture
pads, printers (dot matrix, laser, pvc).

3. Launch the software for the first time and register the product through
customer service: 1-800-323-4576. Use "System" as the Name and "startup"
as the password. The password is case sensitive. Once you are logged in
you can exit the application by going to File / Exit.

4. It is now necessary to copy specific files from you WIN-PAK 1.16 PC to
your new WIN-PAK 1.17 PC. The information provided below explains
where the files would be located by default. When they are copied over
from one PC to another you will need to put them in the directories unless
you have specified something different for a path.

Files to include:

• Database files and indexes: Located in the C:\WINPAK\
DATABASE directory. To be copied to C:\Program Files\
WINPAK\DATABASE directory. The database files will
have a DBF extension and the indexes a MDX extension.



428428428428428 WIN-PAK 1.17 User Manual

• Archived database files: Located in the C:\WINPAK
\DATABASE directory. To be copied to C:\Program
Files\WINPAK\DATABASE directory. These files will also
have a DBF extension with two accompanying files with
DBT and MDX extensions. These files contain history
information that was archived encompassing specific dates
set by the user.

Example: 20020109.dbf
20020109.dbt

• NCIBADGE.INI: Located in the C:\ WINPAK\DATA
directory. To be copied to C:\Program Files\WINPAK\
DATA directory. This file contains specific information
regarding each Badge that is programmed.

• Badge files (Backdrops): Located in the C:\ WINPAK\
DATA directory.  To be copied to the C:\Program Files\
WINPAK\DATA directory. These files will have a BDG
extension.

• Image files (Photos): Located in the C:\WINPAK\DATA
directory. To be copied to the C:\Program Files\WINPAK\
DATA directory. These files will have a JPG extension.

• Signature files (Card Holder signatures): Located in the
C:\WINPAK\DATA directory. To be copied to C:\Program
Files\WINPAK\DATA directory. These files have a SIG
extension.

5. Launch the WINPAK 1.17 application and login with a Name and Password
that will allow you full access. Go to the Setup / Serial Ports Menu and
enable the ports you were using and may be programming new. If remote
ports were configured make sure you have the correct modem strings used
in WP1.16. When you click OK to that menu click NO to buffering the
panels.
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6. Go directory to the File / Rebuild Menu, click NO to buffering the panels.
You MUST Re-index all the databases available. Click on the box for each
database so that an "X" is present. Click OK to view the progress of the re-
indexing for each database. The History database may take some time
depending on the original size. When all the databases are finished click on
the Repair box for the Monitor database so that there is an "X" present.
Click OK and wait for that to complete. Next, click on CLOSE so that the
Referential Integrity Table is rebuilt. This may also take some time
depending on the size of the databases.

7. On every PC where you will be monitoring alarms from, the Monitor View
will need to be updated. To do this, click on the Alarm Monitor Tab and
then select the radio button for the Monitor View. Locate the tool-bar
button for Monitor Points, usually located under the Reports menu and
click on it. At this time you can select any loop and panel input(s) to
Monitor by using the drop-down lists. When you are finished click OK.
Once you exit the application the Control.mtr file is then updated where it
saves the input point information you have selected.

8. To further test your new systems programming it is suggested that you go to
each database and setup menu and verify that the information appears
correct.

Some examples:

• Go to the Panel database and look to see that the Panels are
present and configured correctly.

• Go to the Access Level database and verify all the access
levels are present and that the correct timezones appear to
be selected.

• Go to the Card database and verify that all the cards are
listed and that you can edit an existing one.

9. If all the data appears correct you should now backup your system by going
to File / Backup.

10. To further test your communications you may reinitialize your panels  but
his is not necessary unless you have made changes to the Panel, Timezones
or Card programming.  Sending Time  and Date may be needed to sync up
the PC with the Panels.
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Index

Symbols
12-digit cards  32
20 mA current loop  21

A
Access Control

definition  16
Access Level  177

adding & editing  131–133
defined  130
deleting  133

Access Level Database  130–133
defined  54

Acknowledge
button  257

Acknowledged Alarms  256
Acknowledging an Alarm  261
Acknowledging an Alarm or Card

Read  256
Active Status  136
AEP-3  86
AEP-5  85
Alarm

acknowledging  261
clearing  261
hot spot  264
polling  262

Alarm Info  180
Alarm Info Screen  265–266
Alarm Information

viewing  262
Alarm Input Point

defining  259
monitoring from floor plan  264

Alarm Monitor Screen  180, 253–
264

current view  254
floor plan view  263–264
history view  253
monitor view  258–262

Alarm State  89

Anti-passback  81
Archive

reporting history  307
Archiving  329–330
Area

adding & editing  70
defined  69

Area Database
defined  54

Areas Database  69–76
Attendance Report  324–326
Automatic Card Lookup  290

B
Backdrop  178
Backing Up WIN-PAK Files  332–

333
Badge

creating new  198–201
printing  157

Badge Backdrop. See Badge
Layout Utility

Badge Background
bitmap graphic

erasing  214–249
capturing  204–205
creating single color  202–249
creating tips

creating tips  212
editing  202–203
loading graphic  212–214

Badge Elements
adding  215
layering  217
moving  216
resizing  216

Badge Layout
assigning to card  155
copying  200
deleting  201
opening  199–249
printing  249

Badge Layout Utility
accessing  31, 197
text control  221–228

Badge Photo
capturing  144
compression  145
importing  150

Primary/Secondary  145
Badge Programmming

badge tools  215
barcode control  234
capturing background  204
creating a new badge  198
editing badge background  202
graphic control  231
loading a graphic background

212
overview  197
photo placeholder control  229
printing a badge layout  249
shapes control  237
signature placeholder control

241
text control  221
TWAIN setup  210
video capture boards  205, 243

Badge Tab  143
Badge Text

adding  221
changing background color

225
changing font  223
changing foreground color  225
changing orientation  228
creating with transparent

background  226
deleting  228
editing  222
editing horizontal justification

226
Badge Tools  215–220

grids  218
object menu  215
window menu  219

Barcode Control  234–237
Buffer  43

panels  268

C
C-100-A  21
Camera  177

adding & editing  164
deleting  165
report  322–326

Camera Control  181, 182, 280–
287



432432432432432 WIN-PAK 1.17 User Manual

Camera Database  163–165
defined  56

Card
adding & editing  135
Badge Tab  143
Cards Tab  136
invalid reads  140
locate  291
Notes Tab  142
priority  140
status  136
valid reads  139

Card Database  134–162
defined  54

Card Limiting  33
Card Lookup  182, 288–295

automatic  290
card search  289
locate tool  291

Card Report  319
Card Report with Notes  320
Card Search  289
Cards  177
Changing System Privileges and

Password  40
Clearing an Alarm  261
Clearing an Alarm or Card Read

257
Command File  178

adding & editing  193
assigning to a panel  80
deleting  194
sending  271
system alarms  90

Command File Database
192, 192–194

defined  57
Communication Options  34
Communication Setup  44
Computer requirements  19
Connect (Remote Panel)  272
Controlling Input Points  274
Controlling Output Points  274
Controlling Panels  268
Controlling Remote Panels  271
Converters  21
Core Databases  54

Access Level Database  54
Areas Database  54
Card Database  54

Panel Database  54
Timezone Database  54

Create (Databases)  335
Creating a New Badge  198–201
Current View  254–258

D
Daily Option  305
Database

create  335
pack  336
rebuild  334–336
reindex  336
repair  336

Database Control Tools  62
Database Control Window  60
Database Reports  178, 312–326
De-Energize

interlock option  357
Defining Alarm Input Points  259
Defining Readers  127
Deleting a Barcode  237
Deleting a Graphic  234
Deleting a Guard Tour  120
Deleting a Panel  110
Deleting an Operator  182
Disconnect (Remote Panel)  273
Disk Drives  20
Door Ajar status  102

E
Edit Privilege  173–182
Enabling the Daily Option  306
Energize

interlock option  357
ERB  86
Exporting Reports  301
External 5 Volt (Alarm)  89

F
First Login  40
FlashPoint

TWAIN Setup  211
Flashpoint  146–148, 207–209
Floor Plan  185, 189, 191

adding & editing  184

deleting  191
hot spot  264

Floor Plan Database  183, 183–191
defined  57

Floor Plan Graphic
selecting  185

Floor Plan View  263–264
Follow

interlock option  357
Forgiveness  82
Free Egress  82
Freeze

badge photos  144, 205
history view  254

G
Generating Database Reports

312–326
Generating History Reports  303–

311
card  308
date range  304
operator  311
point  310

Graphic Control  231–234
Grids (Badging)  218–219
Ground Fault (Alarm)  88
Guard Tour

deleting  120
Guard Tour Alarms  119–120
Guard Tours Database  115–120

defined  56

H
Hardware Alarms  88

aux port  88
external 5 volt  89
ground fault  88
low voltage  89
message  90
normally open / normally closed

89
panel communications  88
panel primary power  88
panel reset  88
poll response  88
tamper switch  88
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Help  31
History Files

system alarms  90
History Report  178

archived history  307
by card criteria  308
by operator criteria  311
by point criteria  310

History Reports  302
History View  253
Holiday  177

adding & editing  167
deleting  167

Holidays Database  166–167
defined  56

Home Position (Camera)  285
Hot Spot  186, 189

creating  186
defined  186
defining for alarm points  186
deleting  189
floorplan  189, 264

Hot Spot Detail Window  187

I
Image Capture  144
Import Photo  150
Importing a Graphic  201
Inactive Status  136
Incoming Alarms  255
Initialize Option  269
Input Point  183

controlling  274
interlocking  101

Input Points Tab  98–103
Installation  28
Interlocking

examples  357–367
input point  101
output point  107

Intialization (Panel)  269
Invalid Reads

assigned to a card  140
Invert Follow

interlock option  357

L
Layering (Badge)  217
Limited Use  33
Limited Use Options  137–139
Live Camera View  286
Locate Tool  291
Locating a Card Holder from a

Read  258
Login  40, 43
Lost or Stolen Status  136
Low Voltage (Alarm)  89

M
M-200  22
M-300  22
M-9600-2  23
Magnetic Stripe Encoding  243–

248
Magnetic Stripe Options  160
Mail  294–295

sending a message  295
Main Screen Privileges  180
Maintenance  327–336

archiving  329–330
backing up WIN-PAK files  332–

333
purging  331
rebuilding databases  334–336
restoring from a backup  333–

334
Message

system alarms  90
MIP. See Multiple Interlock

Protection
Modems  22
Monitor  20, 177

adding & editing  169
deleting  169
report  323–326

Monitor Database
defined  56

Monitor View  258–262
Monitoring Alarm Points  264
Monitors Database  168–169
Mouse  20
Multiple Interlock Protection  86
Muster

system precautions  122

Muster Report  275–279
Muster Report Options  37

N
N-485-PCI-2  22
Nesting  Areas  128
Network  180
Network Client. See Client
Network Server. See Server
No Action

interlock option  357
None Privilege  173–182
Note Field  179

setup  47
Notes Tab  142

O
Operator  177

adding & editing  171
deleting  182
password  172

Operator Database  170–182
database privileges  175
defined  57
main screen privileges  180
operational privileges  173
operator privileges  173
report privileges  178
setup privileges  179

Operator Privileges  173, 175
Orientation

badge background  214
Output Point

controlling  274
interlocking  107

P
Pack (Database)  336
Pan (Camera)  283
Panel

adding & editing  78
buffer & unbuffer  268
command file  80
controlling  268
deleting  110
Groups Tab
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Groups Screen  108–109
initializing  269
Input Points Tab  98–103
options  81

anti-passback  81
forgiveness  82
free egress  82

Output Points Tab  104–107
Panel Screen  79
Readers Tab  93–97
status  81–110
Timezones Tab  91–92
version  80

Panel Communications (Alarm)  88
Panel Control Screen  267–275
Panel Database  77–110

defined  54
Panel Primary Power (Alarm)  88
Panel Reset (Alarm)  88
Parallel Printer  21
Password  40

assigning to an operator  172
Photo. See Badge Photo
Photo Placeholder (Badge)

deleting  231
Photo Placeholder Control  229–

231
Poll Response (Alarm)  88
Polling an Alarm  262
Power Fail Reroute  87
Print

badge  157
badge layout  249
system alarms  90

Printer
setup  48

Printer Options  156
Printers

Ultra Electronics Tango/Fargo
Duplex Printer  161

Priority
assigned to a card status  140

Privileges  63
Programming Databases

access level database  130–133
areas database  69–76
camera database  163–165
card database  134–162
command file database  192–

194

floor plan database  183–191
guard tours database  115–120
holidays database  166–167
monitors database  168–169
operator database  170–182
overview  53–64
panel database  77–110
schedules database  111–114
timezone database  65–68
tracking areas database  121–

129
Pulse

interlock option  357
Purging  331

R
Re-Index  336
Reader

assigning to panel  93–97
Rebuilding Databases  334–336
Registration  38
Remote Panels

controlling  271
Repair (Database)  336
Report

exporting  301
viewing  299–302

Report Privileges  178
Reports  178, 297–326

generating database reports
312–326

generating history reports  303–
311

viewing reports  299–302
Restoration from a Backup  333–

334
RS-232  21

S
Schedules Database  111–114

defined  55
Sending a Command File  271
Serial Communication Boards  20
Serial Port

defining area for  71
setup  44

Serial Ports

defining  45
Setup

Communication  44
Note Field  47
printer  48

Setup Privileges  179
Shapes Control  237–240
Shunt

interlock option  357
Signature Capture  153
Signature Import  154
Signature Placeholder Control

241–242
Split Timezones  83
Supplementary Databases  55

Camera Database  56
Command File Database  57
Floor Plan Database  57
Guard Tours Database  56
Holidays Database  56
Monitors Database  56
Operators Database  57
Schedules Database  55
Tracking Areas Database  56

System Alarms  87
System Privileges and Password

changing  40
System Screens  251–295

alarm information  265–266
alarm monitor  253–264
camera control  280–287
card lookup  288–293
mail  294–295
muster report  275–279
panel control  267–275

System Setup
Pre-Installation  27

T
Tamper Switch (Alarm)  88
Text Control  221–228
Tilt (Camera)  283
Time Block

deleting  68
Timezone  176

adding & editing  66
assigning to panel  91–92
defined  54, 65
deleting  68
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Timezone Database  65–68
defined  54

Trace Status  136
Tracking Area

adding & editing  125–127
Tracking Areas Database  121–129

defined  56
Trouble Status  102
TWAIN Compatible Interface  149–

152
TWAIN Setup  210

U
Un-Install  31
Un-Shunt

interlock option  357
Unbuffer  43
Unknown

defining area as  70
Using Floor Plan Hot Spots  264

V
Valid and Invalid Reads  139–141
Valid Reads

assigned to a card  139
Video Capture Boards  205–209
View Privilege  173–182
Viewing Alarm Information  262
Viewing Card Information  258
Viewing Reports  299–302

W
WIN-PAK  17
Window Options (Badging)  219
WINPAK1.INI

example of  374
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